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All information contained in these materials, including products and product specifications,
represents information on the product at the time of publication and is subject to change by
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Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not
limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE
IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Notel) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Corporate Headquarters Contact information
TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:

www.renesas.com/contact/.

www.renesas.com
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Renesas and the Renesas logo are trademarks of Renesas
Electronics Corporation. All trademarks and registered trademarks
are the property of their respective owners.

© 2021 Renesas Electronics Corporation. All rights reserved.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the products
covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor
devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the
level at which resetting is specified.

3. Input of signal during power-off state
Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal
elements. Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal
become possible.

5. Clock signals
After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal
produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. Voltage application waveform at input pin
Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the
input level is fixed, and also in the transition period when the input level passes through the area between V. (Max.) and Viu (Min.).

7. Prohibition of access to reserved addresses
Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these
addresses as the correct operation of the LS| is not guaranteed.

8. Differences between products
Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Regulatory Compliance Notices

European Union regulatory notices

This product complies with the following EU Directives. (These directives are only valid in the European Union.)

CE Certifications:
+ Electromagnetic Compatibility (EMC) Directive 2014/30/EU
EN 55032 Class A

WARNING: This is a Class A product. This equipment can cause radio frequency noise when used
in the residential area. In such cases, the ser/operator of the equipment may be
required to take appropriate countermeasures under his responsibility.

EN 55024

+ Information for traceability
+ Authorised representative

Name: Renesas Electronics Corporation

Address: Toyosu Foresia, 3-2-24, Toyosu, Koto-ku, Tokyo 135-0061, Japan
+ Person responsible for placing on the market

Name: Renesas Electronics Europe GmbH

Address: Arcadiastrasse 10, 40472 Dusseldorf, Germany
+ Trademark and Type name

Trademark: Renesas

Product name: E100 Emulator MCU Unit

Type name: ROE417250MCUO00

Environmental Compliance and Certifications:
+ Waste Electrical and Electronic Equipment (WEEE) Directive 2012/19/EU

United States Regulatory notices on Electromagnetic compatibility

FCC Certifications (United States Only):

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case
the user will be required to correct the interference at his own expense.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this
device may not cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation.

CAUTION: Changes or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate the equipment.
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Preface

The ROE417250MCUOQO is a full-spec emulator for MCUs of the H8SX/1700 Series. This user’s manual mainly describes
specifications of the ROE417250MCUOQ0 and how to set it up.

All components of the ROE417250MCU0O are listed under “1.1 Package Components” (page 18). If you have any questions
about the ROE417250MCUQ0, contact your local distributor.

The manuals relevant to usage of the ROE417250MCUOQO are listed below. You can download the latest manuals from the
Renesas Tools homepage (https://www.renesas.com/tools).

Related manuals

Item Manual
Accessory ROEQ100TNPFKO00 User’s Manual
Integrated development environment | High-performance Embedded Workshop User’s Manual
C/C++ compiler and assembler H8S, H8/300 Series C/C++ Compiler, Assembler, Optimizing Linkage Editor

Compiler Package User’s Manual
Notes on Usage of the C/C++ Compiler Package for H8SX, H8S, H8 Family
and Corrections in the User’s Manual

R20UT3587EJ0302 Rev.3.02

Page 5 of 232
Sep.01. 21 ENESAS
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Important

Before using this product, be sure to read this user’s manual carefully.
Keep this user’s manual, and refer to it when you have questions about this product.

Emulator:

"Emulator"” in this document collectively refers to the following products manufactured by Renesas Electronics Corporation
(1) E100 emulator main unit
(2) MCU unit
(3) Pitch converter board for connecting the user system

"Emulator" herein encompasses neither the customer’s user system nor the host machine.

Purpose of use of the emulator:

This emulator is a device to support the development of systems that use the H8SX family H8SX/1700 series of Renesas 32-bit
single-chip MCUs. It provides support for system development in both software and hardware.

Be sure to use this emulator correctly according to said purpose of use. Please avoid using this emulator other than for its
intended purpose of use.

For those who use this emulator:
This emulator can only be used by those who have carefully read the user’s manual and know how to use it.
Use of this emulator requires basic knowledge of electric circuits, logical circuits, and MCUs.

When using the emulator:

(1) This product is a development-support unit for use in your program development and evaluation stages. When a program
you have finished developing is to be incorporated in a mass-produced product, the judgment as to whether it can be put
to practical use is entirely your own responsibility, and should be based on evaluation of the device on which it is installed
and other experiments.

(2) Inno event shall Renesas Electronics Corporation be liable for any consequence arising from the use of this product.

(3) Renesas Electronics Corporation strives to provide workarounds for and correct trouble with products malfunctions, with
some free and some incurring charges. However, this does not necessarily mean that Renesas Electronics Corporation
guarantees the provision of a workaround or correction under any circumstances.

(4) The product covered by this document has been developed on the assumption that it will be used for program
development and evaluation in laboratories. Therefore, it does not fall within the scope of applicability of the Electrical
Appliance and Material Safety Law and protection against electromagnetic interference when used in Japan.

(5) Renesas Electronics Corporation cannot predict all possible situations and possible cases of misuse that carry a potential
for danger. Therefore, the warnings in this user's manual and the warning labels attached to the emulator do not
necessarily cover all such possible situations and cases. The customer is responsible for correctly and safely using this
emulator.

(6) The product covered by this document has not been through the process of checking conformance with UL or other safety
standards and IEC or other industry standards. This fact must be taken into account when the product is taken from Japan
to some other country.

R20UT3587EJ0302 Rev.3.02

Page 6 of 232
Sep.01. 21 ENESAS
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Usage restrictions:
The emulator has been developed as a means of supporting system development by users. Therefore, do not use it as an
embedded device in other equipment. Also, do not use it to develop systems or equipment for use in the following fields.
(1) Transportation and vehicular
(2) Medical (equipment that has an involvement in human life)
(3) Aerospace
(4) Nuclear power control
(5) Undersea repeaters
If you are considering the use of the emulator for one of the above purposes, please be sure to consult your local distributor.

About product changes:
We are constantly making efforts to improve the design and performance of this emulator. Therefore, the specification or
design of this emulator, or this user's manual, may be changed without prior notice.

About rights:

(1) We assume no responsibility for any damage or infringement on patent rights or any other rights arising from the use of
any information, products or circuits presented in this user’s manual.

(2) The information or data in this user’s manual does not implicitly or otherwise grant a license to patent rights or any other
rights belonging to Renesas or to a third party.

(3) This user’s manual and this emulator are copyrighted, with all rights reserved by Renesas. This user’s manual may not be
copied, duplicated or reproduced, in whole or part, without prior written consent from Renesas.

About diagrams:
Some diagrams in this user’s manual may differ from the objects they represent.

R20UT3587EJ0302 Rev.3.02

Page 7 of 232
Sep.01. 21 ENESAS
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Precautions for Safety

Definitions of Signal Words

In both the user’s manual and on the product itself, several icons are used to insure proper handling of this product and also to
prevent injuries to you or other persons, or damage to your properties.

This chapter describes the precautions which should be taken in order to use this product safely and properly. Be sure to read
this chapter before using this product.

A

A DANGER

A WARNING

A CAUTION

CAUTION

IMPORTANT

Example:

Omeans PROHIBITION.
Example:

Example:

This symbol represents a warning about safety. It is used to arouse caution about a potential
danger that will possibly inflict an injury on persons. To avoid a possible injury or death,
please be sure to observe the safety message that follows this symbol.

DANGER indicates an imminently dangerous situation that will cause death or heavy wound
unless it is avoided. However, there are no instances of such danger for the product presented
in this user's manual.

WARNING indicates a potentially dangerous situation that will cause death or heavy wound
unless it is avoided.

CAUTION indicates a potentially dangerous situation that will cause a slight injury or a
medium-degree injury unless it is avoided.

CAUTION with no safety warning symbols attached indicates a potentially dangerous
situation that will cause property damage unless it is avoided.

This is used in operation procedures or explanatory descriptions to convey exceptional
conditions or cautions to the user.

In addition to the five above, the following are also used as appropriate.

/\means WARNING or CAUTION.
ACAUTION AGAINST AN ELECTRIC SHOCK

®DISASSEMBLY PROHIBITED

@means A FORCIBLE ACTION.
%UNPLUG THE POWER CABLE FROM THE RECEPTACLE.

R20UT3587EJ0302 Rev.3.02

Sep.01. 21

Page 8 of 232
RENESAS
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A WARNING

Warnings for AC Power Supply:
@ |f the attached AC power cable does not fit the receptacle, do not alter the AC power cable and do not plug it
forcibly. Failure to comply may cause electric shock and/or fire.

® Do not touch the plug of the AC power cable when your hands are wet. This may cause electric shock.

® This product is connected signal ground with frame ground. If your developing product is transformless (not
having isolation transformer of AC power), this may cause electric shock. Also, this may give an unrepairable
damage to this product and your developing one.
While developing, connect AC power of the product to commercial power through isolation transformer in
order to avoid these dangers.

@ |f other equipment is connected to the same branch circuit, care should be taken not to overload the circuit.

9 ® When installing this equipment, insure that a reliable ground connection is maintained.
<

® If you smell a strange odor, hear an unusual sound, or see smoke coming from this product, then disconnect
power immediately by unplugging the AC power cable from the outlet.
Do not use this as it is because of the danger of electric shock and/or fire. In this case, contact your local
distributor.

® Before setting up this emulator and connecting it to other devices, turn off power or remove a power cable to
prevent injury or product damage.

Warnings to Be Taken for This Product:
® Do not disassemble or modify this product. Personal injury due to electric shock may occur if this product is
disassembled and modified. Disassembling and modifying the product will void your warranty.

® Make sure nothing falls into the cooling fan on the top panel, especially liquids, metal objects, or anything
combustible.

Warning for Installation:
% ® Do not set this product in water or areas of high humidity. Make sure that the product does not get wet. Spilling
@ water or some other liquid into the product may cause unrepairable damage.

Warning for Use Environment:
® This equipment is to be used in an environment with a maximum ambient temperature of 35°C. Care should be
taken that this temperature is not exceeded.

-~

R20UT3587EJ0302 Rev.3.02
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A CAUTION

Caution for AC Adapter:
0 @ The DC plug of the AC adapter has the polarity shown below.

OmORS)

@ Use an AC adapter which complies with the safety standards of the country where it is to be used.

Cautions to Be Taken for Turning On the Power:
® Turn ON/OFF the power of the emulator and user system as simultaneously as possible.

@ \When turning on the power again after shutting off the power, wait about 10 seconds.

Cautions to Be Taken for Handling This Product:
® Use caution when handling the main unit. Be careful not to apply a mechanical shock.

® Do not touch the connector pins of the emulator main unit and the target MCU connector pins directly. Static
electricity may damage the internal circuits.

® Do not pull this emulator by the communications interface cable or the flexible cable. And, excessive flexing or
force may break conductors.

® Do not flex the flexible cable excessively. The cable may cause a break.

® Do not use inch-size screws for this equipment. The screws used in this equipment are all ISO (meter-size) type
screws. When replacing screws, use same type screws as equipped before.

® Do not tape the flexible cable or apply adhesives to secure the cable. The shielding material on the surface of
the cable may come off.

Caution to Be Taken for System Malfunctions:
@ |f the emulator malfunctions because of interference like external noise, shut OFF the emulator once and then
reactivate it.

R20UT3587EJ0302 Rev.3.02

Page 10 of 232
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User Registration

When you install debugger software, a text file for user registration is created on your PC. Fill it in and email it to your local
distributor. If you have replaced an emulator main unit or emulation probe, rewrite an emulator name and serial number in the
text file you filled in earlier to register your new hardware products.

Your registered information is used for only after-sale services, and not for any other purposes. Without user registration, you
will not be able to receive maintenance services such as a notification of field changes or trouble information. So be sure to

carry out the user registration.

For more information about user registration, please contact your local distributor.
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Terminology

Some specific words used in this user's manual are defined below.

MCU unit (ROE417250MCUO00)
This means the E100 emulator for the H8SX/1700 Series.

Emulator system

This means an emulator system built around the MCU unit (ROE417250MCUO00). The emulator system is configured with an
emulator main unit (ROEO01000EMUQ0), MCU unit (ROE417250MCUO00), emulator power supply, USB cable, emulator
debugger and host machine.

Integrated development environment: High-performance Embedded Workshop
The High-performance Embedded Workshop (HEW) provides a GUI-based integrated development environment for the
development and debugging of embedded applications for Renesas microcontrollers.

HEW, a powerful yet easy to use tool suite, features an industry standard user interface and is designed using a modular
approach seamlessly incorporating device family-specific C/C++ compilers and the debugger elements for various debugging
platforms including emulators and evaluation boards.

This provides the user with a single interface to fully exploit the advanced capabilities of the development tools for the entire
development cycle from evaluation of a device through to completion of code development.

Emulator debugger
This means a software tool that is started up from the High-performance Embedded Workshop, and controls the MCU unit and
enables debugging.

Firmware
This means a control program stored in the emulator. This analyzes the contents of communications with the emulator
debugger and controls the emulator hardware. To upgrade the firmware, download the program from the emulator debugger.

Host machine
This means a personal computer used to control the emulator.

Target MCU
This means the MCU to be debugged.

User system
This means a user's application system in which the MCU to be debugged is used.

User program
This means the program to be debugged.

Evaluation MCU
This means the MCU mounted on the emulator which is operated in a dedicated mode for use with tools.

#
This symbol indicates that a signal is active-low (e.g. RESET#).
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1. Outline

This chapter describes the package components, the system configuration, and the specifications of the emulator functions and
operating environment.

1.1 Package Components
The ROE417250MCUOQ0 package consists of the following items. After you have unpacked the box, check if your
ROE417250MCUO00 contains all of these items.

Table 1.1 Package components

Item Quantity
ROE417250MCUQ00 MCU board 1
Oscillator module (8 MHz) mounted on the 1C21 socket
ROE001000FLX10 flexible cable
ROE417250MCUO00 Release Notes (English)
ROE417250MCUO00 Release Notes (Japanese)
Repair Request Sheet (English)
Repair Request Sheet (Japanese)
CD-ROM - Emulator debugger (H8SX E100 emulator debugger)
- User’s Manual
* Please keep the ROE417250MCU00’s packing box and cushioning materials at hand for later reuse in sending the product
for repairs or for other purposes. Always use the original packing box and cushioning material when transporting the MCU

S G LN

unit.
* |f you have any questions or are in doubt about any point regarding the packaged product, contact your local distributor.

1.2 Other Tool Products Required for Development
To proceed with the development of a program for an H8SX-family H8SX/1700-series H8SX/1720-group MCU, the products
listed below are necessary in addition to those contained in the package and listed above. Procure them separately.

Table 1.2 Other tool products required for development

Product Part No.
Emulator main unit E100 ROE001000EMUOQ0
100-pin 0.5-mm pitch LQFP (PLQP0100KB-A  Former code: LQFP-100) | ROEO100TNPFKO0O0

* To purchase the product, contact your local distributor.
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1.3 System Configuration

1.3.1 System Configuration
Figure 1.1 shows the configuration of the emulator system.

(4) USB interface (1) MCU unit
ROE417250MCU00

(2) Flexible cable

i

(7) Pitch converter board for
connection to the user system

06 [0 (Rt 5 i e T e |

e R P R

/ / I

i = i e (5) AC adapter power
\ supply for the emulator
(6) Host machine (3) E100 emulator (8) User system and user
main unit system power supply

Figure 1.1 System configuration

(1) MCU unit ROE417250MCUO0O (this product)
This is an MCU board for the H8SX/1700 Series MCUs and contains an evaluation MCU.
(2) Flexible cable ROEO01000FLX10 (included)
(3) E100 emulator main unit ROE001000EMUOQO
This is the E100 emulator main unit.
(4) USB interface cable
This is an interface cable for the host machine and emulator.
(5) AC adapter supply for the emulator
(6) Host machine
A personal computer to control the emulator.
(7) Pitch converter board ROEO100TNPFKAOQO for connecting the user system
(8) User system and user system power supply
User system is your application system. This emulator can be used without the user system.
The user system power supply is power supply for the user system. This emulator cannot supply power to the user system.
Get a power supply separately.
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1.3.2 Names and Functions of the Emulator Parts
Figure 1.2 shows the names of the emulator parts.

(5) System status LEDs (4) External trigger connector

' (1) Power switch

(2) USB cable connector

\ : 3 (3) Power connector

(6) Target status LEDs

Figure 1.2 Names of the emulator parts
(1) Power switch
This is a switch to turn the emulator ON and OFF.

(2) USB cable connector
This is a connector for connecting the USB cable of the emulator.

(3) Power connector
This is a connector for connecting the DC cable of the AC power adapter of the emulator.

(4) External trigger connector
This is a connector to connect the external trigger cable of the emulator.
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(5) System Status LEDs

The system status LEDs indicate the E100 emulator’s power supply, operating state of firmware, etc. Table 1.3 lists the
definitions of the system status LEDs.

Table 1.3 Definitions of the system status LEDs

Name Status Meaning
POWER ON Emulator system power is turned ON.
OFF Emulator system power is turned OFF.
SAFE ON Emulator system is operating normally.
Flashing Emulator system cannot communicate with the host machine.
Flashing Self-checking is in progress.
(every 2 seconds)
OFF Emulator system is not operating normally (system status error).

(6) Target Status LEDs

The target status LEDs indicate the operating state of the target MCU and power supply of the user system. Table 1.4 lists
the definitions of the target status LEDs.

Table 1.4 Definitions of the target status LEDs

Name Status Meaning
POWER ON Power is being supplied to the user system.
OFF Power is not being supplied to the user system.
RESET ON Target MCU is being reset, or reset signal of the user system is held low.
OFF Target MCU is not being reset.
RUN ON User program is being executed.
OFF User program has been halted.

IMPORTANT

Note on the Target Status POWER LED:
® |f your MCU has two or more Vcc pins, the LED does not light up unless power is supplied to all the pins.
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1.4 Specifications

Table 1.5 lists the specifications of the ROE417250MCUQ0.

Table 1.5 Specifications of the ROE417250MCUQ00

Applicable MCU

H8SX-family H8SX/1700-series MCUs

Applicable MCU mode

Single-chip mode, On-chip ROM enabled extended mode

Maximum ROM/RAM capacity

1. Internal flash ROM: 1 Mbytes
2. Internal RAM: 64 Kbytes
3. Internal EEPROM: 32 Kbytes

Maximum operating frequency 80 MHz
Power supply voltage 3.0t0 3.6V, 4.5t05.5V
Software break 4096 points

Hardware break

16 points (Execution address, bus detection, interrupt, external trigger signal)

Combination, pass count

- Cumulative AND/OR/simultaneous AND/state transition
- 255 pass counts

Detection of exceptional events

Violation of access protection/task stack access violation/OS dispatch/reading
from a non-initialized area

Real-time tracing

192 bits x 4 M cycles
(Address, data, status, CPU status, bus status, target status, task 1D, timestamp, 32
external trigger inputs)

Trace modes

Fill until stop/fill until full/fill around TP/repeat fill until stop/repeat fill until full

Extraction/deletion of trace data

- Extracting or deleting data by specifying events or extracting the instruction that
accesses the specified data
- Extracting data before and after trace points

Real-time RAM monitor

- 16,384 bytes (512 bytes x 32 blocks)
- Data/last access

Time measurement

- Execution time between program start and stop

- Maximum/minimum/average execution time and number of passes through eight
specified sections

- Clock used to count times: Equal to the MCU clock or 10ns to 1.6 us

Coverage measurement

CO0: 2 Mbytes (256 Kbytes x 8 blocks)
C1: 1 Mbyte (128 Khytes x 8 blocks)

Emulation memory

4 Mbytes (1 Mbyte x 4 blocks)

Pseudo-generation of errors

Detect if external oscillation has stopped and correct ROM/RAM ECC errors

Connection to user system

100-pin 0.5-mm pitch LQFP ROEO0100TNPFKOO0

Emulator power supply

Supplied from an AC adapter (power supply voltage: 100 to 240 V, 50/60 Hz)
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1.5 Operating Environment

Make sure to use this emulator in the operating environments listed in Tables 1.6 to 1.8.

Table 1.6 Operating environmental conditions

Item

Description

Operating temperature

5 to 35°C (no condensation)

Storage temperature

-10 to 60°C (no condensation)

Table 1.7 Operating environment of the host machine (Windows® XP or Windows® 2000)

Item Description
Host machine IBM PC/AT compatible [*1]
(OF] Windows® XP 32-bit editions [*1] [*3]
Windows® 2000 [*1]
CPU Pentium 4 running at 1.6 GHz or more recommended
Interface USB 2.0 [*2]
Memory 768 Mbytes or larger (more than 10 times the file size of the load module)

recommended

Pointing device such as mouse

Mouse or any other pointing device usable with the above OS that can be
connected to the host machine

CD drive

Needed to install the emulator debugger or refer to the user’s manual

Table 1.8 Operating environment of the host machine (Windows Vista®)

Item Description
Host machine IBM PC/AT compatible [*1]
0S Windows Vista® 32-bit editions [*1] [*4]
CPU Pentium 4 running at 3GHz or
Core 2 Duo running at 1GHz or more recommended
Interface USB 2.0 [*2]
Memory 1.5 Gbytes or larger (more than 10 times the file size of the load module)

recommended

Pointing device such as mouse

Mouse or any other pointing device usable with the above OS that can be
connected to the host machine

CD drive

Needed to install the emulator debugger or refer to the user’s manual

Notes:

*1: Windows and Windows Vista are either registered trademarks or trademarks of Microsoft Corporation in the United States
and/or other countries. All other company or product names are the property of their respective owners.
*2: Operation with all combinations of host machine, USB device and USB hub is not guaranteed for the USB interface.
*3: The 64-bit editions of Windows® XP are not supported.
*4: The 64-bit editions of Windows Vista® are not supported.
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1.6 Specifications of the AC Adapter

The user must prepare an AC adapter and a power cable. Use an AC adapter which complies with the safety standards of the
country where it is to be used. Table 1.9 lists the recommended specifications of the AC adapter.

Table 1.9 Recommended Specifications of the AC Adapter

Item Description
AC input voltage range AC 100 to 240 V, 50/60Hz single phase
Output power 36 W
DC output voltage, current 120V,3.0A
DC output polarity EIAJ TYPE IV, inner-side positive/outer-side negative
R20UT3587EJ0302 Rev.3.02 Page 24 of 232
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2. Setup

This chapter describes the preparation for using the MCU unit, the procedure for starting up the emulator and how to change
settings.

2.1 Flowchart of Starting Up the Emulator
The procedure for starting up the emulator is shown in Figures 2.1 and 2.2. For details, refer to each section hereafter. If the
emulator does not start up normally, refer to “6. Troubleshooting ™ (page 214).

1 | Check the package components. | Refer to “1.1 Package Components” (page 18).
v
2 | User registration | Refer to “User Registration” (page 16).
v
3 | Install the included software, etc. | Install them from the included CD-ROM.
v
4 Connect the MCU unit to the EL00 main Refer to “2.3 Connecting the MCU Unit to and Disconnecting it
unit. from the E100 Emulator Main Unit” (page 28)
v
. Connect the USB interface connector of the emulator and the USB
5 Connect the host machine. .
port of the host machine.
v
6 | Connect the emulator power supply. | Connect an emulator power supply to the power connector.
v
7 | Turn on the power supply. | Turn ON the power to the emulator.
v
8 | Check the LEDs on the emulator. | Check that the system status LEDs are lighting.
v
When using the emulator debugger for the first time, try to use the
9 Try to use the emulator debugger according emulator functions, referring to “3. Tutorial” (page 38).
to the tutorial. If the emulator debugger does not start, follow steps 10 through 13
in this chart to perform self-checking.
v
10 Create a project in the High-performance Start up the High-performance Embedded Workshop and create a
Embedded Workshop. project by following “4. Preparation for Debugging” (page 69).
v
1y | Serupteemutorebgger romne | 2 8 on o Cebuging”
High-performance Embedded Workshop.
(page 69).
v
Make settings on the Device page in the Device setting dialog box
12 Set up the operating environment of the of the emulator debugger and select the “Start booting up on
emulator debugger. successful completion of self-checking” checkbox by following
“4. Preparation for Debugging” (page 69).
v
13 Self-checking |

Figure 2.1 Flowchart of starting up the emulator (for the first time)
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14 Change the settings.
v
15 Connect the user system.
v
16 Turn on the power supply.
v
17 Check the LEDs on the emulator.
v
18 Start up the emulator debugger from the
High-performance Embedded Workshop.
v
19 Set up the operating environment of the
emulator debugger.
v
20 Debug a program with various functions of

the emulator debugger

Change the settings of the power supply to MCUs or clock supply,
according to the conditions on use.

Connect the user system as occasion demands.

Turn ON the power to the emulator and the user system as
simultaneously as possible.

Check that system status LEDs, and POWER and RESET of the
target status LED are lighting. When the user system is not
connected, the POWER LED does not light up.

Start up the High-performance Embedded Workshop to launch the
emulator debugger.

Check the contents set in step 12 in Figure 2.1. Do not select the
“Start booting up on successful completion of self-checking”
checkbox.

Refer to the High-performance Embedded Workshop and
“5. Debugging Functions” (page 80).

Figure 2.2 Flowchart of starting up the emulator (after self-checking)
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2.2 Installing the Included Software
If you have Windows Vista, XP or 2000 on the host machine, this installation must be executed by a user with administrator
rights. Note that users without administrator rights cannot complete the installation.

Place the CD-ROM in the CD-ROM drive and follow the instructions to install the software.
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2.3 Connecting the MCU Unit to and Disconnecting it from the E100 Emulator Main Unit
Figure 2.3 shows the procedure for connecting the MCU Unit to the E100 Emulator Main Unit.

Connecting
MCU Unit
ROE417250MCUOQ0

4
Insert the MCU unit Push the MCU unit down

‘ following the inside to check it is attached properly.
rails of the main unit.

E100 emulator main unit

ROEOO1000EMUOO
Ol - Ol

Disconnecting

Figure 2.3 Connecting the MCU Unit to and Disconnecting it from the E100 Emulator Main Unit

A CAUTION

Note on Connecting the MCU Unit to the E100 Emulator Main Unit:
® Always shut OFF power when connecting the MCU unit to the E100 emulator main unit. Otherwise, internal
circuits may be damaged.
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2.4 Connecting the Host Machine
USB interface is used for connecting the emulator to the host machine. The USB cable is connected to the USB cable

connector of the emulator and the USB port of the host machine.

Figure 2.4 Connecting the host machine
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2.5 Connecting the Emulator Power Supply
Power is supplied from an AC adapter to the emulator. The following shows how to connect the AC adapter.

(1) Turn OFF the power of the emulator.

(2) Connect the DC cable of the AC adapter to the emulator.
(3) Connect the AC power cable to the AC adapter.

(4) Connect the AC power cable to the outlet.

Figure 2.5 Connecting the emulator power supply

/A CAUTION

Cautions for AC Power Cable:
If the AC power cable does not fit the receptacle, do not alter the AC power cable and do not plug it forcibly.
Failure to comply may cause electric shock and/or fire.
Do not touch the plug of the AC power cable when your hands are wet. This may cause electric shock.
Cautions for AC Adapter:

0 The DC plug of the AC adapter has the polarity shown below.

(OZ0:€)

Use an AC adapter which complies with the safety standards of the country where it is to be used.
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2.6 Turning ON the Power

2.6.1 Checking the Connections of the Emulator System
Before turning the power ON, check the connection of the interface cable with the host machine, emulator, and user system.

2.6.2 Turning the Power ON and OFF

- Turn ON/OFF the power of the emulator and user system as simultaneously as possible.

- Do not leave either the emulator or user system powered on. The internal circuits may be damaged due to leakage current.
- When turning ON the power again after shutting OFF the power, wait for about 10 seconds.

IMPORTANT

Notes on Power Supply:
® The emulator pin Vcc is connected to the user system in order to monitor user system voltage. For this reason,
the emulator cannot supply power to the user system. Supply power to the user system separately.

The voltage of the user system should be as follows.
3.0V<Vee<36V 45V <Vee<55V

® \When you start the emulator without the user system, do not attach a converter board. When starting with a
converter board, the MCU will be in a reset status.

® \When you start the emulator without the user system, take care that metallic pieces are not touched to the
connector at the head of the flexible cable.

® Do not leave either the emulator or user system powered on. The internal circuits may be damaged due to
leakage current.
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2.7 Self-checking
Self-checking is to check if the emulator functions operate properly. To run the self-check function of the emulator, follow the
procedure below. While self-checking is in progress, the states of the LEDs will change as shown in Figure 2.6. In case of

ERROR, because the states of the target status LEDs will change depending on the types of errors, check the system status
LEDs.

(1) If the user system is connected, disconnect it.
(2) Turn on the emulator.

(3) Launch the emulator debugger, and select the “Start booting up on successful completion of self-checking” checkbox in the
Device setting dialog box.

(4) When you click OK, self-checking will start. If the normal result is displayed in about 60 seconds, self-checking has ended.
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Figure 2.6 LEDs during self-checking
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2.8 Selecting the Clock Supply

2.8.1 Clock Source

You can choose the clock source supplied to the evaluation MCU in the System page in the Configuration properties dialog
box of the emulator debugger. Table 2.1 shows the clock sources and their default settings.

Table 2.1 Clock supply to the MCU

Clock Clock selection in the Description Default setting
emulator debugger
Main (EXTAL) Emulator Oscillator module mounted on 1C21 Yes
User Oscillator circuit on the user system -
Generate Internal generator circuit i
(8.0 to 10.0 MHz)
Sub Emulator Internal oscillator circuit Yes
(OSC1 and OSC2) (32.768 kHz)

IMPORTANT

Notes on Changing the Clock Supply:
® The clock supply can be set on the System page of the Configuration properties dialog box when starting up the

emulator debugger or by an input of the Emulator_clock command on the Command Line window.
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2.8.2 Using an Internal Oscillator Circuit Board

Kinds of Oscillator Circuit Boards

An oscillator module (8 MHz) is mounted on 1C21 at shipment of the ROE417250MCUO00. If you wish to change the
frequency, replace the oscillator module.

(1) Replacing the Oscillator Module
Remove the MCU unit from the E100 emulator main unit, and replace the oscillator module on 1C21 (see Figure 2.7).

EPSON TOYOCOM
SG-8002DC/DB Series
(power voltage 2.7 to 3.6V: PC/SC)

QO0O0O000

C
0000000
8 1 14

Figure 2.7 Replacing the oscillator module

/A CAUTION

Note on Replacing the Oscillator Module and Oscillator Circuit Board:
® Always shut OFF power when replacing the oscillator module. Otherwise, internal circuits may be damaged.
® \When replacing the oscillator module, remove it with a tool such as an IC extractor so as not to damage the
board. If the board is damaged, the pattern on the board may be cut and the emulator may not be able to operate.
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2.8.3 Using the Oscillator Circuit on the User System

To operate the MCU unit with an external clock source, construct the oscillator circuit as shown in Figure 2.8 in the user
system and input the oscillator output at 50% duty (within the operating range of the evaluation MCU) into pin EXTAL. Pin
XTAL, on the other hand, should be open. Choose "User" in the emulator debugger to use this clock source.

Mmcu
EXTAL XTAL
|_ Oscillator Open

circuit

Figure 2.8 External oscillator circuit

Make note that in the oscillator circuit shown in Figure 2.9 where an oscillator is connected between pins EXTAL and XTAL,
oscillation does not occur because a converter board and other devices are used between the evaluation MCU and the user
system.

MCU

EXTAL XTAL

A
Ll —

] ]

Figure 2.9 Circuit in which oscillation does not occur

2.8.4 Using the Internal Generator Circuit

The dedicated circuit in the E100 can generate clock source of any frequency specified in the emulator debugger, and it can be
supplied as a main clock. It does not depend on the oscillator circuit board in the MCU unit or the oscillator circuit on the user
system. If you want to debug programs without the user system or change a frequency temporarily, you can check its operation
before purchasing an oscillator. If you want to use the internal generator circuit in the E100 to generate a main clock, choose
"Generate" in the emulator debugger and specify a frequency you like.

Although you can change a frequency between 1.0 and 99.9 MHz by 0.1 MHz for the E100, do not specify a value exceeding
the maximum input frequency 10 MHz for EXTAL of the MCU.

IMPORTANT

Note on Using the Internal Generator Circuit:
® The internal generator circuit is equipped for temporary debugging purposes. Temperature characteristics of
frequencies are not guaranteed.
® Be sure to evaluate your system with an oscillator whose frequency is the same as that of the oscillator module
or oscillator circuit (internal clock) for final evaluation purposes.
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2.9 Connecting the User System
Figure 2.10 shows how to connect the MCU unit to your system.

Flexible cable

l

100 pins

0.5-mm pitch

\

ROE0100TNPFKO0
100-pin LQFP

Figure 2.10 Connecting the MCU unit to the user system

A CAUTION

Note on Connecting the User System:
0 ® Take care not to attach a converter board in a wrong direction. It may cause a fatal damage to the emulator and
user system.
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2.9.1 Connection to a 100-pin 0.5-mm Pitch Pad Pattern
The following is a procedure of connection to a 100-pin 0.5-mm pitch pad pattern on the user system using the
ROEO0100TNPFKOO (not included). For details on the ROEO100TNPFKOO, refer to its user’s manual.

(1) Install the NQPACK100SD-ND, which comes with the ROEOL00TNPFKOO, on the user system.

(2) Connect the YQPACK100SD, which also comes with the ROEOL00TNPFKOO, to the NQPACK100SD-ND and secure it
with the YQ-GUIDEs.

(3) Connect the ROE0L00TNPFKOO to the YQPACK100SD.

(4) Connect CN2 of the ROEO100TNPFKO00 to CN2 of the flexible cable.

(5) Connect CN1 of the ROE0O100TNPFKO00 to CN1 of the flexible cable.

TR

) ﬂ Evaluation with
ﬂ the actual MCU

ROE0100TNPFK00

3 HQPACK100SD
( ) (not included)

-@x

Flash MCU

ﬂ YQ-GUIDE (x 4)

# ﬂ’ YQPACK100SD

ﬂ (2 NQPACK100SD-ND

These corners
are not round. ~

ﬂ 100-pin 0.5-mm pitch
(PLQP0100KB-A) pad pattern

rd
~
Pin 1

User system

*: These four products are available in one package.

Figure 2.11 Connection to a 100-pin 0.5-mm pitch pad pattern

A CAUTION

Notes on Connecting the User System:
® Take care not to attach a converter board in a wrong direction. It may cause a fatal damage to the emulator and
user system.
® The connectors of the ROEO100TNPFKOO are guaranteed for only 50 insertion/removal iterations.

® For purchasing the HQPACK100SD, contact the following:
Tokyo Eletech Corporation http://www.tetc.co.jp/e_index.htm
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3. Tutorial

3.1 Introduction

A tutorial program for the E100 emulator is provided as a means of presenting the emulator’s main features to you. The tutorial
is described in this section.

The tutorial program was written in the C and C++ languages, and sorts random data (10 items) into ascending and descending
order.
Processing by the tutorial program is as follows.

The main function repeatedly calls the tutorial function in order to repeatedly execute the process of sorting.

The tutorial function generates the random data to be sorted and calls the sort and change functions, in that order.

The sort function accepts input of an array that contains the random data generated by the tutorial function and sorts this data
into ascending order.

The change function accepts input of the array that was sorted into ascending order by the sort function and sorts the data into
descending order.

The tutorial program is designed to help users to understand how to use the functions of the emulator and emulator debugger.
When developing a user system or user program, refer to the user’s manual for the target MCU.

CAUTION
If the tutorial program is recompiled, the addresses in the recompiled program may not be the same as those described in this
chapter.
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3.2 Starting the High-performance Embedded Workshop
Open a workspace by following the procedure described in Section 4.4, “Opening an Existing Workspace” (page 75).

Specify the directory given below.

(Drive where the OS is installed)\Workspace\Tutoria\EL00\H8SX\Tutorial

Specify the file shown below.

Cpen Workspace

Look jn: I 5 Tutarial

~| & & B

2=

l Tukorial

File nanne: IT utorial bz

Select I

Files of type: | HEW warkspaces [* hus)

j Cancel |

A

Figure 3.1 Open Workspace dialog box

3.3 Connecting the Emulator

When the debugger is connected to the emulator, a dialog box for setting up the debugger is displayed. Make initial settings of

the debugger in this dialog box.

When you have finished setting up the debugger, you are ready to start debugging.
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3.4 Downloading the Tutorial Program

3.4.1 Downloading the Tutorial Program

Download the object program you want to debug. Note, however, that the name of a program to be downloaded and the
address where the program will be downloaded depend on the MCU in use. Accordingly, strings shown in the screen shots

should be altered to those for the MCU in use.
Choose Download for Tutorial.abs under Download modules.

hd

= @ Tutanal

Tutonal
=23 C source file
----- =] dbzctc
----- 2] intprg.c
----- 2] resetprg.c

----- 2] shrk.c

H-=3 C++ source file

----- 2] sark.cpp

----- 2] Tutonial.cpp
Ea Download modules

El a Dependencies Download

- zarth Dowenload {Debug Daka only
...... . typedefine. h Unload

Download A Mew Module, .
Remove

Debug Settings. ..

Configure Yiew., .,

IT Allow Docking
Hide

Properties. ..

Figure 3.2 Downloading the tutorial program
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3.4.2 Displaying the Source Program

In the High-performance Embedded Workshop you can debug programs at the source level.
Double-click on the C++ source file Tutorial.cpp.

il

-3 Tutoial
E- [ Tutoral
== C zowce fie
g dbzctc
i 4] intprg.c
i 2] et
- 4] shike
=3 C4+ source fle
[ sotcpp
O 1:0nal cpp
=1 = Downlnad modules
L[ Tuional abs - 00000000
=1-3 Dependencias
i 2] shikh
- [F] soith
E] stackscth
=] ypedefneh

[B&ld

Line

Source...| E.. C.

.| Source

21
22
23
24
25
26
27
28
=]
io
il
iz
a3
34
is
a6
a7z
ig
a3
40
41
42
43
44
45

16
4

0o103C

o0103c
001042

00104 A

00104C

001054
00105C
oo1064
oo106C
001070

00107z

ool1o0es
oo1o020

wold main(void)
1
vhile [1){
tutociml():
I
1

wold cucorial (void)
i
long al[l0]:
leng 3:
int i;
class Seample *p_sam:

p_3am= Sample;
for( 1=0: 1<10: i++ )¢

3 = rand():

if[(1 < Q)4

3 = -3

1

afi] = 3:
)
p_3Em->30rc (&) :
p_sem—>change (&) :

T (rrojects [ @ 1o | i | 3 1o |

< esstpgc o0F Twonalepp [+5F  sofcpp I

Figure 3.3 Editor window (displaying the source program)

If necessary, you can change the font and size to make the text more easily readable. For details, refer to the High-performance

Embedded Workshop User’s Manual.

The Editor window initially shows the beginning of the program. Use the scroll bar to view other parts of the program.
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3.5 Setting Software Breakpoints

Setting of software breakpoints is one simple debugging facility.
Software breakpoints are easy to set in the Editor window. For example, you can set a software breakpoint at the line where the
sort function is called.

Double-click in the row of the S/W Breakpoints column which corresponds to the source line containing the call of the sort
function.

=10lx|
Bz
Line Source... | E.| C.| 5. Source |
35 ZI
36 (001054 b sSamw= Sample:
37 |00105cC for( i=0; i<10; i++ )4
38 001064 3 = randl():
39 |0010s6C if(y < 034
40 |ooi107o i=-a:
41 h
42 00107z ali]l] = 3:
473 h
44 (001088 » P Sam—>s0rt(a):
45 |001020 p_Sam->change (a) !
46
4% |ooi09s p_Sam—>=0=a[0]
458 |00104L0 b _Sam->=1=all]:
49 001043 b _Sam-»sZ=alZ]:
50O |0010E0Q p_Sam->23=al3]:
51 |0010ES p_sam->s4=al4d]:
B2 |0010C4 p_sam-»=5=al[5]:
53 |0010D0 p_Sam->s6=ala]:
54 |0010DC p_sam—x»s7=al7]:
55 |0O010ES p_sam->=8=a[8]:
E& |0010F4 p_Sam—»29=a[3]
57 001100 p_sSam:
53 001106 h
1=
&0 |00110C woid ghort (void) i
Bl i -
*| | a2y

Figure 3.4 Editor window (setting a software breakpoint)

The source line that includes the sort function will be marked with a red circle, indicating that a software breakpoint has been
set there.
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3.6 Executing the Program
The following describes how to run the program.

3.6.1 Resetting the CPU

To reset the CPU, choose Reset CPU from the Debug menu or click on the Reset CPU toolbar button ].

3.6.2 Executing the Program

To execute the program, choose Go from the Debug menu or click on the Go toolbar button ].

The program will be executed continuously until a breakpoint is reached. An arrow will be displayed in the S/W Breakpoints
column to indicate the position where the program stopped.

- Tukorial, cpp

=10l x|

Line Source... | Source |
35 ZI
3o (001054 p_Sam= Sample;

37 (00105C for( i=0; i<10; i++ )¢

35 (001064 J = randl():

39 (00106C if(y < 034

40 (001070 1= -a:

41 ¥

4z (001072 ali]l] = 3:

43 ¥

44 |001088 b_Sam->s0rt (&) ;

45 |0010=20 b_samw->change (a) ;

46

475 |ooi09a p_saw—x>s0=a[0] ;

45 |00104L0 p_Sam->=1=al[l]:

49 001043 p_Sam-»si=ali]:

50 |0O010E0Q p_Sam-»23=al[3]:

51 |0010ES p_sam->s4=al4d]:

B2 |0010C4 p_sam-»=5=al[5]:

53 |0010D0 p_Sam->s6=ala]:

54 |0010DC p_sam—x»s7=al7]:

55 |0O010ES p_sam->=8=a[8]:

E& |0010F4 b Sam->29=a[3]

57 (001100 b Sam;

B2 (001106 h

Lo

60 00110 woid short (woid) o

61 { -
l | v

Figure 3.5 Editor window (break)
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The Status window permits you to check the cause of the last break to have occurred.

Choose CPU —> Status from the View menu or click on the View Status toolbar button ]. When the Status window is

displayed, open the Target sheet and check the cause of the break.

Statws K|
Item |Status
MCT staktus Ready
PC:0010848
TaskID:-

Violaktion of access protection -

Fead from uninitialized mewory -

Stack access wviolation -

Performance owverflow -

Realtime profile owverflow -

Trace memory overflow -

Tazk stack access wviolaktion -

05 dispatch -

Run time count 00:00:00.000.477.240
Zause of last break Software break

| i

4 }r\ Marnory _}H. Platfarrn ,]\ Ewents hTarget lHr

Figure 3.6 Status window

CAUTION
The contents displayed in this window differ with the product. For details of the contents displayed for particular products,
refer to Chapter ”’5. Debugging Functions” (page 80) or the online help.

3.7 Checking Breakpoints

Use the Breakpoints dialog box to check all software breakpoints that have been set.

3.7.1 Checking Breakpoints
Press the keys Ctrl + B on the keyboard of your PC. The Breakpoints dialog box shown below will be displayed.

Breakpoints

ppr. Line 44

] 4

Cancel

Edit Code

Bemove

Remaove All

LB,

Figure 3.7 Breakpoints dialog box

Use this dialog box to remove a breakpoint or enable or disable a breakpoint.
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3.8 Altering Register Contents

Choose CPU -> Registers from the View menu or click on the Registers toolbar button ]. The Register window shown

below will be displayed.

Namme |¥alue | Radixl
ERO QOFFEFDE Hex
ERl Qoooooz 4 Hex
ERZ 0O00Z0DA Hex
ER3 0o00000A Hex
ER4 OOFFO3Ed Hex
ERS Qooooono Hex
ERA Qooooono Hex
ERT QOFFEFEA Hex
B ooooi0es Hex
CCR Qoooo10o0 -0-—-z-- Ein
EXR g11i1111 ————- 111 Ein
VER Qooooono Hex
3ER FFFFFFOO Hex
MACH 00000000 Hex
MACL 00000000 Hex

Figure 3.8 Register window

The contents of any register can be altered.
Double-click on the line for the register you want to alter. The dialog box shown below is displayed, allowing you to enter the

new value for the register.

PC - Set value

Fadix : IHEH

Sethsz IWhDIe Register

x|

Cancel

Figure 3.9 Set Value dialog box (PC)
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3.9 Referring to Symbols

The Labels window permits you to view the symbolic information in a module.

Choose Symbol —> Labels from the View menu or click on the Labels toolbar button [ £& ]. The Labels window shown below

will be displayed. Use this window to look at the symbolic information a module includes.

label i
S =m A R E
EP | Address | Name :I
0013a8 __default new handler ()
0o013aa __sbhrk size
DO13AE _DTEL
0013EA _BTEL
ooZooa Samuple:  Sample ()
0o0zZ043 Sample: rsort (long *)
OO0ZO0EA _ TZB373BE3T1
O0Z11E Sammple: :change (long *)
FFroOoo _ g IntBuf
Froooz _ g CharBuf
Frooo4 _heap ares
FFro4:z4 __rnext
FFro4:ig _brk
FFO4zc __ecip new handler
FFro430 __new _handler
FFro434 _ head
Fro43a8 _ freeptr -
4 I I 2

Figure 3.10 Label window
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3.10 Checking Memory Contents

After you have specified a label nhame, you can use the Memory window to check the contents of memory where that label is
registered. For example, you can check the contents of memory corresponding to _main in byte units, as shown below.

Choose CPU —> Memory from the View menu or click on the Memory toolbar button | ] to open the Display Address

dialog box.
Enter “ _main” in the edit box of the Display Address dialog box.

Display Address 7] x|

Dizplay Address: I "I
Soroll Start Address: IDDDDDD j
Scroll End Address: IFFFFFF =]

ak. I Cancel |

Figure 3.11 Display Address dialog box

Click on the OK button. The Memory window will be displayed, showing a specified memory area.

T
(o mmmzz |6 040 8 2 |aedt dp dodu £ 2 a6 32 |

Address | +0 41 42 +3 4 45 46 +7 #2 +0 +2 +E 4+ 4D +E +F | ascIT -
oni03c OF 98 OF 80 47 08 55 08 OF 9% OF &80 46 P8 54 70 ....G.U..... F.Tp

ooio4c | 01 20 60 FZ 79 37 00 32 1a BO SE 0D Z0 00 OF 84 . m.y7.2..". 5
00105c 19 33 79 22 00 oOa 4¢ 24 S5E 00 11 EZ 17 FO OF 82 L 3v#..LE%.......

oo10ec or 80 4c 02 17 BZ OF FOD Op 31 17 F1 10 71 0& 90 ..L...... l...q..
ooioye |01 OO0 69 82 OB 53 079 I3 00 0Oa 4p Do OF F1 OF <0 ..i..3y#..M.....
O0i08c S5E 00 20 48 OF F1 OF cCO 5E OO0 21 1E 01 00O &9 70 ., H....*.l...ip

Qo109c 01 00 e2 cO 01 01 €9 70 01 01 g9 cO 01 0 62 70 ..i...ip..d...dp
O010ac o1 02 82 ¢cO 01 03 &9 70 01 03 &9 <O 01 OO0 o&F YO ..i...ip..1i...o0p

O0LI0BC oo 10 01 00 &F <O OD 10 01 OO0 &F 7O OO0 14 01 00 ....00.... OPauss
00i0ce EF cO0 00 14 01 00 erF 70 00 18 01 00 eF cO 00 18 o.....0pc.c-0...
o010Dpe 01 00 sF 70 00 1¢ 01 00 eF <O 00 1c 01 00 6F 70 ..0p.ceeeOcusan op
DODi0EC | 00 20 01 00 GF <O OO 20 01 OO0 &F 70 00 24 01 O0 . ..o.. ..op.§..
O010FC 6F <O 00 24 O <O S5E OO 11 A8 79 17 00 3% 54 24 o..§..%...v..2T§
oo110g 54 70 01 20 ep F4 YA OO 00O 00 13 EBA TA 01 OO0 00 Tp. mo.Z..... Tass

DO011l¢c |13 ¢2 40 1z 01 00 6p 04 01 00 6p 05 40 04 01 7D ..@...m...m.@..}f
4 4

Figure 3.12 Memory window
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3.11 Referring to Variables

When single-stepping through a program, you can see how the values of the variables used in the program change as you step
through source lines or instructions. For example, by following the procedure described below, you can look at the long-type
array ‘a’ that is declared at the beginning of the program.

Click on the left-hand side of the line containing the array ‘a’ in the Editor window to place the cursor there. Right-click and
select Instant Watch. The dialog box shown below will be displayed.

Inskant Watch

- a {FFEFBA } [long[10])

Figure 3.13 Instant Watch dialog box

Click on the Add button to add the variable to the Watch window.

Watch x|
RE HEA / iy X & @ &

{long[10]) [Auto]

|4 [+ watch 4 watchz } wistchs j watcha 7
Figure 3.14 Watch window (array display)

Alternatively, you can specify a variable name to be added to the Watch window. Click the right mouse button in the Watch
window and choose Add Watch from the popup menu. The dialog box shown below will be displayed.

Add Watch ﬂil
“ariable or expression:
i LCancel

Figure 3.15 Add Watch dialog box
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Enter variable ‘i in the Variable or expression edit box and click on the OK button.
The int-type variable ‘i’ will be displayed in the Watch window.

#
RE CHEA /X ||~

{long[10])
{int) [Buto]

[Auto]

([ p ]\ watcha £ watchz }, wiatchz j watcha [

Figure 3.16 Watch window (showing a variable)

Click on the “+” mark shown to the left of the array ‘a’ in the Watch window. You can now look at the individual elements of

the array ‘a.’
|
RE OVF/ #8x | @&
1 {long[10]) [Zmto]
----- R [0] H'00000000 { FFBFEA } (long)
----- B [1] H'000053de { FFBFBE } (long)
----- R [2] H'00002704 { FFBFCZ } (long)
----- B [3] H'00005665 { FFBFCE } (long)
----- R [4] H'00000daa { FFBFCA } (long)
----- B [5] H'0000421f { FFBFCE } (long)
----- R [6] H'00003ead { FFBFDZ } (long)
----- B [7] H'00004d1d { FFBFD& } (long)
----- R [8] H'00002f5a { FFBFDA } (long)
----- R [8] H'000020da { FFBFDE } (long)
""" i H'000a { B3 } (int) [Ruto]
(4[] watcha £ watchz }, wiatchs § watcha 7

Figure 3.17 Watch window (showing array elements)
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3.12 Showing Local Variables

By using the Local window, you can view the local variables included in a function. As an example, let’s check the local
variables of the tutorial function. Four local variables are declared in this function: ‘a,” ¢j,” ‘i’ and ‘p_sam.’

Choose Symbol — Locals from the View menu or click on the Locals toolbar button ] to display the Locals window.

The Locals window shows the values of local variables in the function indicated by the current value of the program counter
(PC).

If no variables exist in the function, no information is displayed in the Locals window.

locals A
‘ g6 108 2

Naaue | Value | Type

----- a { FFEFBA } [long[10])

-------- 3 H'0000Z0da { ERZ } [{lonog)

H'OODO= { B3 } [int)

----- p_sam OxO0ff93ed4 { ER4 }  [class Sample*)

Figure 3.18 Locals window

Click on the “+” mark shown to the left of array a in the Locals window to display the elements comprising array a.
Confirm that the random data are being sorted into ascending order by inspecting the elements of array a before and after
execution of the sort function.

3.13 Single-Stepping through a Program

The High-performance Embedded Workshop provides various step commands that will prove useful in debugging programs.

Table 3.0.1 Step Options
Command Description
Step In Executes a program one statement at a time (including statements within functions).
Step Over Executes a program one statement at a time by ‘stepping over’ function calls, if there are any.
Step Out After exiting a function, stops at the next statement of a program that called the function.
Step... Single-step a program a specified number of times at a specified speed.
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3.13.1 Executing Step In Command

The Step In command ‘steps in’ to a called function and stops at the first statement of the function.
To enter the sort function, choose Step In from the Debug menu or click on the Step In toolbar button.

!

Figure 3.19 Step In button

B &l

Line

Source.. | E..

{8

Source

11
12
13
1s
15
14
17
1a
13
20
21
22
23
24
25
26
27
28
23
30
31
az
a3
a4
35
36
a7
aa
ag
40
g1
a3
43
14
45
45
a7
48
49
a0
S1
52
53
54

4

002ooo
O0Z0oo
OoEoio
DOZO16
00201k
O0201E
ODZ0Z2
Q0E0ER
O0Z0ZE
002034
002034
002040
Q0Z046

DO0Z048

DOZ054
002056
O0205C
002054
OoE070
DOZ0TA
O0zaea
0020 A%
ODzZ0E2
ODz0oDa

O0zZ0FC

002 106
OD2ii4

Sample::Sample ()
{
a0=0;
1=0}
a22=0;
33=0;
4=0;
55=0;
=0}
a7=0;
a8=0;
a9=0;
1

s
int g IntBuf:
char g CharBuf:

Void Sample::sorc(long *a)
i
long t©:
int i, j, k, gap:

gap = 5;
while|{ gap > O 11
for( k=0; k<gap; k++i(
for| i=k+gap:; i<10; i=i+gap )1
for (j=i-gap;: j>=k: j=i-gap){
g_IncBul = 3:
it{all]=all+gap] )i
t = alj]:
wal3]l = alitgapl;
ali+gap]l = t:
}
aelze
brealk:

]
gep = gep/2;
}
g_CharBuf = (char)g IntBuf & Ox00FF:

<& Tutonalcpp <2 sot.cpp J

Figure 3.20 Editor window (Step In)

The highlight in the Editor window moves to the first statement of the sort function.
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3.13.2 Executing the Step Out Command

The Step Out command takes execution out of a called function by completing its execution at once and only stopping at the
next statement of the program from which the function was called.
To exit from the sort function, choose Step Out from the Debug menu or click on the Step Out toolbar button.

i+

Figure 3.21 Step Out button

~icix

[ @le)

Lin= Source... .. 5.| Souce |
28 |00104C roid tutorial {(wvoid) j
30 {

31 long a[lo]:
3z lang 32
a3 int i;
34 class Sample *p_sam;
35
36 |D01054 p_sam= new Sample;
37 |ooiosc Eox( i=0; i<10; S&+ )4
A 001064 j = rand{};
39 |00106C i3 < Ot
40 |oo1o70 3= =g
a1 }
42 |ooio72 a[i] = §;
b : warch
Wakel
44 0oio8s [ P_Sam-r3oTs (ah: 22 A
45 001090 G p_sam-»ohange (a) ! [ | =l |§ | P
46
47 |ooaose p_=am->sle=a[0]; Hame [ Walus | Typs | Scope |
48 |0010R0 p_sam-»si=afl]: 3-8 a [ FFEFEA } {lang[10]) [Auto]
;: gg}lggg D_Saﬁ'ﬁ'a::ﬂ:g%f B [0] H'00000000 { FFBEEA } {lang)
1 D_BEI.H.—}B =& H = I -
51 |0010BE P sam->ed=ad]; B (1] H00000dss { FFEESE | (long)
52 |ooiocd p_sam-r=i=a[8]; B o[z] H'000020ds | FFERCZ } {long)
&3 |0010D0 p_sam->zé=a(6]: B (3] w='00002704 { FFEFCE } {lang)
:; gg}lgg‘; D.Sﬂﬂ'”::a::%f B [4] H'00002£5a { FFEFCA } {lang)
1 p_sau—:-s,.:.a g1r7 -
5§ DoioFs P sAm >etea[0]; B (5] H'00003ead { FFEFCE } {long)
7 |0o1100 delete p_sam: B (8] H"QOD0<21f | FFEFDZ | {long)
5B |D01106 } B (7] ®'00004dld { FFEFDE } {long)
23 - o - B [E] H'000053dc [ FFRFDA } {long)
bl i M ahore {radd B [o] H'0000SEE5 | PFEFDE } {long)
&2 i H'00Da { R3 } {int} [Auto]
:E s ! 4[| watchy f watcha ), waicha b wwatcrd [ —
Al | I

Figure 3.22 Editor window (Step Out)

The data of the variable ‘a’ displayed in the Watch window will have been sorted into ascending order.
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3.13.3 Executing the Step Over Command

The Step Over command executes the whole of a function call as one step and then stops at the next statement of the main

program.

To execute all statements in the change function at once, choose Step Over from the Debug menu or click on the Step Over

toolbar button.

[T

Figure 3.23 Step Over button

- Tultoralcpp ) I

B

=101 %]

Lin= Source... | E| €. 5. Souce |
29 |00i0ac rroid tutorial (woid) j
20 {

31 long a[l0]:
32 lang 3:
33 int i;
iz class Sample *p_=am:
35
36 001054 p_sam= new Sample;
37 |00105C Far( i=0; i<l0; S++ )4
3@ 001064 j = rand{};
39 |00106C 1f(3 < G014
40 (001070 3= =3z
41 }
42 001072 ali] = 3;
b :
44 |ooioass [ p_sam->3ort (a): Muates A
45 001030 p_sam-rchange (a) ; R = | oHER S By |§ | # 2
45
27 |ooioas ] p_sam-wsl=af0]: Nams Walue | Type | scape |
48 |0010A0 p_sam-»sl=a(l]: 2R a [ FFBFEA } {long[10]} [Auta]
;: Egiggs D_Saﬁ'i'a;:a:;%-' B (0] H'ODDOSEES { FFEEFEA | {lang)
E‘_BE.H'.—}B =a H = "y =

% | eraaee P sam ded=a[d]: B (i) H ED:I':IE-E:L: { FFBFEE } {long)
52 |oolocd p_sam->sb=a5]; B o[2] H'0000<ald | FFEFCZ } {long)
£3 |0010D0 p_sam=rab=a[6]: B [3] H'0000421f { FFBFCE }  {long)
:; Eg}lg:‘; D.Saﬂ'”::a::%-' B [¢] H'00003=ed { FFEFCA } {long)

1 ﬂ_SE.I:I.—}-S«..:&. g1r "
2= oo P sam >=g=a(0] ; B (5] H'O0002£5a | FFEFCE } {long)
T 001100 delete p_sam; ] [&] H*QODOZ704 { FFEFDZ2 ] {long)
58 (001106 } B [7] H'000020da { FFRFDE } {long)
52 . o » B [E] H'00000dea { FFEFDA } {long)
gg s T abart (void) B [9] H"00000000 | FFEFDE } {long)
&2 1 H'000a [ BRI } {int} [Auto]
63 |op1l0C }
o [T watchs { wicha J, wanchs | watcka [ —

| | il P

Figure 3.24 Editor window (Step Over)

The data of the variable ‘a’ displayed in the Watch window will have been sorted into descending order.
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3.14 Forcibly Breaking Program Execution

The High-performance Embedded Workshop permits you to forcibly break program execution.
Clear all breakpoints.
To execute the rest of the tutorial function, choose Go from the Debug menu or click the on Go toolbar button.

2l

Figure 3.25 Go button

Since the program execution is now in an endless loop, choose Stop Program from the Debug menu or click on the Halt toolbar
button.

Figure 3.26 Halt button
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3.15 Hardware Break Facility

A hardware break causes the program to stop when it executes the instruction at a specified address (instruction fetch) or reads
from or writes to a specified memory location (data access).

3.15.1 Stopping a Program when It Executes the Instruction at a Specified Address

It’s easy to set an instruction fetch event in the Editor window. For example, you can set an instruction fetch event where the
sort function is called.

Double-click in the row of the Event column which corresponds to the source line containing the call of the sort function.

=0l x|
= &l
Line Source... | E.| C.| 5. Source |

36 |001054 p_sSam= Sample; ZI

37 |00105cC for( i=0; i<10; i++ )4

38 001064 3 = randi):

39 |00106C if(y < 014

40 001070 1= -a:

41 B

4z |00107z2 al[i] = 3:

43 B

44 (001088 |HY b Sam-rsortia) :

45 |0010=20 b_sam->change (a) ;

45

47 001098 b_sam-x>s0=a[0] ;

45 (001040 b _sam-x>sl=al[l]:;

49 001048 b _sam-x»sZ=alZ]:

50 |0010E0 b _sam-=s3=al[3];

51 |0010E& b _sam-=s4=a[4] ;

S22 |0010C4 b_sam-=s5=a[3] ; =
1] | v 4

Figure 3.27 Editor window (setting a hardware breakpoint)

The source line that includes the sort function will be marked with 7, indicating that a hardware breakpoint has been set
there. This will cause the program to stop when it fetches the corresponding instruction.
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3.16 Stopping a Program when It Accesses Memory

To make a program stop when it reads or writes the value of a global variable, follow the procedure below.

Choose Event -> Hardware Break from the View menu to open the Hardware Break dialog box.

Open the OR page of the Hardware Break dialog box. Select a global variable in the Editor window, and drag-and-drop the
selected variable into the OR page so that the program will stop when it reads or writes the value of that variable.

Then click on the Apply button.

The program will stop running when it reads or writes the value of the global variable you have set.

-loix

Hardware Break OR I

—Event:
Evert | T.] Descriptions | co... | Ta... | comment |
Em O [Address] _o_IntBuf... - -

add... I [relape | Enable | Disakle I

Evert used 1 Free 15 Dekai.-.l Reg'rstaradavmts...l
save... | Losd... | Hele | apply [ close |

g

Figure 3.28 Hardware Break dialog box

Notes: (1) To be selectable, a global variable must be represented by 1, 2, or 4 bytes in memory.
(2) Local variables cannot be set as hardware-break conditions.
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3.17 Tracing Facility

The tracing facility of the E100 emulator includes a special memory unit known as “trace memory” that can hold a record of
the execution of up to 4-M bus cycles. This memory is constantly updated during program execution. The contents of trace
memory are displayed in the Trace window.

Choose Code —> Trace from the View menu or click on the Trace toolbar button ].

The Trace window shown below will be displayed.

mve|Fsazz i Ed4dr Elaaa
[Range:, Filer (Cycle: nddeess Time: |

cycle Label | kddress | Data Size B/W | BWT | Status | Active | Ares | IMDD | IMDZ  DEEUG | USRC | IRQ | DBEG | RESETF | WML | STEYF | BV | TimeStemp (him:is.rs.us.ns)| |

Figure 3.29 Trace window

The following section gives an outline of the tracing facility and how to set up the facility.
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3.17.1 Showing the Information Acquired in “Fill Until Stop” Tracing

In “fill until stop” tracing, trace information is successively acquired from the start of user program execution until a break is
encountered.

(1) Clear all break conditions. Click the right mouse button with the cursor anywhere in the Trace window and choose
Acquisition from the popup menu. The Trace conditions dialog box shown below will be displayed. Check that the selected
trace mode is Fill until stop. Click on the Close button.

M Trace conditions -l0ix

Trace ] Option |

i
Trace Mode: I i Fill unkil stop :l
condition and combination setting
—# OF condition:
Eventinuse: 0 Cokall I

I~ other condtions:

I;-.r-:l::.’ﬂ-:unu'atmw} ;J

Everginuse: 0 et |

A Excepbion; ——————— Tokal : 0 Ewent

Dy evele) ——

Exeepkional . |
events ekl oM -

—Record condtion:
@ all ¢ Capture  Donot capbure [ Step execution is recorded

Ewent imuse ;0

Evert used 0 Freels Detai,.. | Registered events... |

Save... Load... I Help | Apaly I Close

|

Figure 3.30 Trace conditions dialog box (fill until stop)
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(2) Set a software break on the following line of the tutorial function: “p_sam ->s0=a[0];”.

(3) Choose Reset Go from the Debug menu. Processing will be halted by the break, and the trace information acquired prior to
the break will be displayed in the Trace window.

reace e e ﬂ
Ve |sazzrE|H = aa
|Range: 00009576, 00000000 |Fie: |Cycle: 00000016 Bddress: 00Z18C. Time: 00:00:00,000,537.670 |
| Gyele Lahel Address | Data Size B/W | BWT | Status | Active | ires | TMBO/| IMDZ | DEBUG | UBRC | TRO | DBFG | RESATH | NMI | STBYH | EV | TimeStawp [him:s.ms.us.ns)||4]
-00000016 00218¢ 00024742 LONG WORD R 1] NOFMAL FPETCH  RCM .. - 1 1 1 1 1 1 1 0000000000000000  00:00:00,000.,587. 670
-00000015 00215¢ DFF27901 LONG WORD R 1] NORMAL FETCH  ROM .. - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.537.730
-00000014 002193 OCA46FS] LONG WORD B o NORMAT, FETCH RO . - 1 1 1 1 1 1 1 0000000000000000 00:00:00.000.587.730
3 FFBFAL D0FF LONG WORD R 0 NORMAL  DATA RAM 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.597.860
2 FEBFAC LONG WORD R 1] M RAM - 1 1 1 1 1 1 1 0000000000000000 00:00:00.000
011 FPEFEFAE LONG WORD R 1] FAM - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.
o FFEFEOD LONG WORD R i} RAM - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000. ¢
=00oo =] PFEFEZ LONG WORD R o RAM - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.5
-00000008 FFBEB4 LONG WCRD R 0 RAM 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.
-00000007 FPFBFEA LONG WORD B 1] RAM - 1 1 1 1 1 1 1 0000000000000000  O0:00:00.000
~00000006 PEBEES LONG WORD R 1] RAM - 1 1 1 1 1 1 1 0000000000000000  00:00:00,000.
=00000005 000000 - R 1] - - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000,
-00000004 01098 57706970 LONG WORD B o ROM - 1 1 1 1 1 1 1 0000000000000000 0O0:00:00.000.
~00000003 00109 010069¢0 LONG WORD R 1] ROM - 1 1 1 1 1 1 1 0000000000000000  00:00:00,000.
-00000002 001040 - - R 1 - . - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000,
-00000001 0010A0 - B 1 - . - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.
00000000 0010A0  —--—---- - E o NORMAL - - . - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000. j

Figure 3.31 Trace window (fill-until-stop tracing)

(4) A mixed display of bus information and disassembly listing is possible. Choose Display Mode —> DIS from the popup
menu to view trace information in mixed bus and disassembly mode.

£
ﬁnge: 00003576, (0000000 [Fle: |Cycle: -00000020 [Address: FREFDE Time: 00:00:00.000,597.420 |
(cycle Lebel | Rddress | bata | Size B/W| BWD | Status | hctive | Ares | INDO | TMDZ | DEBUG | UBRC | IRQ | DEFG | RESETH | N1 | STEYH | EV [ TimeStemp |him:s.ms.us.nsy) <]
=00000020 PFBEDE  ----0000 LONG WORD W o HORMAL DATA RAM - - 1 1 1 1 1 1 1 0000000000000000 00:00;00,000,597, 420
-00000012 FFBFEQ 0000---- LONG WORD W 1 NORMAL DATA RAM P - 1 1 1 1 1 1 1 0000000000000000 00:00:00.000,597. 420
00z1 INC.W #1,R0
~00000018 FERFEQ 0000---- LONG WORD W o NORMAT  DATA RAM S o = 1 1 1 1 1 1 1 0000000000000000  00:00:00.000,597. 540
00217 cMP.W #E'000A: 16, RO
-00000017 opz1es 54Z46F51 LONG WORD R 1} NORMAL FETCH  RCM S o 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.587.610
002162 BLT QK'215¢:8
-000000Le oozigc 00024742 LONG WORD R 1] NORMAL PETCH ROM P - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.597.670
02184 ADD.W #H'0024: 16, R7
-00000015 an2 15¢ OFF27901 LONG WORD B o NORMAT, FETCH ROM - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.597.730
-000000L4 002190 DCA46F5SL LONG WORD R o HORMAL  PETCH  ROM - 1 1 1 1 1 1 1 0000000000000000  00:00:00,000,597,730
FPBFAA F LONG WORD R 0 HORMAL DATA RAM - 1 1 i 1 1 1 1 0000000000000000  00:00:00,000, 880
FEBFAC LONG WORD B 1] NORMAT,  DATA RAM - 1 1 1 1 1 1 1 0000000000000000 00:00:00.000. azn
PFRFAE LONG WORD R o NORMAL,  DATA RAM - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000. 980
FFBFEO 000A&---- LONG WORD R 1] NORMAL DATA BAM - 1 1 1 1 1 1 1 0000000000000000 00:00:00.000,593.040
FEBFEL —---0000 LONG WORD R 1] NORMAL BAM - 1 1 1 1 1 1 1 0000000000000000 00:00:00.000.598.110
PFBFE4 20D LONE WORD R 1] HORMAT  DATA RAM 1 1 1 1 1 1 1 0000000000000000  O0:00:00.000. z'

Figure 3.32 Trace window (mixed bus and disassembly mode)
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(5) Choosing Display Mode —> SRC from the popup menu, on the other hand, shows a mixture of bus information,
disassembly listing, and source code as the trace information.

A
[Fienge; -00003576, 00000000 |Fée: [Cyrle: -00000022 [Address: 002154 Time: 00:00:00.000,557.250
(eyele Label | hddress | bata | Size B/U | BWT | Status | kctive | fres | TNMB0 | IMDZ | DEBUG | UBRC | TRQ | DEFG | RESHTH | NMI1 | STEYH | EV | TimeStemp (him:s.ms.us.ns)|]
-00000022 002184  7917002A LONG WORD R o HORMAL FETCH RCGM . . - 1 1 1 1 1 1 1 0000000000000000 00:00;00,000,597,290
-00000021 FFEFDE =---0000 LONG WORD W 1 NORMAL DATA RAM .. - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.537.3680
02178 I ER4,BERL
-00000020 FERFDE ===--0000 LONG WORD W o NORMAT,  DATA RAM S o = 1 1 1 1 1 1 1 0000000000000000  00:00:00.000,597. 420
-000000128 FFEFEQ D000---- LONG WORD W 1 NORMAL DATA RAM .. - 1 1 1 1 1 1 1 0000000000000000 00:00:00.000.597. 480
0oz1 1 #1,R0
-00000018 FERFED 00---- LOWS WORD W o NORMATL  DATA RAM . . S 1 1 1 1 1 1 1 0000000000000000  O0:00:00.000.597. 540
00z17E Y #E'000A: 16, R0
=00000017 o0z 188 542Z46F51 LONG WCRD R o HORMAL FETCH ROGM . . - 1 1 1 i 1 1 1 0000000000000000  00:00:00,000,587, 610
o018 BLT QE'215c:8
-000000Le ooz i1ec 00024742 LONG WORD R o HORMAL  PETCH  ROM . - 1 1 1 1 1 1 1 0000000000000000  00:00:00,000,597. 670
67 )
002 ADD W i D2A:16,R7
~00000015 00z 15¢ OPF27901 LONG WORD R o RO = 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.597. 730
-00000014 002190  OcaA46F51 LONG WORD R 0 RO - 1 1 i 1 1 i i 0000000000000000  00:00:00,000,597. 790
-00000013 FEERAR 00FF LONG WORD R o RAM - 1 1 1 1 1 1 1 0000000000000000 00:00:00.000.597.880
00000012 PERFAL 4 LONE WORD 0 RAM 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.587.920 z'

Figure 3.33 Trace window (mixed bus, disassembly, and source mode)
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3.17.2 Showing the Information Acquired in “Fill around TP” Tracing

In “fill around TP” tracing, the acquisition of trace information is stopped a specified number of cycles after a trace point is
encountered. This facility allows you to use trace information to keep track of program flow without having to break the user
program.

(1) If any break conditions are set, clear all of them.

(2) Choose “Fill around TP” as the trace mode in the Trace conditions dialog box. In the Delay (cycle) section, specify 4M.
(Up to 4-M cycles of trace information from where a trace point is encountered will be acquired.)

M Trace conditions * ) _;lﬂlﬁl

Trace |oR | option |

1
Trace Made: | - am h?nli waine - Fill around TP :l
condition and combination setking
" R condition:

Eventinuse: 0 Detail I

[~ other candtions:

I-'-.r-:D'a'a.:tJnu ation ) j i

Evertinuse: 0  [ebail |

" Total : 0 Ewent
—;En:fptlnln . Delay(cvele:
ceptions P | ST
events ﬁ_rlll 4M -
—Record condtion:
@ all  Capture  Donot capbure " Stepexecifionis recorded

Ewvenkinuse : D

Event used 0 Free 16 Detal..-l Registﬂredavenbi...l
SEVE, ., | Load. .. ] Help | Apply I Close I
g
Figure 3.34 Trace conditions dialog box (Fill around TP)
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(3) Next, set the trace point, i.e. the point where the debugger will start acquiring trace information. Open the OR page of the
Trace conditions dialog box. Select the main function in the Editor window and drag-and-drop it onto the OR page. Click
on the Apply button and then the Close button.

Thus, the debugger will start acquiring trace information when the main function is executed.

I Trace conditions * I : .ulu.lil

Trace COR | Option I

—Ewvent:
Evert | T.] Descriptions | co... | Ta... | Comment |

F o [Address] _main - -

add.,. | elebe | Eriakle I Disable I

Evert used 1 Free 15 Datal...| Registﬂrﬂdervents...l
SaVE,., | Load. .. I Heldp | Apply I Cloze I
g

Figure 3.35 Trace conditions dialog box (OR page)

(4) Choose Reset Go from the Debug menu. As soon as the trace point is reached, trace information as shown below will start
to be displayed in the Trace window.

Trace [ E|
mveop|lsazznE=4p | [aaa |
[Renge: -00000001, 04134302 [Fie: |Cycle: 00000001 Address: FFBFFC [Tine: 00:00:00,000,405.310 |
Cyule Lakel hddress | Data Size /W | BWT | Stetus | Active | Ares | IMDO | IMDZ  DEBUG | USRC | IRQ | DBEG | RASET# | NMI | STBY# | BV [h:m:a.m.us‘ns:“g
"""""" 0 . . = 1 1 1 il 0000000000000000  00:( 10. 405.910
00000000 001040 47085508 LONG WORD R O NORMAL FETCH  ROM - 1 1 1 1 1 1 1 0000000000000001  00:00:00. 000. 405. 830
00000001 001044  OP990FE0 LONG WORD B O NORMAL FETCH  ROM B 1 1 1 1 1 1 1 0000000000000000  00:00:00, 000, 406. 040
00000002 001048 46F85470 LONG WORD R 0 WORMAL FETCH  ROM o) i 1 i i i 1 1 0000000000000000  0D:00:00,000, 406, 100
00000003 00104%  ——-5470 MORD R O UORMAL  PETCH  ROM - 1 1 1 1 1 1 1 0000000000000000  00:00:00. 000. 406. L60
00000004 eutorial() 00L04¢  01206PEZ LONG WORD R 1} NORMAL FETCH  ROM = 1 1 1 1 1 1 1 0000000000000000  00:00:00,000, 406,230
00000005 FFEEFS 00001044 LONE WORD W 1 NORMAL  STACK  RAM - 1 1 1 1 1 1 1 0000000000000000  00:00:00. 000. 406. 220
00000006 PEEPFS  0ODD1044 LONG WERD M O NORMAL  STACK  RAM - 1 1 1 1 1 1 1 0000000000000000  00:00:00. 000. 406. 350
00000007 001050 79370032 LONG WORD R 0 HORMAL FETCH — ROM o) 1 1 i i i 1 1 0000000000000000  0D:00:00,000. 406,410
00000008 001054  LaBOSEOD LONG WORD B O UORMAL FETCH  ROM - 1 1 3 1 1 1 1 0000000000000000  00:00:00. 000. 406. 480
00000009 0oLose 20000r84 LONG WORD R 1} NOFMAL PETCH  ROM = 1 1 1 1 1 1 1 0000000000000000 00:00:00,000, 406, 540
00000010 FFBEF4 00000000 LONE WORD W 1 NORMAL DATA  RAM - 1 1 1 1 1 1 1 0000000000000000  00:00:00. 000. 406 600
00000011 FEBFF4 00000000 LONG WORD W O UORMAL DATA  RAM - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000. 406 660
T PFEFF0 00000000 LONG WORD W 1 NORMAL  DATA RAM - 1 1 1 1 1 1 1 0000000000000000  00:00:00,000, 406,730
00000013 FEBEE0 00000000 LONG WORD W O NORMAL DATA  RAM - 1 1 1 1 1 1 1 0000000000000000  00:00:00. 000. 40E. 7290
00000014 FEEFEC 00000000 LONG WORD W 1 NORMAL  DATA RAM o 1 1 1 1 1 1 1 0000000000000000  00:00:00.000. 406 . 850
o000001S FFEFEC  000DDODD LOWG WORD W O NORMAL DATA  RAM - 1 1 1 1 1 1 1 0000000000000000  00:00:00, 000, £06. 920 =l

Figure 3.36 Trace window (Fill around TP)
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3.17.3 Showing a History of Function Execution

You can extract the history of executed functions from the acquired trace information.

(1) Clear all break conditions. Click the right mouse button with the cursor anywhere in the Trace window and choose
Acquisition from the popup menu. The Trace conditions dialog box will open. Switch to fill-until-stop tracing and click on
the Apply button and then the Close button.

(2) Set a software break on the following line of the tutorial function: “p_sam—>s0=a[0];”.

(3) Choose Reset Go from the Debug menu. Processing will be halted by the break, and the trace information acquired prior to
the break will be displayed in the Trace window.

(4) Click the right mouse button with the cursor anywhere in the Trace window and choose Function Execution History ->

Function Execution History from the popup menu.
rrace L E

:Ranm: -00009578, 00000000 |Fia: |Cyde: -00000006 Address: FREFES [Time: 00:00:00.000.598.290

| cyele Lobel | 2ddress | pata Sire E/W | RWI | Stetus | Active | Ares | IMD0 | IMDZ | DEBUG | UBRC | IRQ | DBFG | RESET# | NMI | STEYA | EV | Timestemp (him:s.ms.us.ns)|[=]
-00000006 FFBEES  1098—-— LONG WORD B O NORMAL STACK  RAM . . - 1 1 11 1 1 1 0000000000000000  00:00:00.000.598.230
-00000005 000000 —--—--—- - R O NORMAL - - - 1 1 11 1 11 0000000000000000  00:00:00,000, 598,350
=00000004 001098 57706970 LOWG WORD R O NORMATL FETCH  Red - 1 1 11 1 1 1 0000000000000000  00:00:00,000, 598, 410
-00000003 00109 D10080CD LONG WORD & O NORMAL  FETCH  Rotl - 1 1 11 1 o1 0000000000000000  00:00:00.000. 598 430
-00000002 001040 E 1 NORMAL - S S 1 1 11 1 11 0000000000000000  00:00:00,000, 598, 540
-00000001 001040 B NORMAL, - - - 1 1 i1 1 1 1 0000000000000000  00:00:00.000, 598, 600
00000000 001040 R O NORMAL - - - 1 1 11 1 11 0000000000000000  00:00:00.000.598. 650 Z'

Figure 3.37 Trace window (function execution history—before analysis)
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(5) Click the right mouse button with the cursor anywhere in the lower pane of the Trace window and choose Analyze
Execution History from the popup menu. The history of function execution will be displayed in the upper pane.

Trace [ El
-vep|lsazzREF4) = aaa \

- <_PoweroN_Reset> (00040¢) =
__INITSCT (00110E) <= 000402

T o000 <Display form of function execution history>
E-tutoriall) (00104¢} <= 001042 ; ) )
& Semplerssample () (002000 <- 00106 Function name (start address of function) <— function caller address

= _rand (0011B2) <- 001064

e 0ot e oo O Example: _main (00103C) <- 00040E

= _rand (0011B2) <- 001064

I |

[Range: -00003578, 00000000 [Fle: [Cycle: -00005083 Adckess: 001040 [Time: 00:00:00.000,405.360

Cycle Label Address | Data Size E/1 | EWT Status | Active | Area | IMDO | IMDZ | DEBUG | UBRC | IRQ | DBFG | RESET#  KMI | STBTR EV .us,n:);‘
-00003083 001040 47035508 LONG WORD R NORMAL a = 1 1 1 1 1 1 1 0000000000000000

-00003082 001044 OFG30F20 LONG WORD R 1] NORMAL  FETCH ROM - 1 1 1 1 1 1 1 0000000000000000

~00003081 001048 46785470 LONG WORD R o NORMAT,  FETCH ~ ROM = 1 1 1 1 1 1 1 0000000000000000

-00003080 00104a —---5470 WORD R 1] NORMAL FETCH ROM - 1 1 1 1 1 1 1 0000000000000000

-00003079  tutorial() 00104¢  01Z0BDFZ LONG WORD R o NORMAL FETCH  ROM = 1 1 1 1 1 1 1 0000000000000000 e
-00003078 FFBFFE 00001044 LONWG WORD W 1 NORMAL  3TACK  RAM = 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.406.230
-00003077 PEREFY 00001024 LONG WORD W o NORMAL  STACK RAM - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.406.3350 j

Figure 3.38 Trace window (function execution history—after analysis)

(6) Double-click on a function in the upper pane to view the trace information corresponding to that function in the lower pane.
Trace [ E|

mvelseazz|nE=54) 8aaa
5 <_Powerol_Reset> (00040¢)
__INITSCT (00110E} <- 000408
B _madin (00L03¢) <= O0040E
E-tutorial() (D0104c) <- 001042

I

= 2}
@ _rand (0011B2] <= 001064
& _rand (001162} <- 001064

[Range: -D000IS7S, 000000 Fik:  Cycle: -00003050 [Addreas: 002004 [Tene: 00;00:00,000.407.420 |

Cycle Label Address | Data Size B/W | BWr | Status | Active | Area | IMDO | IMDZ | DEBUG | UBRC | IR | DBFG | RESETH | NMI | STEF# | EV TimeStamp (him:s.ms.us.nsj||
-00003060 002004 TAl D R 1] HO E .. = 1 1 1 1 1 0000000000 o000 00:00. 000 ]
-00003039 o0z0o08 SEDOL16E LONG WORD R o NORMAL FETCH  ROM = 1 1 1 1 1 1 1 Q000000000000000  00:00:00.000, 407,480
~00003058 oozoLo 1A910100 LTNG WORM R o HORMAL FETCH  ROM = 1 1 1 1 1 1 1 Q000000000000000  00:00:00.000, 407.540
-00003057 00200c  OPBO4TIE LONG WORD R a HORMAL FETCH  ROM C 1 1 1 1 1 1 1 0000000000000000  00:00:00.000. 407, 600
-00003056 opecator new( D01166 ====0110 WORD R o HOFMAL FETCH  ROM - 1 1 1 1 1 1 1 0000000000000000  00;00:00.000, 407.670 -
-00002055 FEBFBZ —---0000 LONG WORD W 1 HOFMAL STACKE  RAM = 1 1 1 i aly 1 1 Q000000000000000  00; 00:00.000, 407.730
-00003054 FPEPBZ ====0000 LONG WORD W ] HOFMAL STACKE  RAM o 1 1 1 1 1 1 i Q000000000000000  00:00:00.000, 407.700 ;I

Figure 3.39 Trace window (function execution history)
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3.17.4 Filtering Facility

Use the filtering facility to extract specific cycles from the acquired trace information.

This is achieved by software filtering of the trace information that was acquired by hardware.

Unlike the “Capture/Do not Capture conditions” where you set conditions for acquisition before getting the trace information,
this facility allows you to change filter settings for the acquired trace information any number of times without having to
reexecute the program. This makes it easy to extract the information you need.

(1) Clear all break conditions. Click the right mouse button with the cursor anywhere in the Trace window and choose
Acquisition from the popup menu that is displayed. The Trace conditions dialog box will be displayed. Check that the
selected trace mode is Fill until stop. Click the Close button.

(2) Set a software break on the following line of the tutorial function: “p_sam—>s0=a[0];”.

(3) Choose Reset Go from the Debug menu. Processing will be halted by the break, and the trace information acquired prior to
the break will be displayed in the Trace window.

(4) Choose Auto Filter from the popup menu of the Trace window. The columns for which filtering can be applied will be

marked by a [EI] button.
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Figure 3.40 Trace window (Auto Filter)
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(5) Click on the [EI] button in the R/W column and choose R.
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Figure 3.41 Trace window (Auto Filter)

(6) The Trace window now only shows trace information for cycles that have R in the R/W column.
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Figure 3.42 Trace window (Auto Filter)

Notes:
(1) Filtering does not affect the trace memory, so that its contents remain intact.
(2) Filtering is available for trace information regardless of whether the setting is fill until stop, fill until full or fill around TP.
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3.18 Stack Trace Facility

Stack information can be used to find out which function called the function corresponding to the current PC value.
Set a software breakpoint in any line of the tutorial function by double-clicking on the corresponding row in the S/W
Breakpoints column.

Line Source... | E.| C.| 5. Source
29 |00104cC woid tutorial (wvoid)
30 i
31 long af[10] :
3z long j:
33 int 1i:
34 class Sample *p sSam;
35
3o 001054 p_Sam= SJample:;
37 (00105C for( i=0; i<10; i++ ){
38 (001064 i = rand():
39 |(00106C & if(y < a4
40 (001070 i=-a:
41 }
4z (001072 ali]l] = 3:
43 }
44 |001085 b_sam->sortia);
45 |001020 b_samw->change (a) ;
46
47 (001098 b_samw->s0=a[0] ;
45 (001040 b_sam->sl=al[l]:
49 001045 b_sam->si=alz]:
50 |0010EQO b_sam->s3=al[3]:
51 |0010ES b_sam->sd=al[4] ;
S22 |0010C4 b_sam->s5=al[3] ;
53 |0010DpO b_sam->s6=al6] ;
54 |0010DC b_sam->sV=al[7]:
55 |0010ES b_sam->s8=al[&] ;
56 |0010F4 b_sam->s3=al[2] ;
57 (001100 b_sam;
58 (001106 }
59
60 |00110cC wold abort (void)
61 i
62
63 |(00110cC }

Kl

% Tutonalcpp [« sortcpp |

Figure 3.43 Editor window (setting a software breakpoint)

Choose Reset Go from the Debug menu.
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After the break, choose Code —> Stack Trace from the View menu to open the Stack Trace window.

£l
Kindl Namme | Walue |

F tutoriall) { 001062 )

F maini) { 001044

F PowerON Rese { 000412 }

Figure 3.44 Stack Trace window

You will see that the current PC value is within the tutorial() function, and that the tutorial() function was called from the
main() function.

Clear the software breakpoint that you set on a line of the tutorial function by again double-clicking on the corresponding row
in the S/W Breakpoints column.

3.19 What Next?

In this tutorial, we have introduced to you several features of the E100 emulator and usage of the High-performance Embedded
Workshop.

The emulation facilities of the E100 emulator provide for advanced debugging. You can apply them to precisely distinguish
the causes of problems in hardware and software and, once these have been identified, to effectively examine the problems.
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4. Preparation for Debugging

4.1 Starting the High-performance Embedded Workshop
Follow the procedure below to start the High-performance Embedded Workshop.

(1) Connect the host machine, E100 emulator, and user system. Then turn on power to the E100 emulator and user system.

(2) From Programs on the Start menu, choose Renesas -> High-performance Embedded Workshop -> High-performance
Embedded Workshop.
The Welcome! dialog box shown below will appear.

Welcome! 1' EI

: | ¥ iCreate a new project workspace: i

Cancel

i [Open arecent project warkzpace:;
I j Admirnistration...

cJ

—' i~ Browse to another project workspace

e

Figure 4.1 Welcome! dialog box

Select the startup method from among the following.

- Create a new project workspace

- Open a recently used project workspace
Select this option when you use an existing workspace.
The names of recently opened workspaces will be displayed.

- Browse for another project workspace
Select this option when you intend to use an existing workspace.
This option is available when there is no record of a recently opened workspace.
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4.2 Creating a New Workspace (Toolchain Unused)

The procedure for creating a new project workspace differs according to whether you are using a toolchain or not.

Toolchains are not included with the E100 emulator. Toolchains can be used in environment in which the C/C++ compiler
package is installed.

Follow the procedure below to create a new workspace.

(1) In the Welcome! dialog box, select the radio button with the caption “Create a new project workspace” and click on the OK
button.

Welcome!

| {* Cieate a new project workspace: oK

Cancel

" Open a recent project workspace:
I j Administratior...

L

j " Browse to another project workspace

N x

Figure 4.2 Welcome! dialog box

(2) The Project Generator will start.

New Project Workspace 21
Proiects |

W d

e ok space Mame

b Dabungar caly - 3008 I
FEropect Hame:
Dirzchan:
I Erowze...
LCFL Famly:
J3acc -]
Tool chan;
[Nene =l

K — i

Propahias.

0F, I Cancel

Figure 4.3 New Project Workspace dialog box

Workspace Name: Enter a workspace name here.

Project Name: Enter a project name here. You do not need to enter any name if you wish this to be the
same as the workspace name.

Directory: Enter the directory in which you want the workspace to be created. Alternatively, click on
the Browse button and select a workspace directory from the dialog box.

CPU family: Select the CPU family of the MCU you are using.
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The other list boxes are used for setting up a toolchain. If no toolchains are installed, fixed information is displayed here. Click
on the OK button.

(3) Select the target for debugging.

Setting the Target System for Debugging

S EI00 Emdator

Tesgel type: [l Targets =

<Back Mest » Fiish | Cancel |

Figure 4.4 Setting the Target System for Debugging dialog box

Select the target platform you wish to use by placing a check mark in its checkbox and click on the Next button.

(4) Set a configuration name. Configuration refers to a file in which information on the state of the High-performance
Embedded Workshop for use with target software rather than emulators is saved.

Setting the Debugger Options i |

|Debug_xoo:_E100_Emdatar

— Dietail options =
Item Walug

Hadip I

<Back | ledo | Fneh | Cancel |

Figure 4.5 Setting the Debugger Options dialog box

If you have selected two or more target platforms, click on the Next button and then set a configuration name for each of the
selected target platforms.
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When you have finished setting the configuration names, emulator-related settings are completed.

Click on the Finish button, and the Summary dialog box will be displayed. Clicking on the OK button in this dialog box starts
the High-performance Embedded Workshop.

(5) After starting the High-performance Embedded Workshop, connect the E100 emulator.

4.3 Creating a New Workspace (with a Toolchain in Use)
Follow the procedure below to create a new workspace.

(1) In the Welcome! dialog box, select the radio button titled “Create a new project workspace” and click on the OK button.

Welcome!

| % Create a new project workspace

" Dpen a recent project workspace:

2%

Qg

X

Cancel

-

j " Browse to another project warkspace

j Adrministation. .

i

Figure 4.6 Welcome! dialog box

(2) The Project Generator will start.

flew Project Workspace
Projects |
Project Types

l"E’E source satup Spplhcation
175 Empty Application

5 Irpar Makefile

'E]_lbran,l
v Diebuger only - 3000 E100E
F+ Debugger only - 300 Simulat

wWnkspace Name:

2 x|

Project Hame:

Directon:

2 family:

| roe
Toal cham:

IFIeﬂcsas M0 Standard

| 0K, | Cancel

Figure 4.7 New Project Workspace dialog box
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Workspace Name: Enter a workspace name here.

Project Name: Enter a project name here. You do not need to enter any name if you wish this to be the
same as the workspace name.

Directory: Enter a directory in which you want a workspace to be created. Alternatively, click on the
Browse button and select a workspace directory from the dialog box.

CPU family: Select the CPU family of the MCU you are using.

Toolchain; To use a toolchain, select the appropriate toolchain here. If you do not use any toolchain,
select None.

The other list boxes are used for setting up a toolchain. If no toolchains are installed, fixed information is displayed here. Click
on the OK button.

(3) Set the CPU and options for the toolchain and make other necessary settings.

(4) Select the target for debugging.

Setting the Target System for Debugging x|

100 Erredator

Tesped type: |4l Targets =

< Back Next > Fiish | Cancel |

Figure 4.8 Setting the Target System for Debugging dialog box

Select the target platform you wish to use by placing a check mark in its checkbox and click on the Next button.
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(5) Set a configuration name.

Setting the Debugger Options

|Dishug_x200¢_E100_Emudator

— Detail options :
e Walue

Hodiy I

Back | lewo | Fnsh | Cancal |

Figure 4.9 Setting the Debugger Options dialog box

If you have selected two or more target platforms, click on the Next button and then set a configuration name for each of the
selected target platforms. When you have finished setting configuration names, emulator-related settings are completed. Click
on the Finish button, and the Summary dialog box will be displayed. Clicking on the OK button in this dialog box starts the
High-performance Embedded Workshop.

(6) After starting the High-performance Embedded Workshop, connect the E100 emulator.
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4.4 Opening an Existing Workspace
Follow the procedure below to open an existing workspace.

(1) In the Welcome! dialog box, select the radio button with the caption “Browse to another project workspace” and click on
the OK button.

Welcome! 2 x|

OF.

; | " Create a new project workspace

Cancel

" Open arecent project workspace;
I j A drinigtration...

o
s J

ie i_ﬂmwse to anather project work space

QLA

Figure 4.10 Welcome! dialog box

(2) The Open Workspace dialog box shown below will appear.

':'FIEEFI 'l,l'l,l'|:|r'l::5|:|.5||:|3 _?I EI
Look in: | =l E100 <] « & ok B

l E100

File name: IE'IEIEI_hws Select I
Files af type: IHEWWnrkspaces [* bz) j Cancel |

Figure 4.11 Open Workspace dialog box

v

Specify the directory in which the workspaces was created, select the workspace file (extension “.hws”), and click on the
Select button.

(3) The High-performance Embedded Workshop will start, and its state will be restored to the state at the time the selected
workspace was saved. If the emulator was connected at the time, the workspace is automatically connected to the emulator.
If the emulator was not connected but you want to connect it, refer to “4.5 Connecting the Emulator” (page 76).
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4.5 Connecting the Emulator

4.5.1 Connecting the Emulator
The following methods for connecting the emulator are available.

(1) Making the emulator settings in booting-up before connection

Choose Debug Settings from the Debug menu to open the Debug Settings dialog box. In this dialog box, you can register
download modules and the command chain to be automatically executed. When you are finished filling in the Debug Settings
dialog box, the emulator will be connected.

(2) Loading a session file

Switching to a session file in which settings for emulator usage have been made in advance simplifies the procedure of
connecting the emulator.

4.5.2 Reconnecting the Emulator
While the emulator is disconnected, you can reconnect it in one of the ways described below.

e  Choose Connect from the Debug menu.

b
e  Click on the Connect toolbar button [L=21].

. Enter the connect command in the Command Line window.
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4.6 Disconnecting the Emulator

4.6.1 Disconnecting the Emulator

To disconnect the emulator while it is active, do so in one of the ways described below.

e  Choose Disconnect from the Debug menu.

e  Click on the Disconnect toolbar button [i

. Enter the disconnect command in the Command Line window.

4.7 Quitting the High-performance Embedded Workshop

Choosing Exit from the File menu closes the High-performance Embedded Workshop.

Before it closes, a message box will be displayed asking you whether you want to save the session. To save the session, click

on the Yes button.
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4.8 Making Debugging-Related Settings
Register download modules, set up automatic execution of command line batch files, and set download options, etc.

4.8.1 Specifying a Module for Downloading
Choose Debug Settings from the Debug menu to open the Debug Settings dialog box.

2]
ISessiu:un:-::-::-::-::-c:-:_E1EIEI_EmuIatu:ur j Target | Elptiu:unsl
...... @ E100 Target:
4 E100 E mulator
Core:
|Single Core Target j

Debug format;
|EI/Dwart2 =l

Download modules:

Filenarme | Offzet Address | Farmat |
$COMFIGDIR]S$(FRO... 00000000 EIF/Diarf2

t ity

Bemaye

I

Up

g

[y

k. I Cancel

Figure 4.12 Debug Settings dialog box

In the Target drop-down list box, select the name of the product you want to connect.
In the Default debug format drop-down list box, select the format of the load module you want to download. Then register a
module in the selected format in the Download modules list box.

CAUTION
At this point in time, no programs have been downloaded yet.
For details on how to download a program, refer to “5.2 Downloading a Program” (page 94).
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4.8.2 Setting Up Automatic Execution of Command Line Batch Files
Click on the Options tab of the dialog box.

ISessiun:-::-::-::-::-c:-:_E'lI:IEI_Emulah:-r j Target Options |

...... @ E100 Cormatd batch file load timing:

Command line batch processing:

[ Dizable batch file execution when downloading debug information

¥ Download modules after build

¥ Femove breakpoints on download

[ Dizable memony access until after target connection command file execution
[ Limit dizassembly memony access

[ Do ot perform automatic target connection
I¥ Beset CPU after download module
[ Dizable memony access by GUI when target is executing

k. I Cancel

Figure 4.13 Debug Settings dialog box

Here, register a command chain to be automatically executed with the specified timing.
Select your desired timing from among the following four choices:

- When the emulator is connected
- Immediately before downloading
- Immediately after downloading

- Immediately after a reset

In the Command batch file load timing drop-down list box, select the timing with which you want a command chain to be
executed.

R20UT3587EJ0302 Rev.3.02 Page 79 of 232
Sep.01. 21 ENESAS



ROE417250MCUO00 User’s Manual

5. Debugging Functions

5. Debugging Functions

The E100 emulator supports the functions listed in the table below.

Table 5.1 List of Debugging Functions

Item

No. Item

Specification

1 Software break

4,096 points

Number of event points Maximum number of effective points: 16
Executed address detection
Data access detection

Event type - - -
Interrupt generation or exit detection

2 Event - -

External trigger detection

Task ID Can be set separately for each event

Condition for number of times an event has

occurred Up to 255 times

3 Exception detection

Violation of access protection

Reading from non-initialized memory areas

Stack access violation

Performance-measurement overflow

Realtime profile overflow

Trace memory overflow

Task stack access violation

OS dispatch

Hardware Event combination OR, AND (cumulative), AND (simultaneous), subroutine,
4 Hardware breakpoints . _ sequ_entlal and state transition
break Exception detection See item No. 3
Delay Maximum 65,535 bus cycles
Trace size Maximum 4-M cycles
Fill until stop Trace acquisition continues until the program stops running.
Fill until full Trace acquisition stops when trace memory becomes full.
Fill around TP Trace acquisition proceeds for a delay in cycles after the trace point
Trace mode has been reached.
Information for a total of 512 cycles before and after each trace
Repeat fill until stop | point are acquired, and this continues until the program stops.
Information for a total of 512 cycles before and after each trace
Repeat fill until full point are acquired, and this continues until trace memory is full.
5 Trace E A OR, AND (cumulative), AND (simultaneous), subroutine,
. vent combination - i
Trace point sequential and state transition
Exception detection See item No. 3
Delay Up to 4-M bus cycles

Extraction/deletion of trace data

Extracting or deleting data by specifying events
- Between two events
- Duration of an event
- Duration of an event occurring in a subroutine

Instruction accessing specific data

Content of measurement

Measures maximum, minimum and average execution time, and
number of passes, for up to 8 sections

Timeout detection

6 Performance

Resolution 10nsto 1.6 us

Measurement —— Between two events, Period of an event and Interrupt-disabled
Event combination

mode range between two events

7 RAM monitor

512 hytes x 32 blocks
- Shows last read/write accesses performed
- Includes a facility to detect reading from non-initialized areas

8 Profile

128 Kbytes x 8 blocks (1-Mbyte space)

Cumulative time and number of passes overflow detection
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Table 5.1 List of Debug Functions (cont)

Item
No.

Item

Specification

9 Coverage

CO-level code coverage
256 Kbytes x 8 blocks (2-Mbyte space)

CO + C1-level code coverage
128 Kbytes x 8 blocks (1-Mbyte space)
Address range and source file

Data coverage
64 Kbytes x 8 blocks (512-Kbyte space)
Address range, section, and task stack
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5.1 Setting Up the Emulation Enviroment

When the emulator is connected, the Device setting and the Configuration properties dialog boxes are displayed. Here, select
the general options associated with the emulator. Note that the target MCU to be debugged, etc. can only be set once each time
the emulator is booted-up.

5.1.1 Emulator Settings During Booting up
While the emulator is booting up, the following three dialog boxes are opened in sequence.

(1) Device setting dialog box

Use this dialog box to select the target MCU and establish communication.

This dialog box can be re-opened by selecting Emulator -> Device setting from the Setup menu after the emulator has been
booted up. In this case, however, be aware that changes of setting made after boot-up will not be reflected immediately but will
be set as initial values when the emulator is reconnected.

(2) Configuration properties dialog box

This dialog box is opened after the Device setting dialog box. Use this dialog box to make settings related to the emulator and
debugger functions.

This dialog box can be re-opened by selecting Emulator -> System from the Setup menu after the emulator has been booted up.
Settings for certain options in this dialog box can be changed after boot-up. Those that can be changed are active while those
that cannot are inactive (grayed out), but with their settings displayed.

(3) Connecting dialog box

This dialog box shows the progress of boot-up processing.
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5.1.2 Setting Up the Target MCU
(1) Selecting the target MCU

On the Device page of the Device setting dialog box, specify the target MCU to be emulated. For details, refer to the hardware
manual supplied with each product.

Device setting ] x|

Device I|
Group
Device  |RSFGIT25 -]
Mode EE[Shg,ls-chip mode] 3 I~ Auibomstic

Dratection

Commurication Seting

LISH - -
Ea |E100: DEVELOPMENT x| Refresh |

[~ Start booting up on successiul completion of geli-checking.

ok | I:amell Help

[ Do hat show this dislog box again.

Figure 5.1 Device setting dialog box (Device page)

The target MCU you have set here cannot be changed after the emulator is connected. To change the target MCU, you need to
disconnect and then reconnect the emulator.

(2) Selecting an operation mode

Select an operating mode.
For details, refer to the hardware manual for the MCU in use.

(3) Automatic detection of operating mode

Select the checkbox if you want automatic detection of the operating mode after connection of the emulator has been

established. When any of the following states is detected, the emulator shows an error message and releases the connection.

- The user system is not connected.

- The user system is not supplied with power.

- The setting of the MD2 to MDO pins of the user system corresponds to an operating mode that is not supported by the
emulator.

Even if the [Automatic Detection] checkbox is not selected and the user system is being supplied with power, the emulator
checks the states of the MD2 to MDO pins against the operating mode selection made by the user. When they do not match or
the operating mode indicated by the MD2 to MDO pins is not available, the emulator shows a message and makes the
connection for the operating mode selected by the user.
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(4) Setting up communications

You can select another target emulator for connection via USB.
The ‘USB Serial No.” list box shows unique identifying information on the E100 emulator connected via USB. Clicking on the
Refresh button updates the information.

(5) Performing self-checking

If you click on the OK button with the ‘Start booting up on successful completion of self-checking.” checkbox selected,
hardware self-checking proceeds after connection to the emulator according to the communications condition you have set.
The results are shown on completion of self-checking. If the results are normal, boot-up processing continues. If an error is
found, boot-up processing stops.
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5.1.3 Setting Up the System

On the System page of the Configuration Properties dialog box, specify the configuration of the emulator system as a whole.

During the boot-up process, this dialog box appears after the Device setting dialog box.

Although it is possible to open this dialog box even after the emulator has been booted up, some items (e.g. target MCU and
clock selection) will be grayed-out since they cannot be changed.

Configuration properties

System I Mermany map ] Intemal fash memom ovenswite | Exception ' arning |

x|

~Clock

Main (= Emulstor i Lsar " Generate | 10 pHz

S {7 Emulatar =) Wainciack divdded By 256

- Trigges
Esternal rigger & BT 03 NRUT O %Pgl% 'Efﬁ;m
’ . EXT 015 ITL
Input tiages level & EXTO-31 CMOS  © coraeon BMOS
~ Coverage
@ [0 coverags " C0sC1 coverage
~ Switching funchon

* Codecoyerage O [hata coverage " Beaktime pofile

— [ arg=tvallage

& 500

=20

_DEt'.Ig furiction

[T Ensble mtemupts during step exacution,

™ Mask the Nl pin,
[T | hask the BRE@AMAIT B

I Uze the EXPE B of SECEH (0MFRDEL] 2511
[ Diebug the program with ovenwiting of flash ROM,

= Dizplay a meszage when the emulator
weas to manipudale registers in the FCLL

IR input signal [FFFF

0K | Cameel |  Hep |

[ Danat show this dislog box again.

Figure 5.2 Configuration properties dialog box (System page)

R20UT3587EJ0302 Rev.3.02
Sep.01. 21

RENESAS

Page 85 of 232



ROE417250MCUO00 User’s Manual 5. Debugging Functions

(1) Selecting the input clock

In the Clock section on the System page, select the sources of the clock signals supplied for the main clock and subclock.

The main clock can be selected from among three choices: Emulator, User and Generate (by default, Emulator is selected).
Select Emulator when the main clock is supplied from an internal source and User when the main clock is supplied from an
external source. To use a user-defined clock, select Generate and enter the clock frequency in the text box.

The clock frequency can be set in the range from 1.0 to 99.9 MHz in 0.1-MHz units. The clock frequency for Generate can be
set only once each time the emulator is booted-up.

Subclock options are only selectable for MCUs that support a subclock function. ‘Emulator’ or ‘Main clock divided by 256’
can be selected (by default, Emulator is selected).

CAUTION
The frequency accuracy for Generate is £5%. Please make sure that final evaluation is performed with a resonator or oscillator
module mounted to generate the actual frequency for use on the target board.

(2) Selecting the direction of the external trigger cable

For the external trigger cable, select the direction of EXT pins 1631 as input or output. EXT pins 0-15 are fixed as inputs.
Select either of the following options:

- EXT 0-31 INPUT (initial value)
- EXT 0-15 INPUT, EXT 16-31 OUTPUT

(3) Selecting a trigger input level

Select CMOS level or TTL level as the trigger input level. Select either of the following options:

- EXT 0-31 CMOS (initial value)
- EXT 0-15 TTL, EXT 16-31 CMOS

(4) Selecting a code-coverage mode

Select a code-coverage mode.

CO0: Instruction coverage rate

CO0 + C1: Instruction coverage rate and branch coverage rate

Up to 2 Mbytes of coverage information can be measured in CO-level coverage, while up to 1 Mbyte of coverage information
can be measured in C1-level coverage. CO coverage is selected by default.

This option can only be set in booting-up of the emulator and is only available when Code coverage has been selected in the
Switching function section. If you wish to use the code coverage function after the emulator has started up, use this option to
select a mode in advance.

(5) Selecting a switching function

The code coverage, data coverage and realtime profile functions cannot be used at the same time. Select one from among these
functions.

Code coverage is selected by default.

The setting of this option can be changed even after the emulator has been booted up.

When the code coverage function is selected, measurements are performed at the coverage level selected under Coverage.
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(6) Selecting the power voltage of the target system

Select the voltage level of the user system. This option can only be set in booting-up of the emulator and is only available
when the MCU in use supports both 5.0 and 3.3 V. If the MCU only supports either 5.0 or 3.3 V, the emulator automatically
selects the given voltage level.

(7) Enabling interrupts during stepped execution

Select whether interrupts should be enabled or disabled from the start of stepping until an instruction is executed. Interrupts are
always accepted while a subroutine is being invoked by step-over or step-out execution.

(8) Masking the NMI pin

Select whether you want masking of input signals to the NMI pin of the target system.

(9) Masking the BREQ/WAIT pin

Select whether you want the input signal to the BREQ/WAIT pin of the target system to be masked.

(10) Usage with the EXPE bit of SYSCR (OxFFFDC2) as 1

Select this checkbox if you wish to enable access to external space while the MCU is in single-chip mode.
This option is only available for MCUs that have an EXPE bit in SYSCR. When the MCU is not in single-chip mode, this
option is ignored.

(11) Debugging with overwriting of flash memory

Select this checkbox if you wish to allow rewriting of the contents of the internal ROM or EEPROM during debugging.

CAUTION
For details on debugging with overwriting of flash memory, see “Debugging with Overwriting of Flash Memory” in section
7.5 Notes on Using the MCU Unit (page 224).

(12) Display a message when the emulator is to manipulate registers in the FCU

Select the checkbox if you wish to view a message when the emulator manipulates registers in the FCU.

(13) Enable or disable IRQ input signals

Specify the hexadecimal number for the pattern of bits that corresponds to the user IRQ signals (IRQn) that you wish to
monitor.

0: Disables monitoring of IRQn

1: Enables monitoring of IRQn

n=15t00.

The default value is FFFF.
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5.1.4  Setting up the Memory Map

The Memory map page of the Configuration properties dialog box allows the user to assign emulation memory to the internal
ROM or external space.

You can allocate two areas in the internal ROM (in 128-Khbyte units) and four areas in external space (in 1-Mbyte units).

Configuration properties I ﬁl

Sysiem  Memom map | Intemal flash memony ovenwite I E:-:ceptinn‘-.l-’atringl

—Azzighn emulation meman o intemal Razh RO

bode
Do pot allocate emulation memony

% 1ze emulstion memeor

Automatically allocate |[EMERMs whean writing to
& zoftwane break oceurs

[ IEMEMD [0
b ainke the contents of the flash ROM to IEMEMO.

¥ IEMEM1 2 0000 FFFF
¥ ‘winke the contents of the flash ROM to IEMEM1.

Q000 FFFF

T
-

T
7

Azzign emulstion memany o exdemal space

[~ EMEMD |— 0ooan - |— FFFFF
redeM [ oom. [ FRRRE
CemeMz [ oo [ FRREE
Cemems [ oooo- [ Feeee

ok | Caneal | Hep |

[~ Danat shaw this dislog box again,

Figure 5.3 Configuration properties dialog box (Memory map page)

(1) Assign emulation memory to internal flash ROM

Up to two blocks can be allocated as emulation memory. Select the checkboxes for the areas you wish to use and specify the
addresses where the blocks start and end. Note, however, that the 16 lower-order bits of the addresses are fixed because the
blocks are only specifiable in 128-Kbyte units.

By default, up to two areas of emulation memory will be allocated from the first address of the internal ROM.

When emulation memory is released from allocation as internal ROM, the current data in the emulation memory will be
written to the internal ROM.
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(2) Selecting a mode

Select one of the following modes for assigning emulation memory to the internal ROM.
- Do not allocate emulation memory

- Use emulation memory

- Automatically allocate IEMEMXx when writing to a software break occurs.

[Do not allocate emulation memory]:
The emulator will not use emulation memory allocated as internal ROM.

[Use emulation memory]:
The emulator will use emulation memory allocated as internal ROM.

[Automatically allocate IEMEMXx when writing to a software break occurs]:

Emulation memory will automatically be allocated as internal ROM when an attempt is made to set a software break at a
location in the internal ROM area. If you have manually assigned IEMEMO and IEMEML1 as emulation memory to internal
flash ROM, however, automatic assignment of emulation memory will not be performed.

Even when emulation memory has been allocated automatically, the allocated memory is treated as if it had been manually
allocated: deleting a software breakpoint does not release the corresponding memory.

(3) Write the contents of the flash ROM areas to IEMEMx

Selecting a checkbox makes the assignment of emulation memory to internal ROM areas include writing the contents of the
internal flash-ROM area to the corresponding emulation memory block. If a program is downloaded to internal ROM, the
program will also be downloaded into the emulation memory block.

(4) Assign emulation memory to external space

Up to four blocks of emulation memory can be allocated to external space. Select the checkboxes for the areas you wish to use
and specify the addresses where they start and end. Note that the 20 lower-order bits of the addresses are fixed because the
blocks are only specifiable in 1-Mbyte units. Assignment of emulation memory to an external space is only possible at the time
the emulator is booted-up.
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5.1.5 Setting for Overwriting Blocks of the Flash ROM
The Internal flash memory overwrite page of the Configuration properties dialog box allows you to specify whether or not
individual blocks of flash ROM should be overwritten.

Corfiguration properkies EI

System | Memory map  Intemal flash memory ovenite | Exception Waning |

Mo | Address

O m 000000 - DOOFFF
CJoz  omooo-ootFee
OO0z 002000 - OOZFFF
J o4 002000 - OD2FFF
Oos 004000 - O04FFF
OJos 005000 - ODSFFF
O o7 005000 - O0GFFF
[Joe 007000 - OOFFFF
O o9  00=000 - DOFFFF
10 10000 - O1FFFF
On 00000 - O2FFFF
[l12 020000 O3FFFF setal

Clear al

Selected blocks wall be overvailten rather than deleted when lhe e
peagram is downloaded.
Uneelected blocks will b= oveswitien after deleted.

0k | Camcdl | Hep

™ Do not show this dislog box again,

Figure 5.4 Configuration properties dialog box (Internal flash memory overwrite page)

Settings for all blocks are automatically shown in the list according to the information on the target MCU. When a checkbox is
selected, the block will be overwritten rather than deleted when the user program is downloaded.
This is the same even when emulation memory has been allocated as internal ROM.
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5.1.6  Settings to Request Notification of Exceptional Events
The Exception Warning page of the Configuration properties dialog box allows you to select whether or not to display
warnings in the Status window and as a balloon on the status bar when exceptional events occur.

Configuraktion properties B x|

....................... b

System ] Mernomny map ] Irterrial Rash memon ovenwite EHCEE@WEW,

[ Wiolstion of access pratection
[+ Read hom yrertizlized memorny
[ Stack access violation

[T Petformance overlow
I™ HBeslime profleicveflon

[~ Trace memany overlow

F Tizsk stack apcasswialaton

& 05 dhenstel

Checked tems wall dizplay waming in & dialog balloon,

oK | Caneel | Help |

[ Danat show this dislog box again.

Figure 5.5 Configuration properties dialog box (Exception Warning page)

The ‘Violation of access protection’ , ‘Read from uninitialized memory’ and ‘Stack access violation’ checkboxes are initially
selected.

When a load module that includes an OS has been downloaded, the ‘Task stack access violation’ checkbox is also initially
selected.

Other items are non-selected by default.

If you deselect a checkbox, the corresponding item will appear as ‘-’ in the Status window.
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5.1.7 Viewing the Progress of Boot-Up Processing

You can check the progress of boot-up processing in the Connecting dialog box.

This dialog box appears when boot-up processing is started and remains open until it is completed.

As long as display of the Device setting and the Configuration properties dialog boxes continues, you cannot manipulate this
dialog box.

Conneching, .,
Group Name = HESX/17 a] [~ Slatus
EY Distect Hev, = HEV.A
External Tringer Cable Infe. USER SYSTEM DISCOMMECT
Pnl:ahlg E?_nnectian Status = MOT | [Discornect CNMO. CNNT]
118
MODE Fin Check = 0K POWER SOURCE  DISCONNECT
112 Buz Accezs Check  =0K (0.5
Mon CPU-SSRAM Check,  =0F
Mon CPU-USB Check = DK RESETH High
Seling of the MCU suppl clock. .
I aClock Emulator T b High

Setting of information specific to the

Setling of debug opbians. STBi#

Setting of data in registers for use by MOz

Setting of data in the maonitor CPU 5 s

Seltitg of data in the target MCU 2p WD High
WVallage check of the wser Langet bo .
Setiing of the UD| clack, (o] High
Selttitg of debugging information, |

Seling of the clock requency gene ~ Clock

Set Prasessor mode.
Set Emuration memon's allocaban, Systern Clock 160 kHz
Set Intesnal Emuation memon's alo .

Itialization of the emuators intema—{ | Main Clock[EXTAL) - B.0MHz

1| 13 S e -.ij‘:-':‘l:‘

Irstizlization of the emulator's intemal setfing,
[ Close the dialag box when the connection iz complated.

Cancel

Figure 5.6 Connecting dialog box

(1) Description of progress

The progress history box on the left-hand side of the dialog box shows the history of progress.
The information shown here is saved in a bug report. To check the contents of the bug report, select Technical Support ->
Create Bug Report from the Help menu.

(2) Display of pin states

The pin states are updated when you close the Configuration properties dialog box.
A warning will be shown in the progress history box if the pin states do not match the settings made in the Device setting

dialog box.

(3) Display of states of clock signals

This information will be updated on completion of processing for the clock settings.
Only information on the clock signals that are actually operating is shown here.
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(4) State of progress as progress bars

The upper progress bar shows the state of progress through the overall process of booting up.
The lower progress bar shows the state of progress through the current part of the process of booting up.
The name of the current part of the overall process is shown under the progress bar.

(5) Canceling the connection

Click on the Cancel button to cancel the process of booting up.
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5.2 Downloading a Program

5.2.1 Downloading a Program

Download the load module to be debugged.

To download a program, choose Download from the Debug menu and select a desired load module or right-click on a load
module under Download modules of the Workspace window and then choose Download from the popup menu.

CAUTION
Before a program can be downloaded, you must have it registered as a load module in the High-performance Embedded
Workshop. For details on how to register load modules, refer to “4.8 Making Debugging-Related Settings” (page 78).

5.2.2  Viewing the Source Code
Select either of the following ways to view the source code.

- Double-click on the name of the source file in the Workspace window.
- Right-click on the name of the source file and choose Open from the popup menu.

eTutorialepp {0l x|
= &E
Line Source... | E.| C.| 5. Source |

29 |00104cC woid tutorial (void) j

an i

31 long a[10]

3z long j:

33 int 1i:

34 class Sample *p sam;

35

36 |001054 & p_sam= Sample;

37 |00105C |  for( i=0; i<10; i++ )4

38 001064 ] = rand() :

39 |0D106C |HY if(3 < 0) 4

40 001070 3] =R

41 }

47 |00107z2 ali]l] = 3j:

43 }

44 |001085 b _sam->sort(a) ;

45 |001020 b_sam->change (a) ;

44 =
4 | v 4

Figure 5.7 Editor window
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The columns listed below are to the left of the Source column.

(1) Line column

This column shows the line numbers of lines in the source file.

(2) Source Address column

When a program is downloaded, this column shows the addresses that correspond to the lines of the current source file. This
function is convenient for determining values for the PC and where to set breakpoints.

(3) Event column

This column shows the following:

Table 5.2 Icons in the Event column

H! | Hardware breakpoint
- | Trace point (fetch condition)

A hardware breakpoint can be set by double-clicking in the Event column.

A trace point is only displayed when a fetch condition has been set.

[*] after the title on the title bar of the Hardware break, Trace conditions and Performance Analysis Conditions dialog boxes
shows that a setting is being edited. You cannot change the settings from the Event column of the Editor window while editing
is in progress.

(4) Code Coverage column

This column graphically shows the CO code coverage information.

(5) S/W Breakpoints column

This column shows the following:

Table 5.3 Icons in the S/W Breakpoints column

= | Bookmark
@ | Software break

= | PC position
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5.2.3  Turning columns in all source files off

(1) From the Editor window

1. Right-click in the Editor window and choose Define Column Format from the popup menu.

2. The Global Editor Column States dialog box will be displayed.

Global Editor Column States

2l x

CodeCoverage - A5
Dizazzembly Address
Event

Label

Line

Obj code

Code Coverage -

[w] S Ereakpn?nts =
A | 3

Cancel |

Figure 5.8 Global Editor Column States dialog box

3. Deselect the checkboxes of columns you want to turn off. Click the OK button, and the new settings you have made will

take effect.

5.2.4  Turning columns off for one source file

(1) From the Editor window

1. Right-click in the Editor window and choose Columns from the popup menu.

2. A cascaded menu will be displayed. A check mark is to the left of the names of currently enabled columns.

Zolumns

v Code Coverage

Turn Header OnjQFF

v CodeCoverage - A3M

v Disassembly Address

Irstant Watch

~ Ewvent

GO To Eursar
Seb PE Here
Display PC

v Label

v Line
+ 0bj code

Wiew Disassemtly

IT S/ Breakpoints
« S Breakpoints - 43M

Propetties...

v Source Address

Figure 5.9 Popup menu window

3. Clicking on a column name toggles the setting between enabling and disabling of the column.
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5.2.5 Viewing Assembly Language Code

While a source file is open, click the right mouse button in the Editor window and choose View Disassembly from the popup
menu. The Disassembly window will be displayed.

The first address shown in the Disassembly window corresponds to the cursor position in the Editor window.

You can also use the View Disassembly button in the Editor window to view code produced by disassembly.

If there is no source file, you can still view the disassembly by one of the following methods.

— Click on the Disassembly toolbar button [l

— Choose Disassembly from the View menu.
— Use the “Ctrl + D” shortcut keys.

In this case, the Disassembly window opens with a listing from the position currently indicated by the PC.

The emulator also supports a mixed mode as an optional way to show all source lines from the address where disassembly
started. To view disassembly code in mixed mode, click the View mixed mode button.

R
||
Ewvent | CodeCoverage... | 5/ Breakpointz - ... | Dizassembly... | Obj code Label Dizazzembly |
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001054k OFs4 MOV, L ERO,ER4
oo01058c 1933 SUE.W R3,R3
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Figure 5.10 Disassembly window

The columns listed below are to the left of the Disassembly column.

(1) Event column

This column shows the following:

Table 5.4 Icons in the Event column

H Hardware breakpoint
] Trace point (fetch condition)

A hardware breakpoint can be set by double-clicking in the Event column.
A trace point is only displayed when a fetch condition has been set.
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(2) Code Coverage - ASM column

This column graphically shows the CO code coverage information.

(3) S/W Breakpoints - ASM column

This column shows the following:

Table 5.5 Icons in the S/W Breakpoints — ASM column
@ | Software break
= PC position

(4) Disassembly Address column

This column shows the address of the machine code corresponding to the disassembly. Double-clicking in this column brings
up the Set Address dialog box. Enter the address where you want the display of disassembly code to start in this dialog box.

(5) Obj code column

This column shows the object code.

(6) Label

This column shows labels. This column is not usable if no module has been downloaded.

5.2.6  Correcting Assembly Language Code
Double-click on the instruction you want to correct in the Disassembly window or choose Edit from the popup menu. The
Assembler dialog box will open. Use this dialog box to correct the assembly-language code.

Assembler

Addresz Code
000412 Fasy

. Cancel
nemanic:

x

OB H#H'S7.RO

Figure 5.11 Assembler dialog box

The dialog box shows the address, instruction code and mnemonic of the selected instruction.

Enter a new instruction (or edit the old instruction) in the Mnemonic edit box. When you have finished, hit the Enter key. The
value in memory is overwritten by the new instruction code, and the pointer is moved to the next instruction.

Click on the OK button to overwrite the current value in memory with the new instruction code and close the dialog box.

CAUTION

The assembly-language code shown in the Disassembly window and the Assembler dialog box is based on the data currently in
memory. When you modify data in memory, the new assembly-language code is shown in the Disassembly window and the
Assembler dialog box. However, the source file being displayed in the Editor window remains unchanged, even if it includes
assembly-language code.
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5.3 Viewing Memory Data in Real Time

5.3.1 Viewing Memory Data in Real Time

Use the RAM Monitor window to monitor data in memory while the user program is running.

The RAM monitoring function permits recording and inspection of the data in an area of memory for which monitoring has
been assigned and the states of access in real time without obstructing execution of the user program.

The RAM Monitor window shows the access states (read, written, non-initialized or not inspected) in different colors.

(1) Allocating an area for RAM monitoring

A 16-Kbyte RAM monitoring area is provided.

This RAM monitoring area can be allocated to a desired contiguous address range or up to 32 blocks of 512 bytes.

By default, a maximum of 16 Kbytes of space from the first address of the internal RAM is allocated as the RAM monitoring
area.

(2) Monitor display

Access states are indicated by different background colors according to the access attribute as listed below (the background
colors are customizable).

The access attributes “read” and “written” indicate the last access to each memory location.

To view detected errors, choose Error Detection Display from the popup menu. In this case, the information on reading and
writing is not displayed.

Table 5.6 Access attribute and background color

Access attribute Background color

Read Green
Written Red
Error Non-initialized memory (the location has Yellow
detected been read but nothing has been written to it

yet)

Non-inspected memory (a value has been Sky blue

written to the location but it has not been

read)
No access White

CAUTION

The contents of the RAM Monitor window are acquired from bus access. Therefore, changes made to memory by access that
was not through the user program (e.g. writing to memory directly from external 1/0) are not reflected in the RAM Monitor
window.
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(3) Detecting reading from non-initialized areas

If a memory location is read but nothing has been written to that location, the emulator detects “a non-initialized area” and
indicates the error.

To view errors of this type, choose Error Detection Display from the popup menu.

Non-initialized memory locations are shown against a yellow background.

Errors of this type can be detected as exceptional events and used as conditions of hardware breakpoints and trace points (also
refer to *5.14 Detecting Exceptional Events” (page 189)).

(4) Detecting non-inspected areas

If a memory location has been initialized but has not been read, the emulator detects this as “a non-inspected area” and
indicates the error.

To view errors of this type, choose Error Detection Display from the popup menu.

Non-inspected memory locations are shown against a sky blue background.

5.3.2 Setting the Update Interval for RAM Monitoring
Choose Update Interval Setting from the popup menu of the RAM Monitor window. The Update Interval Setting dialog box
shown below will appear.

Ipdate Inkerval Setking ed |

Interval (10 - 10000mzec : 10ms unit):

100 msec

ak. I Canzel

Figure 5.12 Update Interval Setting dialog box

A separate Update Interval can be specified per RAM Monitor window.
The initial value is 100 ms.

5.3.3 Clearing RAM Monitoring Access History
Choose Access Data Clear from the popup menu of the RAM Monitor window. The history of all access to the RAM
monitoring area will be cleared.

CAUTION
If clearing proceeds while the user program is being executed, the realtime characteristic of execution may be lost because
clearing produces a memory dump.

5.3.4 Clearing RAM Monitoring Error Detection Data
Choose Error Detection Data Clear from the popup menu of the RAM Monitor window. All information on the detected errors
in the RAM monitor area will be cleared.
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5.4 Viewing the Current Status

5.4.1 Viewing the Emulator Status
To find out the current status of the emulator, open the Status window.

To open the Status window, choose CPU -> Status from the View menu, or click on the View Status toolbar button || o ].

The information shown in this window is not updated while the program is running.

Status =
Item |Status |
[MCT status Ready
PC:FOOOO
TaskID: -

Wiolation of access protection -
Fead from uninitialized memory -
Stack access wviolation -
FPerformance owverflow -
Fealtime profile owerflow -
Trace mwemory overflow -
Tazk stack access wiolation -
03 dispatch -
Fun time count Qd:00:00.000.000.000
Cause of last bresk -

L I FI'-. ety }1. Platfarm }1. Events hTarget {r

Figure 5.13 Status window

The Status window has the following four sheets.

Table 5.7 Sheets of the Status window

Sheet Description
Memory Shows information on memory resources.
Platform Shows information on the emulator and debugging.
Events Shows information on events.
Target Shows information on the target MCU.
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5.4.2 Viewing the Emulator Status in the Status Bar
The status of the emulator can be displayed in the status bar.
Right clicking on the status bar brings up a list of the available items. Check the items you want to view in the status bar.

[+ Debugger
~ Application

o
¥ TaskD

' BreakCondition
[~ ExecutionTime

, v Exception "
Hormal - |Saftware break oo, 001, 306,220 |6

Figure 5.14 Status bar

Table 5.8 Items regarding emulator status shown in the status bar
Item Description
PC PC value

During execution: PC value
During a break: Normal

Task ID Task ID, task entry label

BreakCondition Source of a break in the user program
ExecutionTime Result of time measurement

Exception Whether or not an exceptional event has occurred

(1) When more than one break source is present
When you click on the status bar indicating the source of a break (“Some factors exist” when there is more than one), a
balloon appears.
Read the contents of the balloon to check the source of the break.

Y %]
Break cause

- Saltveare bresk
- Hardware beeak [OR) EV=1

Hlormal F [50me Factors exist 5 Cick here 00:00:00, 001,396,200 | 4

Figure 5.15 Checking the source of a break

(2) When an exceptional event has occurred

When an exceptional event has occurred, a warning is displayed in a status bar balloon.
However, exceptional events of types that are not selected on the Exception Warning page of the Configuration Properties
dialog box are not shown.

v 3

Waming: Exception event deteciion

= Access protection

[deess0071C AtbiibutewRITE)

- Trace memory overflow
i

Figure 5.16 Example of warning display when exceptional events have occurred
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5.5 Periodically Reading Out and Showing the Emulator Status

5.5.1 Periodically Reading Out and Showing the Emulator Information

To find out about changes in emulator information whether the user program is running or idle, use the Extended Monitor
window.

The extended monitor function only monitors the signals output from the user system or MCU, so it does not affect execution
of the user program.

To open the Extended Monitor window, choose CPU -> Extended Monitor from the View menu, or click on the Extended

The displayed items are updated at an interval of about 1,000 ms during user program execution or about 5,000 ms during a
break.

Monitor toolbar button |

CAUTION
“Main Clock (System Clock)” can only be measured while the user program is running.

Extended Monitor |
5}

Ttem I Value

User System Connection DISCONNECT [(Disconnect: CNNO, CHNL)
User Zystem Power ZSource DISCONNECT (0.6 w)

User 3Jystem REIETH High

User System HMI High

MD1 High

MD0 High

Main Clock (System Clock) -

Main Clock (EXTAL) Emulator &.0 MH=z

5] | L

Figure 5.17 Extended Monitor window
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5.5.2 Selecting the Items to Be Displayed
Choose Properties from the popup menu of the Extended Monitor window. The Extended Monitor Configuration dialog box

will be displayed.

Extended Manitor Configuraticn 7| x|
— Update millzecond
Ok
Bunning: 1000 Ereak: I RO00
Cancel

Settings:

[kem | W alue

Idzer Syzten Connection DISCOMMECT [Dizconnect: CMMO, CHHT]

Idzer Syztemn Power Sournce DISCOMMELT [0.6

[¥] User System RESET#H High

[dzer Spstern M| High

k4011 High

kD0 High

M ain ClocklS ystem Clock)

bain Clock[ExTAL) Ermulator 8.0 MHz

ol | i

Figure 5.18 Extended Monitor Configuration dialog box

This dialog box allows you to select items to be shown in the Extended Monitor window.
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5.6 Using Software Breakpoints

5.6.1 Using Software Breakpoints

In a software break, the instruction code at a specified address is replaced with a BRK instruction, which causes the user
program to stop running by generating a BRK interrupt. In that sense, this is a pre-execution break function.

Up to 4096 breakpoints can be set.

If multiple software breakpoints are set, program execution breaks when it arrives at any of the breakpoints reached.

(1) When stopped at a software breakpoint

When the program you have created is run and arrives at an address you have set as a software breakpoint, the program stops
and the message “Software Break” is displayed on the Debug sheet of the Output window. At this time, the Editor or

Disassembly window is updated, and the position where the program has stopped is marked with an arrow ['::"] in the S/IW

Breakpoints column.

CAUTION

When a break occurs, the program stops immediately before executing the line or instruction at which the software breakpoint
is set. If Go or Step is selected after the program has stopped at the breakpoint, the program restarts from the line marked with
an arrow.

5.6.2 Adding and Removing Software Breakpoints
Select either of the following ways to add or remove software breakpoints.

- From the Editor or Disassembly window
- From the Breakpoints dialog box (only for removal)
- From the command line
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(1) From the Editor or Disassembly window

1. Check that the Editor or Disassembly window that is currently open shows the position at which you want to set a software
breakpoint.

2. In the S/W Breakpoints column, double-click on the line where you want the program to stop.

=0l x|
Elll=

Line Source... | E.| C.| 5. Scurce |
55 :I
e
s6 002130, [ woid Sample::change({long *a)
57 i
S5 Long tmp[10] :
59 int 1i:
&0 |‘/
61 |00Z213C = for{i=0; i<10; i++)(

62 OO0Z144 E@[i] = al[i]l:
&3

64 002168 for [1=0; 1€10: 14++)4

&5 O0Z170 ali] = twpl[9® - i):

56 i

567 |00Z 198 i

66 -
4| | K| 2

Figure 5.19 Editor window

Alternatively, you can select Toggle Breakpoint from the popup menu or press the F9 key.

3. When a software breakpoint is set, a red circle [®] is displayed at the corresponding position in the S/W Breakpoints
column of the Editor or Disassembly window.

ET TR
Elll=
Ling Source.. | E.] C) 5. Sowce |
=5 Zl
L6 (002130 - void Serople: icheange (long *a)
57 {
58 long tmp[10]:
59 int 1;
&0
61 |00213C L for (i=0; i<10: i++) |
62 |00E144 tmp[i] = ali];
63 i
64 |D0Z165 Tor (1=0; 1<10:; i++){
&5 |D0Z170 a[i] = cwp[9 - i]:
(=14 }
57 |00E198 H
1]
| |

Figure 5.20 Editor window

Double-clicking one more time removes the breakpoint.
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5.6.3

Enabling and Disabling Software Breakpoints
Select one of the following ways to enable or disable software breakpoints.

- From the Editor or Disassembly window
- From the Breakpoints dialog box

- From the command line

(1) From the Editor or Disassembly window

1. Place the cursor at the line where a software breakpoint exists and then select Enable/Disable Breakpoint from the popup
menu. Alternatively, press the Ctrl and F9 keys at the same time.

T

2 &ld

=10 x|

Line Scurce... | E| C] 5. Souce
=5 ZI
L6 (002130 - rolid Serple: icheange (long *a)
57 {
=13 long tmp[10] :
5Q int 1:
&0
61 |00213C for {i=0; i<10; i++)(
62 |0DE 144 tmpli] = ali];
&3 i
&4 |00Z163 for (1=0; 1<10:
&5 |00Z170 ali] = tmg b s
&5 1 Templates
&7 |0DZ158 H
[=15]
| |

Enable/Cisable Breakpoint

Ckr|+F3

Figure 5.21 Editor window and popup menu

2. The software breakpoint is alternately enabled or disabled.

=10 x|

Elzl=
Ling Source..,

E.

.| Souce

z5
=17
L
58
59
&0
&l
62
&3
G4
55
117
67
(=15

4

00z 130

OOZL13C
002144

o0z 168
o0z 170

00z 158

[

wold Sexnple: :change |long %a)

Llong tmp[10] :
int i;

Tor [1=0: 1<10; i++){
twp(i] = af1]:

}

for(i=0; i<10; i++){
m[i) = cmp[9 - il:

1

Figure 5.22 Editor window
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(2) From the Breakpoints dialog box

1. Select Source Breakpoints from the Edit menu to bring up the Breakpoints dialog box. In this dialog box, you can alternately
enable, disable, or remove a currently set breakpoint.

X

Breakpoints 0 Jed I

cpolh Line 16 ok

Cancel

Edit Code

Femoye &8

LOREE

Figure 5.23 Breakpoints dialog box
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5.7 Using Events

5.7.1 Using Events

An event refers to a combination of phenomena that occur during program execution.

The E100 emulator permits you to use an event you have set as a condition for the break, trace or performance-analysis
function.

Events can be set at up to 16 points at the same time.

These 16 points can be placed as desired.

Events you create can be registered for reuse at a later time.

(1) Types of events

Events are of the following types.

Table 5.9 Event types

Instruction fetch The emulator detects that the CPU has executed the instruction at the specified address.
Detection is in the cycle of execution by the CPU rather than the cycle of prefetching by
the instruction queue.

Data access The emulator detects access under a specified condition to a specified address or
specified address range.

Interrupt The emulator detects interrupt generation or return from an interrupt handler.

Trigger input The emulator detects a signal fed in from the input cable for external trigger signals being

in a specified state.

(2) Event combinations

The following types of combination can be specified for two or more events.

Table 5.10 Types of event combination

OR The condition is met when any one of the specified events occurs.

AND (cumulative) The condition is met when all of the specified events occur regardless of the timing.
AND (simultaneous) The condition is met when all of the specified events occur at the same time.
Subroutine The condition is met when a specified event occurs within a specified address range.
Sequential The condition is met when the specified events occur in a specified order.

State transitions ;jrir;zrc;)rgdition is met when the events occur in an order specified in the state transition

5.7.2 Adding Events
Select one of the following ways to add events.

- Create a new event
- Add by dragging and dropping from another window
- Add from the command line
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(1) Creating a new event

[Creating an event in the Hardware Break, Trace conditions, or Performance Analysis Conditions dialog box]

1. Click on the Add button or double-click on the line where the new event is to be added.

Hardwate Break ORI

~Ewent:

Event | T.I Descriptions | Co... | Ta... | Comment |

Add... Delete | Enablz | Disable |

Figure 5.24 Hardware Break dialog box

2. The Event dialog box shown below will be displayed. In this dialog box, set the details of the event condition and then click
on the OK button.

| T )
[[Cendtion || courk snd Task 0 | Comment | Corebtion [Counk and Task 10 | Comevert |
Event typs: [In-sm.-:limfb:n:h ﬂ 1 Countf1-z55) -
- Condition Settings l—
Address condbon |Spetf-odm-:-: ;|
[ Tk
Stact; | OO0+ End; | o000 S
: | -I ﬂ I -I E : I rmbsers St .,
[ Spaily & furetion e | S F—
Pl nams; | | (B '
wele [ ok | caed oo [ o ] e |

Figure 5.25 Event dialog box

3. An event will be added at the specified position.

Hardware Ereak OR |

Event:

Event T.I Descriptions Count | TaskID | Comment

F [Address] _main

Figure 5.26 Hardware Break dialog box

4. If you create an event that would make the total number of events exceed 16, an error message is displayed. In this case, the
event you have added is invalid.
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[Adding an event from the Registered Events dialog box]

1. Click on the Add button in the Registered Events dialog box.

<o
Events
Type | Descriotions | court | Taskip | comment
1 | =
Dupicate || add... ] [relete | [Delete .f-.II|
Save... | Load... | Help Close
i

Figure 5.27 Registered Events dialog box

2. The Event dialog box shown below will be displayed. Set details of the event condition in this dialog box. Enter a comment
if any is necessary. Then click on the OK button.

event Eillevent |
Condiian | Count and Task 30 | Comment | Condthn | Count and Task D Cement |
Event bype [Irstaction fatch = Comment: | main Function
r—Condition settngs
Ackdress condbian |Specied value (=) =l
F' A d | this et o e et
o I | [ e | = |
[T Speciy a funckion neme
Fhm:l d |-’I"‘.‘<"-"‘:...I
Function name: | E
pp [ e ] cown pep [ e ] coma

Figure 5.28 Event dialog box
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3. The event is added to the list of registered events.

ioix
Events
Type | Descriptions | court | Taskip | comment
F  [Address] _main - - mzin Function
1] | =
_,lup.:al.'-':[ Add... I [helete | DEIEJ:EAII|
Save... ] Losd... | Help l close |
E

Figure 5.29 Registered Events dialog box

(2) Adding an event from the Event column of the Editor window
[Adding a hardware breakpoint]

1. Select HW Break Point from the popup menu opened by double-clicking or right clicking in the Event column of the Editor
window.
This sets fetching from the corresponding address as the condition for a hardware breakpoint, i.e an instruction fetch
condition.

Eel@

Line Sour.. | B C.| 5. Sowce
14 wold main(wold)
15 |FEZDC {
16 F82DC E/ vhile (1) 4
17 |FEZED cutarial (]2

18 |FE2E3 ‘W Break Point

19 FE2ES Trace Fort

20

21 mold tutorial (void)

22 |FBZEG {

23 long a[10]

Z4 lorwg 3:

25 int iz

28 atruct Sample far Tp sSam;

e

| |

Lt zorkc v Tutoriale I

Figure 5.30 Editor window
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2. If the number of events currently set allows room for another, the event you have added from the Editor window is added as
an OR condition. If there is no room, an error message is displayed.

CAUTION

If you are editing the contents of the Hardware Break dialog box, you cannot set a hardware breakpoint from the Event column
of the Editor window.

Hardware Break QR l

—Ewent:
Event I Type | Descriptions | Counk | TasxID | Comment
T ¢ (adovess]Fazeo . -

Figure 5.31 Hardware Break dialog box

[Adding a trace point]

1. Double-click or right click in the Event column of the Editor window then select Trace Point from the popup menu.
This sets fetching from the corresponding address as the condition for a trace point, i.e an instruction fetch condition.
Double-click on the instruction fetch event in the Event column of the Editor window to delete it.

CAUTION
Trace points cannot be set in the Event column of the Editor window in the following cases.

- The contents of the Trace conditions dialog box are being edited.

- The selected trace mode is Fill until stop or Fill until full.
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(3) Adding events by dragging and dropping

[Dragging and dropping a variable or function name in the Editor window]

1. By dragging and dropping a variable name into the Event column, you can set access to that variable as an event to be

detected, i.e. a data-access condition.

At this time, the size of the variable is automatically set as a condition of the data access event.

Only global or static variables taking up 1, 2, or 4 bytes can be registered for event detection. Static variables in functions

cannot be registered.

2. By dragging and dropping a function name into the Event column, you can set instruction fetching from the address where

that function starts as an event to be detected.

Il Hardware Break *

Hardwere Bresk OR |

Evenk:

| Event | T..| Descriptions

Line Sour..  E. CJ 5| Sowce
25 L e ————
26
27 (
£8 |Fa1BD
23 long t;
30 int i, 4, kK,
31
32 |FaiBs o ==
33 |F31ES while| gap > 0 ){
a4 Falcz for | k=0; kg
35 |F1CF for{ i=k+

Figure 5.32 Editor window and Hardware Break dialog box

[Dragging and dropping an address range in the Memory window]

F [address] $sort
[Address] Q060 [Size] WORD. ..

| Counk | Tastip | Camme

Select an address range in the Memory window and drag and drop it into the Event column. In this way, you can set access to

an address in the selected address range as a data access event to be detected, i.e. a data access condition.

[Dragging and dropping a label in the Label window]

You can set fetching from the label as an event to be detected, i.e. an instruction fetch condition.
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5.7.3 Removing Events
The following ways of removing events are available.

[Deleting an event from the Hardware Break, Trace conditions, or Performance Analysis Conditions dialog box]

1. To remove one point, select the line you want to remove in the Event list and then click on the Delete button (or use the
keys Ctrl + Del instead of clicking on the button).
The selected event will be removed from the Event list.

Hardware Break ©OR |

—Event:

Event | T.I Descripkions | Cu:uuntl TaskID | Zammerkt |
F [Address] _start
F [Address] _initsck - -
F [Address] _exit - -

add. .. ' Delete Enable | Disable |

Figure 5.33 Hardware Break dialog box

2. Toremove multiple events, hold down the Shift or the Ctrl key while you select lines you want to remove in the Event list
and then click on the Delete button (or use the keys Ctrl + Del instead of clicking on the button).
The selected events will be removed from the Event list.

Hardware Break  ©R |

—Event:

Event | T.I Descripkions | Cl:uuntl TaskID | Carmment |

Add... I Delete | Enable | Disable |

Figure 5.34 Hardware Break dialog box
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[Deleting an event from the Registered Events dialog box]

To remove one point, select the line you want to remove in the Registered Events dialog box and then click on the Delete
button (or use the keys Ctrl + Del instead of clicking on the button).

The selected event will be removed from the list of registered events.

To delete all events, click on the Delete All button.

[N rRegistered Events =10l x|

Events
Twpe | Descripkions | Cournk I TaskID I Caomrnenk
F [Address] _PowerQnl_,.,
F [Address] _main - -
F [Address] tutarial() - -
F [Address] Sample::sor,., - -

4| | |

Cuplicate | add... Delete Celete all
SAVE. .. | Load... | Help I Close I
P

Figure 5.35 Registered Events dialog box
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5.7.4 Registering Events

“Registering an event” refers to placing an event in the list of registered events. A registered event can be reused at a later time.
Select one of the following ways to register an event. Up to 256 events can be registered.

(1) Registering events

[Creating an event in the Event dialog box]

1. Open the Comment page of the Event dialog box and select the “Add this event to the list” checkbox. Then click on the
OK button.

x

Conditionl Count and Task ID  Comment |

Cormment: | BreakPoink

v iadd this event ko the list

Help | [o]8 I Cancel

Figure 5.36 Event dialog box

2. The event is added at the specified position and registered in the Registered Events dialog box at the same time.

Hardware Bresk. QR [ [N registered Events : o =] 5
—Event: Events I l I
' : ' Tvpe I Descripkions Count | TaskID | Comment
Evect | Type |Deserptione [ count | Tadan [ Comment F [Address] 000000 - E EreakPoint
F [Address]Ooooon - : BreakPoint
Figure 5.37 Hardware Break dialog box and Registered Events dialog box
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[Registering an event by dragging and dropping]

An event you have created can be registered in the Registered Events dialog box by dragging and dropping it into the list.

Hardware Break. OR [ [ rRegistered Events - = IEI‘EI
—Event: .| Events
Esvent Tvpe | Descriptions | cowr | 125410 | Comment ._tiE.I.._DE.“_TEm. H IQ;!I'IE | Tad__«:_lpl Comiment

- F  [Address] 000000 - - BraakPaint
F [Address]ooooon - : BreakPoint

Figure 5.38 Hardware Break dialog box and Registered Events dialog box

[Registering an event in the Registered Events dialog box]

Click on the Add button to create an event. Any event you create here is added to the Registered Events dialog box.

EH Registered Events =10 x|

Events
Tvpe | Descriptions | _ount | TaskiD | Comment

« _ | 2]

Duplicate add. .. Delete | Delete .ﬁ.lll

SAVE... | Load... | Help | Close |
P

Figure 5.39 Registered Events dialog box

(2) Attaching comments

An explanatory comment for the event can be attached. Check the Registered Events dialog box to see the registered events
and comments.
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5.7.5 Creating Events for Each Instance of Usage or Reusing Events

The following two approaches are available for setting events in the Hardware Break, Trace conditions, or Performance
Analysis Conditions dialog box.

One is to create events in the dialog box each time they are to be used. The other is to choose a condition from the Registered
Events dialog box and drag and drop it into the Event list in the Hardware Break, Trace conditions, or Performance Analysis
Conditions dialog box.

Here, we refer to the former as creating events per usage and the latter as reusing events.

[Creating events per usage]

Select this method if you intend to use a specific condition only once. The event you have created is used without ever being
registered.

Once the event is no longer in use (i.e., it has been changed or deleted), its setting is nonexistent.

Any event created by a simple operation such as double-clicking in the Event column of the Editor window constitutes an
event created per usage.

[Reusing events]

Any event registered in the Registered Events dialog box can be reused by dragging and dropping it into the Event list in the
Hardware Break, Trace conditions, or Performance Analysis Conditions dialog box.

Hardware Break OR I [X Registered Events i o ]
Event: Events
T I = I Saeh ’ R l R l = : Type I Descriptions I Count | TaskiD I Comment
Yen P8 | Descriptons LS ommen F [Address] 000000 - 3 BreakPoint
F [Address] 000000 - - BreakPoint

Figure 5.40 Reusing an event

(1) Dragging and dropping an event into multiple dialog boxes

An event in the Registered Events dialog box can be dragged and dropped into multiple dialog boxes.
If a condition of an event is altered after the event has been dragged and dropped, the alteration is not reflected in the setting of
the original event in the Registered Events dialog box.

(2) Registering duplicates in the Registered Events dialog box

Even duplicate events that have the same conditions can be registered in the Registered Events dialog box.
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5.7.6  Activating Events

To activate the settings for events that you have created, click on the Apply button. Settings you make do not become effective
until you click on the Apply button.

[*] after the title on the title bar of the Hardware Break, Trace conditions, or Performance Analysis Conditions dialog box
indicates that some setting is being edited. While you are editing an event, you cannot change the settings via the Event
column of the Editor window or the command line.

1ol

Hardware Break ©OR I

rEvent:
Evert | T..] Descrintions | count | Taskip | comment |
Ewdl F [Address] _main = rivain Function

Add... I Delets | Enabls ] Dissble |

Event used 1 Free 15 Detail Ra-g'rstraradavmts...l
save.. | Losd. | Help rpq:plg.r Close
p s

Figure 5.41 Activating the settings
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5.8 Setting Hardware Break Conditions

5.8.1 Setting Hardware Break Conditions
A hardware break causes the user program to stop running a specified number of cycles after a specific event or phenomenon
is detected (i.e., a hardware breakpoint is encountered). Up to 16 events can be specified as hardware breakpoint conditions.

5.8.2 Setting Hardware Breakpoints
(1) Setting Hardware Breakpoints

For a hardware breakpoint, you can set an OR condition, other conditions (AND (cumulative), AND (simultaneous),
subroutine, sequential or state transitions) and detection of exceptional events.

For each hardware breakpoint, you can specify all or only one from among the OR condition, other conditions, and detection
of exceptional events.

Program execution

{
OR condition | ->
Other conditions
AND (cumulative)
AND (simultaneous) -> Hardware breakpoint
encountered
Subroutine
Sequential
State transitions
Exceptional event ->
2 } Delay value
Break

Figure 5.42 A hardware break in outline
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(2) Setting an OR condition

You can choose to enable or disable the OR condition. By default, the OR condition is enabled.

To disable the OR condition, deselect the checkbox to the left of “OR condition.”

If you add an event by double-clicking in the Editor window while the OR condition is disabled, the OR condition is
automatically enabled.

When the OR condition is re-enabled, the previous event settings on the OR page (with their checkboxes being selected) are
restored.

However, if re-enabling the OR condition would bring the total number of events to more than 16, the events are restored with
their checkboxes not selected (disabled) on the OR page.

condition and combination setting
v OR condition:

Eventinuse: 0  Detai |

I other conditions:

IAND(.ﬁ.ccumuIatinn} j

Event inuse : 0 [etai |

1 Exception:

Taotal ; O Ewent

Delay(cycle) —

Exceptional m—— | ........... . "
events I ]

Figure 5.43 Hardware Break dialog box

Table 5.11 OR condition

Type Description

OR condition A breakpoint is encountered when any of the specified events occurs.
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(3) Setting other conditions

You can select one from among five available choices: AND (cumulative), AND (simultaneous), Subroutine, Sequential and
State transitions. To set any condition, select the checkbox to the left of “Other conditions.” Other conditions are disabled by
default (the checkbox to the left of “Other conditions” is not selected). Cumulative AND is listed as “AND(Accumulation)” in
the dialog box.

Hardware Break |OR I ANDEACcumulation) I

condition and combination setking
—v OR condition:

Evertinuse: 0  Detai |

IAND(.ﬁ.ccumuIatinn} j

Event inuse : 0 Dretail |

1 Exception:

Taotal ; O Ewent

Delay(cycle) —

Exceptional m—— | ........... . "
events I ]

Figure 5.44 Hardware Break dialog box

Table 5.12 Other conditions

Type Description

AND (cumulative) A breakpoint is encountered when all of the specified events have occurred regardless of
their timing and order.

AND (simultaneous) A breakpoint is encountered when all of the specified events occur at the same time.

Subroutine A breakpoint is encountered when a specified event occurs within a specified address range
(subroutine or function).

Sequential 6 steps (forward direction) + reset point
A breakpoint is encountered when the specified events occur in a specified order.

State transitions 3 steps, 9 paths + reset point
A breakpoint is encountered when the specified events occur in a specified order.

The events shown in the list for each condition can be deleted by the keys Ctrl + Del.

CAUTION

When a time-out condition is set in State transitions (Hardware break point) dialog box, the time to make transition from a set
state to another then back to the original set state must be 10 ps or more. Transition time of less than 10 ps will result in an
incorrect timeout detection.

R20UT3587EJ0302 Rev.3.02

Page 123 of 232
Sep.01. 21 ENESAS



ROE417250MCUO00 User’s Manual 5. Debugging Functions

(4) Detection of exceptional events
Specify whether you want detection of the following exceptional events to be used as a breakpoint.

- Violation of access protection

- Reading from a non-initialized memory area
- Stack access violation

- Performance-measurement overflow

- Realtime profile overflow

- Trace memory overflow

- Task stack access violation

- OS dispatch

(5) Specifying a delay value

If this checkbox is selected, program execution breaks the specified number of bus cycles after the breakpoint is encountered.
The delay value is specifiable in the range from 0 to 65,535 (default = 0).

5.8.3 Saving/Loading Hardware Break Settings

(1) Saving hardware break settings

Click on the Save button of the Hardware Break dialog box. The Save dialog box will be displayed.
Specify the name of the file where you want the break settings to be saved. The file-name extension is “.hev”. If this is omitted,
the extension “.hev” is automatically appended.

(2) Loading hardware break settings

Click on the Load button of the Hardware Break dialog box. The Load dialog box will be displayed. Specify the name of the
file you want to load.

When you load a file, the previous hardware break settings are discarded and the new settings appear in the dialog box.

Click on the Apply button of the Hardware Break dialog box to activate the new hardware break settings you have loaded.
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5.9 Viewing Trace Information

5.9.1 Viewing Trace Information

Tracing means the acquisition of bus information per cycle and storage of this information in trace memory during user
program execution. You can use tracing to track the flow of application execution or to search for and examine the points
where problems arise.

The E100 emulator allows acquisition of up to 4-M bus cycles.

When program execution stops (due to an exception break, forced stop or breakpoint), the contents of trace memory at the time
the program has stopped are displayed as the result of tracing, even if no trace points have been encountered yet.

5.9.2 Acquiring Trace Information

In cases where no trace acquisition conditions are set, the default behavior of the E100 emulator is to acquire information on
all bus cycles unconditionally (trace mode = Fill until stop).

In “fill until stop” mode, the emulator starts trace acquisition as soon as the user program starts running. When the user
program stops, the emulator stops tracing.

The acquired trace information is displayed in the Trace window.

| |
ve sazzriE5d) =eaa
nge: -04194303, 00000000 [Fie: |Cydle: 00000016 Address: D02084 Time: 00:00:10. 354,002,390 _-
cycle | Label | kddress | bata | Size | B/W | BWT | Status | Active | hrea | IMDO | IMD2 | DEBUG | UBRC | 1RQ | DEFG | RESETH | NMI | STEVH | EV | TimeStamp [him:s.ms.us.ns)||a|
=00000016 0ozoe+4 17r31073 LONG WORD R [} NCRMAL FETCH ROM o) 1 1 1 1 1 1 1 0000000000000000 00:00:10.394.002.380
-0D000D15 oozoges 0AB20100 LONG WORD R o WORMAL FETCH  ROM o 1 1 1 1 1 1 1 0000000000000000  00:00:10.394.002. 450
-00000014 oozogc 69240F92 LONG WORD R o NORMAL FETCH ROM - 1 1 1 1 1 1 1 0000000000000000  00:00:10.394,002,520
-00000013 aozosa Op050985 LoNG WORD R 0 NORMAL FETCH  ROM S 1 1 1 1 1 1 1 0000000000000000  00:00:10.3594.002 . 580
-0000001Z 00z004 17F50FD3 LONG WORD R a WOPMAL FETCH ROM - 1 1 1 1 1 1 1 0000000000000000  00:00: Q4,002,640
-000o0011 FEBPDZ ----0000 LONG WORD R 0 NCORMAL DATA RaM - 1 1 1 1 1 1 1 00000D0D00000000  00:00:10.394.002.710

00000010 FEBFD4 6456=-== LONG WORD R 0 NORMAL DATA RAM 1 1 1 1 1 1 1 0000000000000000  00:00:10.3594.002.770

-00oogong nozoos 10730ABZ LONG WORD R o NORMAL FETCH ROM - 1 1 1 1 1 1 1 0000000000000000  00:00:10.394.002.820
-00000008 00208 01006923 LONG WORD R o NORMAL FETCH  ROM S 1 1 1 1 1 1 1 0000000000000000  00:00:10.394.002.950
-000o0oo? 0020a0 1FE44F46 LONG WORD R 0 NORMAL FETCH  ROM o) 1 1 1 i 1 1 1 0000000000000000  00:00:10.324.002. 9860
-D0000006 0020AsE -—--———— - B a HORMAL - - - 1 1 1 1 1 1 1 0000000000000000 00:00:10.394.003.020
=00000005 002024 OF230D0Z LONG WORD R 0 NCRMAL FETCH ROM = 1 1 1 1 1 1 1 0000000000000000 00:00:10.3594.003,080
-00000004 002088 ———————— - R a NORMAL - - - 1 1 1 1 1 1 1 0000000000000000 00:00:10.394.003. 140
-00000002 00zoas 17F21072 LONG WORD R a WORMAL FETCH ROM - 1 1 1 1 1 1 1 0000000000000000  00:00:10.394.003.210
-0ooooooz oDzoac R 1 NCORMAL - - - 1 1 1 i 1 1 1 0000000000000000 00:00:10.394.003.270
-Dnoooon1 alekdul T B 1 NORMAL - - - 1 1 1 1 1 1 1 0000000000000000 00:00:10.394.003.330
00000000 00z0ac R [} NCRMAL = = o) 1 1 1 1 1 1 1 0000000000000000  00:00:10.394.002 ., 400 j

Figure 5.45 Trace window
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The following items are shown in the Trace window (in bus display mode).

Table 5.13 Items shown in the Trace window

Column Description
Cycle Number of the cycle within trace memory. By default, the number of the last cycle to have been acquired
is 0, and earlier cycles are assigned progressively lower numbers in sequence, i.e. -1, -2, etc. If a delay
count is set, the cycle on which the trace stop condition is met is numbered 0 and the cycles that were
executed until the program actually stopped (cycles during a delay period) are assigned progressively
larger numbers +1, +2, etc. in sequence up to the last cycle to be acquired.
Label Label corresponding to the address (displayed only when a label has been set)
Address Address on the address bus
Data Data on the data bus (in hexadecimal)
Size Unit of access (byte, word, or longword)
R/IW Data bus state, indicated as “R” for reading, “W” for writing, or “~" for no access
RWT Whether the bus cycle is valid or not. The value “0” indicates a valid bus cycle. The Address and Data
information is valid when RWT is “0”.
Status Current mode of the target MCU.
NORMAL Normal operation
S-ACT Subactive mode
SLEEP Sleep mode
S_SLEEP Subsleep mode
AMCS All-module clock-stop mode
S-STBY Software standby mode
H-STBY Hardware standby mode
D-STBY Deep standby mode
- Other
* Impossible combination with ACTIVE
Active Action taken by the target MCU.
DMAC Access by DMAC operation
DTC Access by DTC operation
HUDI Access by HUDI operation
DATA Data access by CPU operation
FETCH Instruction fetch by CPU operation
STACK Stack access by CPU operation
- Other
* Impossible combination with STATUS
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Column Description
Area Area being accessed.
EXT32 32-bit external access space
EXT16 16-bit external access space
EXT8 8-bit external access space
EXTMEM32 32-hit external emulation memory
EXTMEM16 16-bit external emulation memory
EXTMEMS 8-bit external emulation memory
ROM Internal ROM
11032 Internal 1/0 space (32-bit 1/0)
1/1016 Internal 1/0 space (16-bit 1/0)
1108 Internal 1/0 space (8-bit I/0)
RAM Internal RAM
- Other
Notes:

Access to an area for writing to the internal ROM (H’D00000 to H’DFFFFF) is indicated as “1/016”.
Access to the internal RAM area for use by the FCU (H’EF8000 to H’EF97FF) is indicated as “1/016”.
Access to the firmware area for use by the FCU (H’C00000 to H’CO1FFF) is indicated as “-”.

Access to an internal ROM area to which emulation memory has been assigned is indicated as “-”.

IMDO States of interrupt mask bits of the condition code register in interrupt control mode 0
Description

Value Bit CCR | Bit CCR Ui

. 0 0

Ui 0 1

l. 1 0

Ui 1 1

- The entry under IMDO is "-" if IMD2 values are being displayed.
IMD2 Interrupt mask levels of the extended control register in interrupt control mode 2

Description

Value Bit EXT 12 Bit EXT I1 Bit EXT 10

0 0 0 0

1 0 0 1

2 0 1 0

3 0 1 1

4 1 0 0

5 1 0 1

6 1 1 0

7 1 1 1

- The entry under IMDO is "-" if IMD2 values are being displayed.

DEBUG 0 indicates that the emulator has taken over the MCU bus while the user program was running. The
emulator takes over the MCU bus when access to memory is attempted by a debugger operation.
Note: Execution of the user program is temporarily stopped during such access to memory.

UBRC Whether the cycle was a user-bus release cycle (i.e. the external bus of the target MCU had been released
and a low-level signal was being output).

0: The external bus had been released.

1: The external bus had not been released.

IRQ Monitoring of user IRQ.
0: An interrupt has been detected.
1: No interrupt has been detected.

DBFG Whether the write-data buffer function was used and a low-level signal was being output.
0: The write-data buffer function was used.
1: The write-data buffer function was not used.
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Column Description

RESET# User reset input.
0: A user reset signal has been input.
1: No user reset signal has been input.

NMI NMI input.
0: An NMI signal has been input.
1: No NMI signal has been input.

STBY# STANDBY input.
0: An STANDBY signal has been input.
1: No STANDBY signal has been input.

EV If an event occurred, the number of the event.
To show the EV column, you need to select Event number on the Option page of the Trace conditions
dialog box opened by choosing Acquisition from the popup menu of the Trace window.

TID Task ID (when the RTOS is in use)

Task IDs are shown in the form “task ID (task entry label)”, such as 1 (_Taskl). To show the Task ID
column, you need to select Task ID on the Option page of the Trace conditions dialog box opened by
choosing Acquisition from the popup menu of the Trace window.

EXT Signal fed in from the external trigger cable; “1” and “0” indicate the signal being at the high and low
levels, respectively.

To show the EXT column, you need to select External trigger on the Option page of the Trace conditions
dialog box opened by choosing Acquisition from the popup menu of the Trace window.

Timestamp Time elapsed since the target program has started.

Each time the user program starts running, time stamping starts from 0.

Note: After the counter has overflowed, the times displayed will not be correct. The maximum timestamp
value is 3 hours 03 minutes 15 seconds.

Columns of the Trace window can be hidden if you do not require them. To hide a column, right-click in the header column
and select the column you want to hide from the popup menu.
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5.9.3 Setting Conditions for Trace Information Acquisition

Since the size of the trace buffer is limited, the oldest trace data is overwritten with new data after the buffer has become full.
You can set trace conditions to restrict the acquired trace information to that which is useful, thus more effectively using the
trace buffer.

To set trace conditions, use the Trace conditions dialog box that is displayed when you choose Acquisition from the popup
menu of the Trace window.

(1) Selecting the trace mode

Start by selecting the trace mode.

Trace | Dption I

op
Trace Mode: A Fill until stop j

condikion ang bFEill unkil skop,
v St
¥ R cong r—  Fill kil Full
Event inug 1P
i ae'ull dalay | Fill around TP
| Gther o w3

i i
'[ r 1' T Repeat Fill until stop

IANDI{P.::::L _1]._ ]L JI: W

'|' Repeat Fill unkil Full
Event inusEr T o= ] I

Figure 5.46 Trace conditions dialog box

(2) Setting trace points

If you have selected Fill around TP, Repeat fill until stop or Repeat fill until full, you need to set a trace point.
For trace points, you can specify conditions using events and/or the detection of specific exceptional events.
For Fill around TP, you can also specify a delay value.

(3) Selecting Capture or Do not capture

If the selected trace mode is Fill until stop, Fill until full or Fill around TP, you can specify Capture or Do not capture in the
Record condition group box.

Record cu:unu:_l_i_l_:inn:
oAl !C rej " Do nok capture ¥ | step executionis recorded

I WEV] _WEv]_ Between bwo events j Detail |

Eventin use ; O

Figure 5.47 Record condition group box

You can specify events so as to extract only the required portions or to eliminate non-required portions of the trace information.
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(4) Recording step execution

If the selected trace mode is Fill until stop, you can record step execution. To record step execution, select the Step execution
is recorded checkbox in the Record condition group box.

—Record condition:
& pl O Capture Do not capture [v Step execution is recorded

Eventinusa: 0

Figure 5.48 Recording step execution

The recordable modes of step execution are Step In, Step Over and Step Out.

(5) Selecting the type of trace information to be acquired

Use the Option page of the Trace conditions dialog box to select the type of trace information to be stored in the trace memory.
By default, ‘Event number’ is selected as the type of trace information.
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5.9.4 Selecting the Trace Mode
(1) Selecting the trace mode

The following five trace modes are available.

Table 5.14 Trace modes

Trace mode Description
Fill until stop Trace acquisition continues until the program stops running.
Fill until full Trace acquisition stops when the trace memory becomes
full.
Fill around TP Trace acquisition stops a specified number of cycles after a

trace point is encountered. A delay value can be specified in
the range up to the maximum value of trace capacity.

Repeat fill until stop For each trace point encountered in program execution,
information for a total of 512 cycles* before and after the
point is acquired, and acquisition continues in the same way
until the program stops running.

Repeat fill until full For each trace point encountered in program execution,
information for a total of 512 cycles* before and after the
point is acquired, and acquisition continues in the same way
until the trace memory is full.

CAUTION

*Recording is for 512-cycles units, consisting of the lines for the cycle at the trace point, for the 255 cycles before that point,
and for the 256 cycles after that point.

Execution starts

Trace pointis
encountered

Trace pointis
encountered

Trace pointis
encountered

\/

Execution stops

Figure 5.49 Differences between the trace modes
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Specifiable conditions vary with the trace mode, as summarized in the tables below.

1. Fill until stop
The trace memory can hold up to 4-M bus cycles. When the buffer becomes full, the oldest data among the acquired trace
information are overwritten with new data. The emulator continues acquiring trace information in this way until the
program is stopped.

Table 5.15 Specifiable conditions: Fill until stop

Trace point Delay Specifying capture/do not Recording of step
capture execution
- - Possible Possible
2. Fill until full

Once the trace memory of the emulator overflows during trace acquisition, the emulator stops acquiring trace information.

Table 5.16 Specifiable conditions: Fill until full

Trace point Delay Specifying capture/do not Recording of step
capture execution
- - Possible -

3. Fill around TP

Trace acquisition is halted a specified number of cycles after a trace point is encountered. In this mode, the user program
continues running and only trace acquisition is halted. Sophisticated conditions can be set using a maximum of 16 event
points. The delay value can be chosen as OM, 1M, 2M, 3M or 4M cycles.

Table 5.17 Specifiable conditions: Fill around TP

Trace point Delay Specifying capture/do not Recording of step
capture execution
Possible Possible Possible -

4. Repeat fill until stop
For each time trace point encountered, information for a total of 512 cycles before and after that point is acquired, and
acquisition continues in the same way until the program stops running. Acquisition continues until it is halted by a break or
forced stop. The positions where trace points have been encountered can be checked in the Trace window.

Table 5.18 Specifiable conditions: Repeat fill until stop

Trace point Delay Specifying capture/do not Recording of step
capture execution
Possible - - -
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5. Repeat fill until full
For each time trace point encountered, information for a total of 512 cycles before and after that point is acquired.
Acquisition continues in the same way until the trace memory overflows, at which time acquisition is halted. The positions
where trace points have been encountered can be checked in the Trace window.

Table 5.19 Specifiable conditions: Repeat fill until full

Trace point Delay Specifying capture/do not Recording of step
capture execution
Possible - - -
CAUTION

If trace points are encountered in consecutive cycles in the repeat fill until stop or repeat fill until full mode, the yellow
highlight that indicates a trace point only appears for the trace point in the first of the cycles.

5.9.5 Setting Trace Points
(1) Setting trace points

For trace points, you can set an OR condition, other conditions (AND (cumulative), AND (simultaneous), subroutine,
sequential or state transitions) and detection of exceptional events.
You can specify all or only one of the OR condition, other conditions and detection of exceptional events at a time.

Trace acquisition

\

OR condition | ->

Other conditions
AND (cumulative)

AND (simultaneous) -> Trace point encountered
Subroutine

Sequential
State transitions

| Exceptional event | ->

J } Delay value
Trace acquisition halted
Figure 5.50 A trace point in outline
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(2) OR condition

You can choose to enable or disable the OR condition. By default, the OR condition is enabled.

When the OR condition is re-enabled, the previous event settings on the OR page (with their checkboxes being selected) are
restored.

However, if re-enabling the OR condition would bring the total number of events to more than 16, the events are restored with
their checkboxes not selected (disabled) on the OR page.

Trace |oR | Option |

i :le'ull dalry | Fill around TP j

condition and combination setking
—v OR condition:

Evert inuse: 0  Detai |

1 Other conditions:

Trace Maode:

IAND{P.I:l:umulatiI:un} j i

Eventinuse: 0 et | 0
Exception: i

T Exception 0 Delaw(ovele):

Exceptional : | ___________ '
evenks pizel I oM vI

—FRecord condition:
@ al © Capture € Do nok capkure [ Step execution is recorded;

o] i

Taokal : 0 Ewent

Eventinuse : O

Figure 5.51 Trace conditions dialog box

Table 5.20 OR condition

Type Description

OR condition A trace point is encountered when any of the specified events occurs.
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(3) Other conditions

You can select one from among five available choices: AND (cumulative), AND (simultaneous), Subroutine, Sequential and
State transitions. To set any condition, select the checkbox to the left of “Other conditions.”

Other conditions are disabled by default (the checkbox to the left of “Other conditions™ is not selected). Cumulative AND is
listed as “AND(Accumulation)” in the dialog box.

IR I MO Accurmulakion) I Optinnl

i ae'.w'll dalry | Fill around TP j

condition and combination setking
v OR condition:

Evert imuse: 0  Detai |

¥ Other conditions:

Trace Maode:

IAND{P.I:l:umulatiI:un} j

Eventinuse: 0  Detai | 0

E Lo
—: xcsp ID:-l Delay(ovcle) —
wrepkiona ; | ___________ 0
evenks ek ’7 I 4M vI

—FRecord condition:
@ al © Capture € Do nok capkure [ Step execution is recorded

o] i

Taokal : 0 Ewent

Eventinuse : O

Figure 5.52 Trace conditions dialog box

Table 5.21 Other conditions

Type Description

AND (cumulative) A trace point is encountered when all of the specified events have occurred, regardless of the
timing.

AND (simultaneous) A trace point is encountered when all of the specified events occur at the same time.

Subroutine A trace point is encountered when a specified event occurs within a specified address range
(subroutine or function).

Sequential 6 steps (forward direction) + reset point
A trace point is encountered when the specified events occur in a specified order.

State transitions 3 steps, 9 paths + reset point
A trace point is encountered when the specified events occur in a specified order.

CAUTION

When a time-out condition is set in State transitions (Trace) dialog box, the time to make transition from a set state to another
then back to the original set state must be 10 ps or more. Transition time of less than 10 ps will result in an incorrect timeout
detection.
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(4) Detection of exceptional events

Specify whether you want detection of the following exceptional events to be used as a trace point.

- Violation of access protection

- Reading from a non-initialized memory area

- Stack access violation

- Performance-measurement overflow
- Realtime profile overflow

- Task stack access violation

- OS dispatch

(5) Specifying a delay value

If this checkbox is selected, tracing stops the specified number of bus cycles after the trace point is encountered.

The delay value is selectable as OM, 1M, 2M, 3M or 4M bus cycles (default: OM).

Select the desired value from the Delay drop-down list box.

PR
| ]

v Sther conditions:

IAND(.ﬁ.ccumuIatinn} j

Evertinuse: 0 Detail |

o Exception:

Exceptional Dietal | ___________
events

Tokal: 0 Ewent

Delay(cycle):
@5

o —
—Record condition: 1M
i all  Capture © Do not capkure [~ stepe gm Hed
il |

Ewent in use : 0
Figure 5.53 Selecting a delay value
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5.9.6  Setting Extraction or Elimination Conditions

If the selected trace mode is Fill until stop, Fill until full or Fill around TP, you can specify a condition for capturing or not
capturing information.

You can specify events so as to extract only the required portions or to eliminate non-required portions of the trace information.

(1) Extraction and elimination conditions

The following types of condition are available.

Table 5.22 Extraction and elimination conditions

Type Description

Extraction WEML T E]_ Between two events Trace information is extracted from the cycle in which the
event set as [Start event] occurs to the cycle preceding the
event set as [End event] (information is not acquired for the
cycle where [End event] occurs).

N PR = Duration of an event Trace information is extracted over the cycles
corresponding to occurrence of the specified event.
P Duration of an event Trace information is extracted over the cycles
occurring in a corresponding to occurrence of the specified event within
subroutine the specified address range (subroutine or function).
1o Instruction accessing Information is extracted for instructions that access
specific data specified data.
Elimination B W[Ev]_ Between two events Trace information is eliminated from the cycle in which the

event set as [Start event] occurs to the cycle preceding the
event set as [End event] (information is not acquired for the
cycle where [End event] occurs).

N PR =T Duration of an event Trace information is eliminated over the cycles
corresponding to occurrence of the specified event.
L Duration of an event Trace information is eliminated over the cycles
occurring in a corresponding to occurrence of the specified event within
subroutine the specified address range (subroutine or function).

Select the desired condition from the list box that is displayed when you select Capture or Do not capture in the Record
condition group box of the Trace conditions dialog box.

Record condition:
Al % Capture; © Da not capture ¥ | step execution s recarded

I BBV _Ev]_ Between bwo events j Dk il |

Eventinuse ; 0

Figure 5.54 Record condition group box

Then click on the Detail button. The Event dialog box will appear.
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CAUTION

When you specify conditions for extraction or elimination, you cannot select DIS (disassembly mode) or SRC (source mode)

from Display Mode in the popup menu of the Trace window.

When you specify a data-access event as a condition for extraction or elimination, be sure to specify MCU bus as the access

type.

Condition |C|:u_|nt and Task ID I Camment I

Event bype IDaI:a access j

— Condition settings

—ACcess bype
i Mnemu:uniu: level |LomG j

[#] cPu
DMAC
DT

1 Address condition ISpemﬁed value (=]

Skart: E End: I I E

1 Data condition ISpeclﬁed walue (=)

Yaluel: I Yaluez: I
Mask.
(I' Eniabiled Masking walue: I FFFFFFFF

Read/write IRead,l'Write j

X

Help | Ik I

Figure 5.55 Event dialog box
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5.9.7 Selecting the Type of Trace Information to be Acquired
Select the type of trace information to be stored in the trace memory. Make this selection on the Option page of the Trace

conditions dialog box.

8 Trace conditions * B =10] x|

Trace Option

Selecting the kvpe of trace infarmation

¥ Event number
i TaskID

" External trigger

Event used 1 Free 15 Detail...l Registered e'-.fents...l

Save... I Load... | Help I Apply | Close

Figure 5.56 Trace conditions dialog box

|

Select which signal you want to acquire from three choices available: Event number, Task 1D or External trigger. By default,
Event number is selected.

CAUTION
If you want to view the history of tracing information on a realtime OS program, select Task ID.
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5.9.8 Viewing Trace Results

To check trace results, open the Trace window. Trace results can be shown in one of the following display modes: bus,
disassembly, source, or mixed. The display can be switched by changing the selection of Display Mode in the popup menu of
the Trace window.

(1) Bus Display Mode
In the popup menu, select Display Mode -> BUS. Bus information is displayed for all traced cycles (this is the default display

mode).

rrace L |
mvp|lsazziE 54 aaa

Ange: -00D07637, DOUODDOD |Fie: [Cycle: 00000016 Address: D01076 Time: 00:00:00.000,476.350 |

Gycle | Lahel | 2ddress | bata | Gize | R/14| BWE | Status | Active | Ares | IMDO | IMDZ | DEBUG | UBRC | IRQ | DBFG | RESETA | MWL | STBY# | EV | TimeStamp (him:s.ms.us.ns) ]
=-00000016 001078 10710490 LOHG WORD R o HORMAL FETCH  ROM =5 - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.476.350
-00000015 ooLov2 -=--0FF0 WORD R o WORMAL FETCH  ROM = 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.476, 420
-00000014 00107¢  D1006982 LONG WORD B 0  HORMAL FETCH  RoM - 1 1 1 1 1 11 0000000000000000  00:00:00.000. 476, 480
=00000013 ooi0en OB537923 LONG WORD R o WORMAL FETCH  ROM - 1 1 1 1 1 1 1 0000000000000000  00:00:00,000.476, 540
-00000012 001084 OODA4DDC LONG WORD R 0  NORMAL FETCH  RoM - 1 1 11 1 1 1 0000000000000000  00:00:00.000. 476, 600
-00000011 001088  —-——---- - R0 NORMAL - - - 1 1 11 1 11 0000000000000000  00:00:00.000. 476. 670
=-00000010 001088 57700rCD LONG WORD R o TORMAL FETCH  RoOM - 1 1 1 1 1 i i 0000000000000000  00:00:00,000.476,730
-00000003 PFBEDE  —-—-0000 LONG WORD W 1  NORMAL DATR  RAM - 1 1 101 1 11 0000000000000000  00:00: 476,790
=00000002 FFEEDE ====0000 L AORD T o HORMAL DATA FAM - 1 1 1 1 1 1 1 0000000000000000 00:00 -476.850
-00000007 FFEFED  20DA---- LONG WORD W 1  TWORMAL DATA  RAM - 1 1 11 1 1 1 0000000000000000  00:00 476,920
-00000006 PFEEE0  20DA---- LONG WORD W O  HOEMAL DATA  RaM - 1 1 11 1 11 0000000000000000  00:00:00.000. 476,980
=00000005 00108 SEO0Z048 LONG WIORD R o NORMAL FETCH  ROM - 1 1 1 1 1 1 1 0000000000000000  00:00:00,000.477.040
-00000004 001090  OFFI0FCO LONG WORD R 0 NORMAL FETCH  RoM - 1 1 11 1 1 1 0000000000000000  00:00:00.000. 477, 100
-00000003 001064  SEOD11BZ LONG WORD R O  HORMAL FETCH  RoM - 1 1 11 1 11 0000000000000000  00:00:00.000.477.170
=-00000002 001094 R i TORMAL = = - i 1 1 1 1 i i 0000000000000000  00:00:00.000.477,230
-00000001 001094 - R 1 NORMAML - - - 1 1 101 1 11 0000000000000000  00:00:00.000. 477,290
00000000 001084 = R o HORMAL - o) - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.477.350 j

Figure 5.57 Trace window
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(2) Disassembly Display Mode
From the popup menu, choose Display Mode -> DIS. This mode shows a disassembly of the machine-language instructions

that have been executed.

reace -
nmy | FAaFXrx B S4r (a8
[Feange: -D0D0RGTE, DOO00000. Fles | ok 00000001 Wakdvas: (0ZU5E [Tines; 00 7008 001000, 55%. 500
Epsle Label | Rddeess Sedect Sode || Tnatrusticn TimeHEanp =]
=00oonoa 1 DOZL13E TaoLoooa fo e ¥H'DOD9:16,R1 DOr00: 00,000, 536, 500
-0000000 00112 1301 8IE. W 3, A1 00100100, 000, 596,670
oannoies O0ELé4 17F1 BETE.T ER1 000 00, 000, 596, 70
-0O00002E 00166 071 SMLL.L AE.ERD 00300 00, 000. 596, 790
-0000ooe T o0z1cd ORoz ADD.L Rl Bl 00:00:00. 000. 596 . 650
-0000002 6 O0z1EL 0100524 L AERZ, ZRA O0:00:00.000. 596 . 520
-0000002 5 00Z1EE OFBl ML L ER3, BR] 00200100, 000. 536, 580
-0000002 4 oo0z1To onoz MO 0, B2 00100100, 000, 537, 040
~0000002 a0ILR 17F% BETS.L  ERI 0300 00,000,597, 100
~CO0000% 003174 107% SMLL.T AELORE 0030000, 000. 597, 170
-000000 1 00176 oaat ADD.L ERZ, R O0:00:00.000. 597, 230
-00000013 00z17d O100E504 WL ERd, AzR1 00:00:00.000. 597 . 410
-00000016 002176 OB50 IHG.H ¥1,00 O0:00:00.000. 537, 540
-00000015 O0Z17E Taz0000A CHE .M #H'000A: 15, 50 00100100, 000, 537, 500
-00000014 aoz182 008 BLT aH 150 00100100, 000, 537, 870
LTI Eh B 0azing LM A ADD W HN002A: 16, 7T 000 00, 000, 527, 710
-CO000o: OOZ1AH 54iq AT/ |ERE-ZR4) 0030000, 000. 598, 420 E|

Figure 5.58 Trace window

(3) Source Display Mode

From the popup menu, choose Display Mode -> SRC. This mode shows the flow of execution of the source program.
You can check the flow of execution by stepping forwards and backwards through the source code from the current trace cycle.

T el
Vo PAXXh#E F4dP|(F AGE

[Range! -CODLZ0ME, 00000000 et soet.cop [Cyde: -DOO0LISL [Godrass: DOZOSS. [Tives: D0S00(00, 090 B4LEDD |

Line Addeeas How | Source =]
aonez? O020E6

anoosE 00z06E = for| iFktgap; 1<10; i=itgap i

aoooag 0020Te = far [1=i=gmp; 3=k; 1=31=gap){

Qopo4aa 002 0eag = g IntBuf = j;

a00na1 a0z eEs - aftald)=ali=gapl |

aonpaz O0Z0AE = t = alil;

aonogs 0020 - al[1] = alitgmpl;

‘00D044 | 0020DC - alitgapl = &

ao0oas 1

O0ooa e & Lag

annpaT break;

Q0ncde 1

aonnga 1

ao0nsEa b

Annns1 002106 | = gEp = gapsE;

0000s: | H

Q0003 oozii4 | = gq_CharBuf = (charjg IntBuf & Ox00FE; =

Figure 5.59 Source mode screen
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(4) Mixed Display Modes

Two or all of the basic modes can be selected at the same time, providing mixed displays of bus, disassembly, and source
information.

After choosing Display Mode -> BUS from the popup menu, select Display Mode -> DIS. This produces a mixed display of
bus and disassembly modes.

In the same way, you can produce mixed displays of bus—source, disassembly—source, or bus—disassembly—source.

To revert to bus mode after viewing a bus—disassembly mixed display, reselect Display Mode —> DIS from the popup menu.
rrace L |

vvplsazxz|rE =d)r & aaa

[ranoe; 00009576, 00000000 Fie: |Cyele: 00005578 Addeess: 000400 Time: 00:00:00,000,000.050 |

[eycle | Tebel | kddress | bata | Size | B/t RWT | Status | hetive | Area | IMDD | IMDZ | DEBUG | UBRC | 1RG | DEFG | RESETH | WMI | STEVH | EV | TiweStamp (h;m:a.m,us.ns;”i]
=00009572 _PowerON_Rese 000400  7A0700FF LONG WORD R o NCRMAL FETCH ROM I . o) 1 1 1 1 1 0000000000000000 00:00:00.000.000.050
-00003577 000404  cO0000430 LONG WORD R 0 WORMAL FETCH ROM T . o) 1 1 1 1 1 1 1 0000000000000000  00:00:00.000.000. 110

resetpryg.e 56 1 _ entry(veot=0]) void PowerON_Reset (void)

000400  _PowerON_R MOV.L #H'00FFe000:32, ERT
-00009576 000402  SEDO110E LONWG WORD R O NORMAL FETCHK ROM I . - 1 1 101 1 11 0000000000000000  00:00:00.000.000. 130

resetprg.c &7 i set_imask_cor ((_UBYTE) L};

000406 ORC LB #H'80:8, CCR
-00009575 00040¢  DETFSEQD LONG WORD B O  NWORMAL FETCHK ROM I . - 1 1 11 1 11 0000000000000000  00:00:00.000.000.240
-00008574 aoo410 1030180 LoNG WORD R o NORMAL FETCH  ROM T . S 1 1 1 1 1 1 1 0000000000000000  O0:00:00.000.000.300
-00009573  _ INITSCT 00110E  ----0120 WORD R 0 WORMAL FETCH ROM I . - 1 1 1 i 1 1 1 0000000000000000  00:00:00.000.000.360
-00009572 FEEFFC  0OO0040C LONG WORD W 1 NOEMAL STACK RaM I . - 1 1 11 1 11 0000000000000000  00:00:00.000.000. 430

resetprg.c 68 1 _INITSCT();

000408 T3R @ INITSCT:Z4
-00000571 FEEFFC  0000040C LONG WORD W O HORMAL STACK RRM I . - 1 1 101 1 11 0000000000000000  00:00:00.000.000. 460
-00009570 o110 EDF47A00 LONE WORD R 0 NCRMAL FETCH ROM I . - 1 1 1 i 1 1 1 0000000000000000 00:00:00.000.000,550
-00009563 001114 DOD013BA LONG WORD B 0  NOEMAL FETCH ROM I . - 1 1 101 1 11 0000000000000000  00:00:00.000.000. 610
-00009568 001112  7A010000 LONG WORD R O  NORMAL FETCH RoM I . - 1 1 101 1 11

0000000000000000  00:00:00.000,000, 620 =l

Figure 5.60 Trace window
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5.9.9 Filtering Trace Information

Use the filtering facility to extract only the records you need from the acquired trace information. This facility is achieved by
software filtering of the trace information that has been acquired by hardware.

Unlike “Capture/Do not Capture”, where the conditions must be set before getting the trace information, the filter settings can
be changed any number of times. This makes it easy to extract required information, significantly facilitating data analysis.
Filtering does not affect the trace memory, so that its contents remain intact.

Filtering is available when the selected trace mode is Fill until stop, Fill until full or Fill around TP and the selected display
mode is bus or disassembly.

(1) Auto-filtering
To use the filtering facility, choose Auto Filter from the popup menu of the Trace window. When Auto Filter is turned on, each

of the columns in the Trace window is marked with an auto-filter arrow [j].

By simply clicking on the arrows [j] and selecting desired conditions from the drop-down lists, you can filter the records to

get those that meet the conditions. Selecting Option in the drop-down list brings up the Option dialog box. In this dialog box,
you can set detailed conditions.

Items such as Address and Data do not have a manageably small fixed set of items, so the only entry in the drop-down list for
these columns is Option... Selecting All returns the window to the non-filtered state.

=
mVi FaErx B C40 @S
[Feange: -00D0RGTE, SOO00000. Flee | ok 00000001 Wakdras: 002064 [Tines; 00 7008 001000, 55%. 500
Gypele x| Lakel | hddresx] batn =] Bize x| RSx] B =] keex] v =] =] ven=] tnx] vee=] rese=] =] srex] = =] TumeBuamp =11=]
-000000d 1 O02164  1TFLLOT] LOWG WCRD R O E R .. - 1 1 1 1 1 1 CO00000000000000 00:001 00,000, 296, 500
-0anunean 002168 ORIIOLOO0 LONG WORD B O E R .. - 1 1 1 1 1 1 COOD0OOOI00000a0 003001 00,000, 296, 570
oannoies 0izi1ks  GREA0FE] LOWG WORD R 0 |HAMAL B RO 1 1 1 1 1 1 COODO0OCDONO000 GO=00; 00.000, £95, 20
~O00000e S ooz iTa OpdELTTd LOWE WoRD R o m-ACT " ROH 50 = 1 1 i i 1 i COONACODONACOOI0 GO=00; 00000, 526, 730
-000000:T D0X1T4  I07E0AR] LOWG woRD B O |=LEER ke o .. - 1 1 1 1 1 1 COO0000000000000 D0=00: 00000 . ZRE. BS0
-CO00002 6 DO2ITE  ———mmmmm - B0 |s-sLEER - R 1 1 1 1 1 1 COO0000000000000 00=00: 00,000 . 506, 020
-C000002 5§ PEEFS0  OOODODCO LoWS Wopb B O [AMcs R L 1 1 1 1 1 1 CO00000000000000 002001 00,000, 296, BB
-000000e 002178 01005559 LONG WoRD B O [8-BTEY  =fE ROM . . - 1 1 1 1 1 1 CO00000000000000 00001 00,000, 257, 0140
~Ca000e 002170 OBSO7520 LONG WCRR B 0 BORMAL FETCH  ROM 1 1 1 1 1 1 COODOGODN0M000 G0:00: 00,000, &7, 100
oOnnoce 00z a0 MO0A9eTd LOEE WORR R 0 FORMAL  FETGID ROM 1 1 1 1 1 1 COONACO0DNANCOIN GO=00; 00000, 527, 170
~COn000: 1 00384 ——mmmmmm - B0 WORMAL - - - 1 1 1 1 1 1 COON00O0O0000000 D0=00: 00000 . 297 230
-000000aa 002184 TOLTO02A LOWG WoRh B 0 EORMAL FETCH RO - 1 1 1 1 1 1 CO00000000000030 00=00: 00000 . 567
-0000001 PEEFDE  ----0000 LOWG WO W 1 NOFRMAL DATA  RAM - 1 1 1 1 1 1 CO00000000000000 00=00: 00,000, 567, 35
-0000001E PEEFDE  ----0000 LONG WORD W 0 EORMAL IRTR  PAM - 1 1 1 1 1 1 CO000NCO00000000 00:001 00,000, 257, 41
-0anuna1y FEEFED  0000---- LOBG WOAD W 1 FOFMAL DRTR  RAM - 1 1 1 1 1 1 COODOGOO0N000a0 00001 00,000, 257,
(TG T FERFED 0000 LOWE WORD W 0 FORMAL DATA RAM 1 1 1 1 1 1 CONOOOCODNN0CNaN 00:00; 00.000,
~COn00015 00185  S4ZAFTTF LOWG WORD B 0 WORMAL TETCH  ROM 1 1 i 1 1 i COONOOOODDN0ON00 D0=00; 00000 . 597, 600 =

Figure 5.61 Trace window

If you switch the display mode to disassembly or source after filtering records in bus mode, Auto Filter is deselected. Similarly,
if you switch the display mode to bus or source after filtering records in disassembly mode, Auto Filter is deselected.
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If you have specified multiple items in an Option dialog box, these items constitute an OR condition for use in filtering.

2]

Iterm;

[w]HORMAL il
[]5-ACT
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(] I Cancel |

Figure 5.62 Option dialog box
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5.9.10 Searching for Trace Records
You can search the acquired trace information for a specific trace record.
To search for trace records, use the Find dialog box. Open this by choosing Find -> Find from the popup menu of the Trace

#h

window or clicking on the Find toolbar button |l

.

2/
Combination: Fird Ik
1 Cycle - Find Presdaies
| Address

T RWT
| Status

T Active
| Area

1 IMDD

T kAN :I

[ Ezchusion of the specified condiion

FEind Setting Contents:

Mew
Delete
Delate Al
Histary:
[01] : [Stakes] SLEEP Sdd

[02] : [Datal 0. [RAV] W

Claze

Figure 5.63 Find dialog box

In the Combination column, select the checkboxes for the items of trace information for which you want to set up criteria.

The criteria that correspond to the currently selected items appears in the Find Item column. Select the required criteria.

If you have checked more than one item in the Combination column, set criteria for each of them. The items you have set are
used as an AND condition.

The criteria you have set are shown in Find Setting Contents.

After setting the criteria, click the Find Previous or Find Next button to start a search. Searching then proceeds forwards or
backwards through the trace records from the line you have clicked in the Trace window (the line highlighted in blue).

When a matching trace record is found, the corresponding line is highlighted in the Trace window. If no matching trace records
are found, a message dialog box is displayed.

When an instance of the trace record was successfully found, choose Find Previous or Find Next from the popup menu. This
initiates a search for the next instance of the trace record.
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(1) Search history

The search conditions that have been used are recorded in the History column and are retained throughout a session of the
High-performance Embedded Workshop.

If you want to perform a search again, choose the corresponding line from the history and click on the Add button to initiate a
new search for trace information with the same condition.

Up to the last 10 searches are retained in the search history.

(2) OR search

You can perform a search with two or more search conditions combined in an OR condition.

To set an OR condition, begin by setting the first condition (shown on the first line in the Find Setting Contents column) and
then click on the New button.

Then enter the second condition. At this time, the second condition is added as a second line in the Find Setting Contents
column.

In this case, the search is for lines satisfying the logical OR of the conditions on the first and second lines in the Find Setting
Contents column.

Up to 16 conditions (16 lines) can be set.

CAUTION
Conditions set on the same line of the Find Setting Contents column are treated as an AND condition.

5.9.11 Saving Trace Information in Files

Il . The

To save trace information in a file, choose File -> Save from the popup menu or click on the Save toolbar button |l

trace information displayed in the Trace window is saved in a binary or text format.

(1) Saving in the binary format

To save trace information in the binary format, choose “Trace Data File: Memory Image (*.rtt)” in the Save As Type list box
of the dialog box that is displayed when you choose File -> Save from the popup menu.

When information is saved in the binary format, information for all cycles is saved. This type of file can be loaded back into
the Trace window.

(2) Saving in the text format

To save trace information in the text format, choose “Text Files: Save Only (*.txt)” in the Save As Type list box of the dialog
box that is displayed when you choose File -> Save from the popup menu.

When information is saved in the text format, saving of information for a range of cycles can be specified. This type of file can
only be saved and cannot be loaded back into the Trace window.
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5.9.12 Loading Trace Information from Files

To load trace information from a file, choose File -> Load from the popup menu or click on the Load toolbar button |l = ].
Specify a trace information file that was saved in the binary format. The current results of tracing are overwritten.

Before loading a file saved in the binary format, switch to the trace mode in which the saved trace information was acquired.
This switching should be performed in the Trace conditions dialog box that is displayed when you choose Acquisition from the
popup menu of the Trace window.

If the current trace mode differs from that in which the saved information was acquired, an error occurs. Trace information
files saved in the text format cannot be loaded back into the Trace window.

5.9.13 Temporarily Stopping Trace Acquisition
To temporarily stop the acquisition of trace information during user program execution, choose Trace -> Stop from the popup

menu of the Trace window or click on the Stop toolbar button |l ].

Trace acquisition will be stopped, with the trace display updated. Use this function when you only want to stop acquisition and
check the trace information but not to stop program execution.

5.9.14 Restarting Trace Acquisition
If you want to restart trace acquisition after it has temporarily been stopped during user program execution, choose Trace ->

Restart from the popup menu of the Trace window or click on the Restart toolbar button |l v ].

5.9.15 Switching the Timestamp Display
The display of timestamps in the Trace window can be switched to absolute time, differential time or relative time. In the
initial state, the timestamps are displayed in absolute time.

(1) Absolute time

Choose Time -> Absolute Time from the popup menu or click on the Absolute Time toolbar button [ﬁ . The displayed

timestamps will be displayed in absolute time since the program started running.

(2) Differential time

Choose Time -> Differences from the popup menu or click on the Differences toolbar button |l ]. Each displayed timestamp

is the difference in time from the preceding cycle.

(3) Relative time

Choose Time -> Relative Time from the popup menu or click on the Relative Time toolbar button [a . The displayed

timestamps are times relative to the time of a specified cycle.
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5.9.16 Viewing the History of Function Execution
To view the history of function execution extracted from the acquired trace information, choose Function Execution History ->

i3}

Function Execution History from the popup menu or click on the Function Execution History toolbar button [i

An upper pane will be opened in the Trace window (the pane is blank by default).
When you choose Analyze Execution History from the popup menu or click on the Analyze Execution History toolbar button

[ e ], the emulator starts analyzing the history of execution history from the end of the results of tracing. The results of

analysis are displayed in a tree structure.

mvolsazrznE =dr = aaa

(= <_PowerON_Reset> (00040C) il

(00104<) «<- 001042

E- Samples sSanple () (002000) <- 001056
E- _rand (0D11BZ} <- 001064

#- _rand (0D11BZ} <- 001064

#- _rand (0D11BZ} <- 001064

Range: -00005575, 00000000 Fie: |Cycle: -00003053 Adchess: 001040 Time: 00:00:00. 000,405,550

Lobel Address | Data Size R/W | RWI Status | Active | Area | MDD | IMD2 | DEBUG | UBRC | IRQ | DBFG | RESET# | WMI | STBY# | EV TimeStomp (himss.ms.us. najl +|
] 001040 RD R . = 1 1 il il 1 1 1 0000000000000000  00:00 00. 80
001044  OFSE0FS0 LONG WORD R 0 NORMAL FETCK  ROM - 1 1 11 1 1 1 0000000000000000 00:00:00.000. 406.050
-0000308 1 001043 46FA5470 LONE WORD R o NORMAL FETCH  ROM S 1 1 1 1 1 1 1 0000000000000000  00:00:00.000. 406,110
-00003080 001048  ----5470 WORD 2 0 NORMAL FETCH ROM - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000. 406,170
-00003079  tukorial(} 00104¢  01206DPZ LOKG WORD R 0 NORMAL FETCHE  ROM S 1 1 11 1 1 1 0000000000000000 00:00:00.000,406.230 -
=00003078 FEBFES 00001044 LONS WORD W 1 NORMAL STACK  RAM o) 1 1 1 1 1 1 1 0000000000000000  00:00:00.000. 406,300
-00003077 FEEFFE 00001084 LONG WORD W O  NOBMAL STACK  RAM - 1 1 1 1 1 1 1 0000000000000000  00:00:00.000, 406,360 =

Figure 5.64 Trace window

The lower pane of the window shows results of tracing from the cycle in which the function selected in the upper pane was
called.
Results in the lower pane can be displayed in disassembly, source, or a mixed mode.

CAUTION
If extraction or elimination conditions are specified, the history of function execution cannot be displayed.
If the ‘repeat fill until stop” or ‘repeat fill until full” mode is selected, the history of function execution cannot be displayed.
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5.9.17 Viewing the History of Task Execution

The history of task execution can only be displayed when you are debugging a program including a realtime OS.

Furthermore, to view the history of task execution, you need to select Task ID on the Option page of the Trace conditions
dialog box that is displayed when you choose Acquisition from the popup menu of the Trace window.

To show the history of function execution extracted from the acquired trace information, choose Show Function Execution

i3}

History from the popup menu or click on the Show Function Execution History toolbar button |l

The upper pane of the window will be opened (the pane is blank by default).
When you choose Analyze Execution History from the popup menu that is displayed when you right-click in the upper pane or

A

In the history of task execution, note that function calls from within tasks are not displayed in a tree structure. Only the order in
which the functions were executed is displayed.

click on the Analyze Execution History toolbar button [L=1], the emulator shows the history of task execution.

L=

Trace 1

ve|sazznE =54 7 laaa

- TaskID = 1 | MainTask}

i

[Ranm: 04194303, 00000000 |Fle: ‘l‘_ytle:mIMmE Address) FRESED. Time: 00:00:00,575, 441,080

Cyocle Lobel Ad 3 Dato R/W | RWT Status IMDOD | TMDZ 1] I T, us . nshl =
-04194105 F| a NOFMAL STACK = 0 1 1 1 1 1 1 1 i Malr

-04194104 a NORMAL FETCH - o 1 1 1 1 1 1 1 1 (_MainT

-04194103 460CFO0Z LONWE TIORD F i} NORMAL FETCH - 0 1 1 1 1 1 1 1 1 (_MainTask) -

-D4104102 FEESAE -—--0001 WoRD w 1 NOPMAL DATA RAM - 0 1 1 1 1 1 1 1 1 [_mMainTask) 00.575.441.270
=04194101 PEGSAE ====0001 WORD W a NORMAL  DATA RAM - 0 1 1 1 1 1 1 1 1 (_MainTask) :00.575.441.330
-04194100 0ozZop4 ADD24536 LONG WORD R 1] NORMAL FETCH ROM - 0 1 1 1 1 1 1 1 1 {_MainTask) 00:00:00.575,441.390
-04194059 oDzZpoe 0210DEDO7 LONG WORD R o HORMAL  FETCH ROM - o 1 1 1 1 1 1 1 1 (_MainTask) 00:00:00.575.441.460 ﬂ

Figure 5.65 Trace window

The lower pane of the window shows results of tracing from the cycle in which the task selected in the upper pane was called.
The lower pane of the window can show trace results in disassembly, source, or a mixed mode.

CAUTION
If extraction or elimination conditions are specified, the history of task execution cannot be displayed.
If the ‘repeat fill until stop’ or ‘repeat fill until full’ mode is selected, the history of task execution cannot be displayed.
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5.10 Measuring Performance

5.10.1 Measuring Performance

The performance measurement facility of the emulator is capable of measuring the maximum, minimum, average and total
execution times and the number of passes for each of up to eight specified sections of the user program, and shows ratios of
time relative to the overall execution time (Go—Break) as percentages and graphically.

Since this facility uses the emulator’s performance measurement circuit to measure the execution time, it does not impede
execution of the user program.

Performance measurement conditions cannot be manipulated during program execution.

5.10.2 Viewing the Results of Performance Measurement
Results of measurement are displayed in the Performance Analysis window.
To open the Performance Analysis window, choose Performance —> Performance Analysis from the View menu or

E]

click on the Performance Analysis toolbar button [==—1].
Performonce dnalzsin e 4
2% H | = H
Hnl_can.dltlnn__Run Cime (him:a.ma... C.. Staciabic  Max (him:a.m2.us. 0] |_mnih:m:s.m.ua.ns:l _avetageih:m:s.wa.ua.nsbl
1 Enable 00:00:01.254.556.150 5 253N 00:00:00.268,311.700 00:00:00,227.113.,400 00:00:00.250,911.230
? Enable 00:00:01.982.471.9680 4 715 [ 00:00:00.514.026.900 00:00:00.472.936. 250 00:00:00.485.617.970
3 Enable 00:00:01.254.556.150 5 455 00:00:00.268,311,700 00:00:00,227.113.400 00:00:00.250,911,230
i Diseble o: I
5 Dissble 0+ I
& Dissble os I
7 bisable o:
§ Dissble o5 I

Figure 5.66 Performance Analysis window

The Performance Analysis window shows the ratios of execution time per condition you have set for the most recent execution
of the program as percentages and graphically.

Any unnecessary columns in this window can be hidden.

To hide any column, right-click in the header column and select the column you want to hide from the popup menu.

To view any hidden column, reselect that column from the popup menu again.
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The contents displayed in this window are listed below.

Table 5.23 Columns and contents

Column Description
No Numbers from 1-8 that are assigned to the measurement sections set up in the Performance
Analysis Conditions dialog box.
Click Settings on the popup menu to open the Performance Analysis Conditions dialog box.
Condition The entry is “Enable” when a measurement condition is set in the Performance Analysis
Conditions dialog box.
Otherwise, the entry is “Disable”.

Run time Cumulative execution time. This is the cumulative total of measured execution times.
(h:m:s.ms.us.ns)

Count Shows the number of times measurement for the section has proceeded.

Statistic Shows the ratio of the cumulative execution time relative to the Go—Break execution time.

[Ratio calculation formula]
(Cumulative execution time / Go—Break cumulative execution time) * 100

Max (h:m:s.ms.us.ns) Maximum execution time per measurement performed
Min (h:m:s.ms.us.ns) Minimum execution time per measurement performed
Average (h:m:s.ms.us.ns) Average execution time per measurement performed

5.10.3 Setting Performance Measurement Conditions

In the Performance Analysis window, select the line of a section number to use for the condition and choose Set from the
popup menu. The Performance Analysis Conditions dialog box will be displayed.

: ~ioix
12| s | 4+ | s | e | 7| s |
Registered events..,
Cundltinn:| WEX]_[Ev]_ Bebween bwo evenks j
~Details:
Skart event:[OR]
Event [TJ Descripkions [CD... ITa... ICcumm Add... I

MEI £ (address] not 000000 .

Deleke

Enable

HAS

4 ] F _bJ Disable
~End event:[OR]
Event [TJ Descriptions [ Ce l Ta.., I Camm | Add... I

FEEEN 7 (adiress]oooo00- .. 1 -

Ci|eke
Enable

4| | Ll Disahle

EEE

Event used 2 Free 14 Debai!l...l Tirree uniks | 10ns ~

.

SAVE... | Load... [ Help | Apall Cloze

Figure 5.67 Performance Analysis Conditions dialog box
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(1) Setting measurement conditions

The measurement mode can be selected from among the four choices listed in Table 5.24. Select one measurement mode for
one section. Use events to specify the beginning and end of a section. The value of Count is fixed to 1. The event count is
always 1, even if you have attempted to specify some other value.

Table 5.24 Measurement modes

| [Disabled]

Measurement is disabled.
LBl _[Ev]_| [Between two events]

—Skart event:[OR]

Event | T.) Descriptions [ court | Taskio | cor | Add. .. I

F [Address]not 00000 1 - pelete |

Enatle |

1] | _PI Disable |
—End event:[OR]

Evenk | T.I Descripkions | Zourik | TaskID | Zon | &dd. ., I

F  [Address]o0ooo-0.., 1 - Delete

Enable

1| | _PI Disatle

Figure 5.68 Between two events

LEE

Measurement is performed between the start event and the end event.
Specifically, the time execution takes and number of passes through the range
between the start event and the end event are measured. The measurement of
time starts when the start event occurs and is suspended when the end event
occurs. The number of passes through the section is incremented by one each
time the pair of the start event and end event for the specified range occur.

Start event: One or multiple events can be set.
End event: One or multiple events can be set.

LEx] __[Ew] [ [Period of an event]

Event:
Event | T.I Descriptions | Counk: | TaskID | Zon Add...
S F [address]00001-F... 1 - Delete
| | 2~

Figure 5.69 Period of an event

Measurement is performed during the event.

Namely, the period between occurrences of the event the number of times it
occurs are measured. The time from one occurrence of the event to the next is
measured as one instance. The number of times is incremented by one each
time the event occurs.

Event: Only one event point can be set.
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Table 5.25 Measurement modes (continued)
vy [Interrupt-disabled range between two events]
—3tart event:[OR]

Event |T| Descripkions |Cu... |Ta... |Cu:umm | add.. . I
F [Address] outside 0., 1 - Delete |

Ematle |
4| | _Pl [isable I

End event:[iDR]
Event I T.I Descripkions I Ca... I Ta... I Comm |4

F  [Address] 00000 -F... 1 - Delete |
Enable |
1| | _bl Disatle |

Figure 5.70 Interrupt-disabled range between two events

Measurement is of ranges over which interrupts are disabled from the start
event to the end event.

Specifically, the intervals over which interrupts are disabled and number of
times interrupts are disabled within the range specified by Start event and
End event are measured. The measurement of time starts when interrupts are
disabled and is suspended when interrupts are re-enabled. The number of
times is incremented by one each time interrupts are disabled.

Start event: One or multiple events can be set.
End event: One or multiple events can be set.

[CAUTION]

To measure the execution time of a function (maximum, minimum or average execution time of a function), use Between two
events.

Specify fetching from the first address of the function as the start event and fetching from the exit point of the function (point
corresponding to the line containing the function’s return statement) as the end event. If there is more than one exit point, set a
fetch condition that covers each of them as the end event.

(2) Selecting the unit of measurement

This setting applies in common to all 8 sections. The following units of measurement are available:
10 ns (default), 20 ns, 40 ns, 80 ns, 160 ns, 1.6 ps
The maximum measurement time varies with the unit of measurement you set.

5.10.4 Starting Performance Measurement

When the user program is run, performance measurement is automatically started according to the conditions set on
performance measurement.

When the user program is halted, the results of measurement are displayed in the Performance Analysis window.

When execution of the user program is halted and then restarted without changing the conditions of measurement, the newly
measured times are added to the previous values.

To perform the measurements afresh, clear the results of measurement before running the program.
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5.10.5 Clearing Performance Measurement Conditions

Select the measurement condition you want to clear in the Performance Analysis window and then choose Set from the popup
menu to display the Performance Analysis Conditions dialog box. In the Performance Analysis Conditions dialog box, disable
the condition you want to clear.

1 | 2 | = 4+ | s | & | 7| 8 |
Reqistered events. .. |

T [

|—Detalls: |

Condition: (disabled)

Figure 5.71 Performance Analysis Conditions dialog box

5.10.6 Clearing Results of Performance Measurement

In the Performance Analysis window, select the section corresponding to the results you want to clear and then choose Clear
Data from the popup menu. The results of measurement for the selected section will be cleared. To clear all results of
measurement, choose Clear All Data from the popup menu.

5.10.7 Maximum Time of Performance Measurement
(1) Maximum measurement time

The timer used for performance measurement is comprised of a 40-bit counter.

The maximum measurement time varies with selected unit of measurement.

To select the unit of measurement, use the Time unit list box of the Performance Analysis Conditions dialog box.
The maximum measurable times for the respective units are listed in the table below.

Table 5.26 Maximum measurable times

Resolution Maximum measurable time
10 ns Approx. 3 hours, 03 minutes, 15 seconds
20 ns Approx. 6 hours, 06 minutes, 30 seconds
40 ns Approx. 12 hours, 13 minutes, 00 seconds
80 ns Approx. 24 hours, 26 minutes, 00 seconds
160 ns Approx. 48 hours, 52 minutes, 01 seconds
1.6 s Approx. 488 hours, 40 minutes, 18 seconds

CAUTION

Note that results of performance measurement carry an error equal to +1 times the resolution (e.g. +20 ns when the resolution
is 20 ns).

(2) Maximum measured number of passes

Numbers of passes through sections are measured by a 32-bit counter. Measuring up to 4,294,967,295 passes is thus possible.
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5.11 Measuring Code Coverage

5.11.1 Measuring Code Coverage

Code coverage refers to measures of the condition of a program in terms of ‘digestion’ by tests, i.e., the degree of thoroughness
of tests of the software code (and the paths within it).

Information on instruction execution is displayed for the C/C++ and assembly-language levels.

This function collects information on instruction execution without causing execution of the program to break. Therefore,
measuring code coverage does not affect the realtime characteristic of user-program execution.

The results of coverage are updated when a break is encountered.

The E100 emulator supports CO (instruction) coverage and C1 (branch) coverage.

Table 5.27 Code coverage definition
CO: Instruction coverage All statements within the code are executed at least once.
C1: Branch coverage All branches within the code are executed at least once.

The E100 emulator comes with up to 2 Mbytes of code-coverage memory for CO level coverage and up to 1 Mbyte of code-
coverage memory for CO + C1 level coverage.

With the initial settings, code-coverage memory is automatically allocated to addresses in the ROM and RAM areas, in that
order.

5.11.2 Opening the Code Coverage Window

Choose Code -> Code Coverage from the View menu or click on the Code Coverage toolbar button ||

The Code Coverage window is initially empty.

R20UT3587EJ0302 Rev.3.02

Page 155 of 232
Sep.01. 21 ENESAS



ROE417250MCUO00 User’s Manual

5. Debugging Functions

Code Coverage [ §|
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Figure 5.72 Code Coverage window

(1) Measurement method

The Code Coverage window has two sheets.

Table 5.28 Sheets of the Code Coverage window

Sheet Description
Address Range Measurement is performed on any address range.
Source Measurement is performed on a specified source file

The respective sheets permit registration of multiple ranges.
Up to two instances of the Code Coverage window can be open at the same time.

5.11.3 Allocating Code Coverage Memory (Hardware Resource)
(1) Memory allocation

Before code coverage can be measured, code-coverage memory must be assigned to the target address range. Coverage data

can only be obtained from an address range to which memory has been allocated.
To allocate code coverage memory, use the Allocation of Code Coverage Memory dialog box.

To open this dialog box, select [Hardware Settings...] from the popup menu of the Code Coverage window.
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Allocation of Code Coverage Memory ﬂ
Allozation of Coverage kemaony:
Address | Block | Add..
Q0000 - 1FFFF 1
EQO00Q - FFFFF 2
Clear
Al Clear
Default
Help k. Cancel

Figure 5.73 Allocation of Code Coverage Memory dialog box

When using CO level coverage and C1 level coverage, you can specify a number of blocks from 1 to 8 (for a total of up to 2
Mbytes), each beginning on a 256-Kbyte boundary, and a number of blocks from 1 to 8 blocks (for a total of up to 1 Mbyte),
each beginning on a 128-Kbyte boundary, as areas for the respective forms of code coverage measurement.

The blocks may be contiguous or non-contiguous.
With the initial settings, the coverage memory is automatically allocated to addresses in the ROM and RAM areas.
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Figure 5.74 Schematic view of coverage memory allocation
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(2) Changing memory allocation

When the allocation of coverage memory is changed, the coverage data acquired from the target address ranges prior to the
change is retrieved from coverage memory into a dedicated coverage buffer.

Buffer for
coverage

noooon

040000

07FFFF

Area where coverage can
be measured

(Z) Data acguisition

240000

—

Area where coverage can
be measured

27FFFF

Faooon

FCooon

Area where coverage can
he measured

FFFFFF

Area where coverage can
be measured

Figure 5.75 Schematic view of a change in coverage memory allocation

{1} Change in allocation

Acquired coverage information is accumulated in the coverage buffer until it is cleared by the user. However, coverage
information is not updated for areas to which coverage memory is not allocated.
The coverage information shown in the Code Coverage window includes the information from the contents of the coverage

buffer.
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5.11.4 Code Coverage in an Address Range

The Address Range sheet shows the code-coverage information (CO coverage and C1 coverage) acquired by the emulator from

a user-specified address range.
Multiple address ranges can be registered.

An address range larger than 2 Mbytes or even an area to which no coverage memory has been allocated can be specified.
However, when coverage memory has not been allocated to an area, coverage information on that area is not updated.

Avreas for which coverage information is not updated are grayed-out.
An example display is shown below.

CodeCoverage ™

o | 48w % < &M

Address Range |CEI Coverage |Cl Coverage |
DFE1BE - 0FEZ18 123l | z5: |
oFezz4 - 0PE3TE  2e:[ iy
Executed I Pasz= | Addre== [ Az=zembler I Source | H
1 = OFE1BE ENTER ... 1

1 = OFEiC1 MOV . W ...

1 - OFeEicd BOV. W ... for(i=0...

1 - OFE1C7 CHP.W:...

1 F OFE1CC TGE 200

1 - OFEICF  MOV.W:i... twp[i] ...
B OFE1DZ SEL.W ... -
MAJIIMH Range l.l';IIS«:hurl:cu ;

Figure 5.76 Code Coverage window (address specification)

The Code Coverage window is vertically divided in two by the splitter.

The upper pane shows the address ranges to be measured, and the degrees of CO coverage and C1 coverage.

Table 5.29 Contents of the upper pane of the Code Coverage window
[Address Range] Address range for which coverage is measured
[CO Coverage] CO0 coverage as a percentage and graph
[C1 Coverage] C1 coverage as a percentage and graph

The lower pane shows a detailed (assembly-language level) view of the address range selected in the upper pane.

Table 5.30 Contents of the lower pane of the Code Coverage window

[Executed] 1: The instruction was executed.
0: The instruction was not executed.

T: The condition was satisfied.
F: The condition was not satisfied.

[Pass] Condition for execution of a conditional branch instruction.

T/F: The condition was satisfied in one case and not satisfied in

another.
[Address] Address of the instruction
[Assembler] Disassembled program
[Source] C/C++ or assembly source program
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Acquired coverage information is accumulated in memory until it is cleared by the user.

When you double click on an assembler instruction in the Address Range sheet, the corresponding source code is shown in the
Editor window.

Be aware that the source code will not be displayed in the cases listed below.

- Assource file that corresponds to the assembler line does not exist.

- No source line corresponds to the assembler line.

- Where no debugging information was included, such as when the assembler line is for a library.

5.11.5 Code Coverage in a Source File

The Source sheet shows the code-coverage information (CO coverage and C1 coverage) acquired by the emulator from a user-
specified source file.

Multiple source files can be registered.

A source file larger than 2 Mbytes or even an area to which no coverage memory has been allocated can be specified.
However, when coverage memory has not been allocated for a portion of the code, coverage information on that area is not
updated.

Address lines where coverage information is not updated are grayed-out.

An example display is shown below.

=
% | 49| = W < | i iy \
File Function ICEI Coverage ICl Coverage |
IDD%_ Condition=al Br
sort.c  sort a7+ I 71+
sorkt.c change 0% 0%
Executed | Pass I Address | Assenbler I Source I ﬂ
- OFEO14 ENTEER ... {
- OFEOLY MOV.W: ... p_Sam—>...

OFEQOLGD MOV, ...
- OFEQLE MOV. ...
= OFEQLE MOV .W: ... LI

4' }I\ Address Range ,}H.Snurte {r

Figure 5.77 Code Coverage window (source file specification):

I i S =
|

The Code Coverage window is vertically divided in two by the splitter.
The upper pane shows the address ranges to be measured (file and function names), CO coverage and C1 coverage.

Table 5.31 Contents of the upper pane of the Code Coverage window

[File] File name

[Function] Function name

[CO Coverage] CO0 coverage as a percentage and graph
[C1 Coverage] C1 coverage as a percentage and graph
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The lower pane shows a detailed (assembly-language level) view of the address range selected in the upper pane.

Table 5.32 Contents of the lower pane of the Code Coverage window

[Executed] 1: The instruction was executed.
0: The instruction was not executed.
[Pass] Condition for execution of a conditional branch instruction.

T: The condition was satisfied.
F: The condition was not satisfied.
T/F: The condition was satisfied in one case and not satisfied in

another.
[Address] Address of the instruction
[Assembler] Disassembled program
[Source] C/C++ or assembly source program

The acquired coverage information is accumulated in memory until it is cleared by the user.

5.11.6 Showing Percentages and Graphs
After the program has stopped, right-click in the upper pane of the Code Coverage window and choose Percentage from the

popup menu. The emulator will start calculating CO (instruction) coverage and C1 (branch) coverage for each address range.
When the calculation is completed, coverage information is displayed in the upper pane as percentages and graphs.
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OFE102 - OFE1RC MlgY | sos G
orez24 - 0FE276 253 & 20

Figure 5.78 Code Coverage window
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5.11.7 Sorting Coverage Data
Clicking on a header column in the upper pane of the Code Coverage window allows the coverage data to be sorted.

(1) Clicking on the File column

The data can be sorted by file name. Lines for the same file are sorted by function name.

Example:

File Function

CO Coverage

filel.cpp funcl
filel.cpp func2
filel.cpp func3
filel.cpp func4
file2.cpp funcl
file2.cpp func2
file2.cpp func3
file3.cpp funcl
file3.cpp func2
file3.cpp func3

40% mmmm
10% m

80% mmmmEEEN

70% aumEEEE
20% mm

60% mummEE

90% EuEEEEEEE

0%
30% mmm
10% m

(2) Clicking on the CO Coverage column

The data can be sorted by coverage rate.
Clicking on the column once sorts the values into descending order. Clicking on the column a second time sorts the values into

ascending order.
Example:

File Function

CO0 Coverage

file2.cpp func3
filel.cpp func3
filel.cpp func4
file2.cpp func2
filel.cpp funcl
file3.cpp func2
file2.cpp funcl
filel.cpp func2
file3.cpp func3
file3.cpp funcl

90% EuEEEEEEE

80% emEEEEEE

70% eEEEEEE
60% EEmEEm
40% mumm
30% mmm
20% mm

10% m

10% m

0%
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(3) Clicking on the CO Coverage and File columns, in that order

The data for each file is sorted by coverage rate in descending order.

Example:

File Function  CO Coverage

filel.cpp func3  80% mwmmEmmmm
filel.cpp func4  70% mmmummm

filel.cpp funcl  40% mmmm
filel.cpp func2 10% m

file2.cpp func3  90% EmEEEEEEE

file2.cpp func2  60% Emmmmm

file2.cpp funcl  20% mm
file3.cpp func2  30% mmm
file3.cpp func3  10% m
file3.cpp funcl 0%

5.11.8 Searching for Nonexecuted Lines

Search for nonexecuted lines in a selected address range or function. When you click on the Find toolbar button [l

Find dialog box shown below appears.

x|

FindWhat: |Unexecuted Line

Brarch [T]
Branch [F) L2

[ Find

Figure 5.79 Find dialog box

The following three search options are available.

Table 5.33 Search options

Unexecuted Line Instructions not executed yet
Branch (T) Branch instructions with condition that is always TRUE when tested
Branch (F) Branch instructions with condition that is always FALSE when tested

5

Clicking on the Find Next button [l

] starts a search.

When a matching instruction is found, the corresponding line is highlighted.
When no matching instructions are found, a message is displayed.

.

], the
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5.11.9 Clearing Code Coverage Information
(1) Clearing the code coverage information for a specified range

Selecting Clear Coverage Range from the popup menu opens the Clear Address Range dialog box.

Clear Address Range ilil

Start Address: IEIEIEEI?E j
End Address: [DDCTTE =] Cancel |

Figure 5.80 Clear Address Range dialog box

Enter the addresses where the range to be cleared starts and ends. Clicking on the OK button then clears the coverage
information for the selected range.

(2) Clearing all of the code coverage information

Selecting Clear the Entire Coverage from the popup menu clears all of the code coverage information.

5.11.10 Updating Coverage Information

Selecting Refresh from the popup menu updates the contents of the Code Coverage window.

If Lock Refresh has been selected, the information is not automatically updated when program execution breaks. To view the
latest information, therefore, you must manually select updating.

5.11.11 Preventing Updates to Coverage Information
Selecting Lock Refresh from the popup menu prevents updates to the Code Coverage window while the execution of the user
program is stopped.
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5.11.12 Saving the Code Coverage Information in a File
You can save the code coverage information for the currently selected sheet in a file.
Selecting Save Data from the popup menu opens the Save Coverage Data dialog box.

werage Data - Address Ranges llﬁl
File: name: ]

I Ll Browse, .. | Cancel |

¥ Always save to this file when saving the session

Figure 5.81 Save Coverage Data dialog box

Enter the name of the file where you want the information to be saved.
If the file-name extension is omitted, “.cov” will automatically be appended as the extension.
If you specify an existing file name, that file will be overwritten.

5.11.13 Loading Code Coverage Information from a File
You can load code-coverage information files.
Selecting Load Data from the popup menu opens the Load Coverage Data dialog box.

Load Coverage Data

Load Mods | File Mame | Diffzet | o

X

Bemowe

fowe

i !

td mwee o

[T Clear coverage RAM before loading

[ &lways load these files when loading the seszion

k. Cancel |

Figure 5.82 Load Coverage Data dialog box
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Clicking on the Add button opens the Add Coverage Files dialog box shown below.

Add Coverage Files _?IEI
File: M ame:
I 3 | Browse,.. |
Offzet;
| 0000000
Coverage Data Load Mode
’7('3' Dvenurite " Merge

oK LCancel |

Figure 5.83 Add Coverage Files dialog box

Use this dialog box to specify the coverage information file you want to load. You can also specify a mode of loading and
offset for each file you load.

The only file-name extension allowed is “.cov”. An error message will appear if any other extension is entered.
The files you add will be listed in the Load Coverage Data dialog box. The files will be loaded in the order in which they are
listed. If necessary, use the Move Up or Move Down button to change the order.

CAUTION
If the coverage information file you’re loading is of the source-file type, you cannot specify an offset.

5.11.14 Modes of Loading for Coverage Information Files
Two modes of loading are available for coverage information files. They are schematically depicted below.

(1) When “Overwrite” has been selected

COvVErage Memory
[Before loading]  [After loading)

Coverage file

O 2000 O 2000 O 2000
-] The coverage memory is overnritten with
1] the data of the loaded coverage file.
Ox2FFF Ox2FFF Ox2FFF

Figure 5.84 Schematic view of the overwrite mode
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(2) When “Merge” has been selected

Coverage memory
[Before loading]  [After loading]

Coverage file
0x2000 0x2000—1 0x2000— (1) Existing data is read.
(1]' """"" (21 The data ofthe coverage file is
." merged with the existing data.
0x2FFF 0x2FFF 0x2FFF
: : : {3 The rmerged data is written to
the coverage memaory.
(2

Figure 5.85 Schematic view of the merge mode

(3) Example of application of the merge mode

COVEFRGE MEmary

Test & TestB Test © (after loading in the merge mode)
COVEraQe  COVEraQge  COVErage
file: file: file
guneeeee [Example]
I A A= the result of test
DT A B, and C, the CO
coverage iz 79%.

Figure 5.86 Schematic view of a merge-mode application

[Procedure]

(1) Open the Load Coverage Data dialog box.
To begin with, select the “Clear coverage RAM before loading” checkbox.
(2) In the merge mode, add the coverage file for test A.
(3) In the merge mode, add the coverage file for test B.
(4) In the merge mode, add the coverage file for test C.
(5) Click on the OK button.

You have now finished merging three files.

By re-calculating the percentages in the Code Coverage window, you can view the coverage (as percentages) of the tests as a
whole.

Furthermore, you can save the merged data in a single file and manage the data accordingly.
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5.11.15 Displaying Code Coverage Information in the Editor Window

When the Editor window is open in the source mode, the results of coverage are displayed in the Code Coverage column.
Rows of the Code Coverage column that correspond to source lines where the instructions have been executed are highlighted.
If the user changes any setting related to coverage information in the Code Coverage window, the contents of the
corresponding Code Coverage column will also be updated.

R ——— =101
Elll=

Ling Source.. E.! C.J 5. Sowce |

30 |00Zas0 wold Sample::sorct (long Ta) j
=k | [
aa long t:

33 int i, 3. k., gap:
3%
35 |00DZ0S5C gap = 5;

36 002080 while{ gap > 0 )|

A7 |DDE0SE6 for| k=0; k<gap:; k++){

38 |DOEOEE for i i=k+gap: i<10: i=i+gap |4
39 |(D0ZOTA for [j=i-gap: 1>=k: j=i-gap]{
40 |0Dz0s4 g_IncBuf = j:

41 |0D20BA if(a[3]=alj+gap] )i

4z |O0ZO0AE -+ £ = afi]l:
43 |DDZOEC ali]l = alj+aap]:

44 |pozapc a[j+gap] = r:
45 ;

45 elms

47 break:

45 b

aq 3

=0 ¥

51 |00z106 gap = gapil:

53 H

53 DD2iils g CharBuf = (char)g IncBuf § 0X00FF:

sS4 |oozizz i B - -

1 | Ll
Figure 5.87 Example of code coverage results
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5.12 Measuring Data Coverage

5.12.1 Measuring Data Coverage

The code coverage, data coverage and realtime profiling functions of the E100 emulator are mutually exclusive.

To use the data coverage function, choose Data coverage in the Switching function section on the System page of the
Configuration properties dialog box.

Data coverage indicates the kinds of access to data areas. The emulator is capable of acquiring information on access per byte
without causing program execution to break. Therefore, the realtime characteristic of user-program execution will not be
affected.

The coverage results are updated upon a break.

The E100 emulator comes with 512 Kbytes of data coverage memory.
With the initial settings, the data coverage memory is automatically allocated to addresses in the ROM and RAM areas, in that

order.

5.12.2 Opening the Data Coverage Window

Choose Code -> Data Coverage from the View menu or click on the Data Coverage toolbar button |l

The Data Coverage window is initially empty.

DataCoverage 1
% | W |t X \
Fange I Access Rate |

Address | Lakhel I Area I Data

MAddress Range ;{. Section h Tazh Stack: f

Figure 5.88 Data Coverage window
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(1) Measurement method

The Data Coverage window has three sheets.

Table 5.34 Sheets of the Data Coverage window

Sheet Description
Address Range Measurement is performed on any address range.
Section Measurement is performed on a specified section.
Task Stack Measurement is performed for all task stack areas.

The respective sheets permit multiple ranges to be registered.
The Task Stack sheet only supports automatic registration.

Up to three instances of the Data Coverage window can be opened at the same time.

5.12.3 Allocating Data Coverage Memory (Hardware Resource)
(1) Memory allocation

Before data coverage can be measured, data-coverage memory must be assigned to the target address range. Coverage data can

only be obtained from an address range to which memory has been allocated.

To allocate data coverage memory, use the Allocation of Data Coverage Memory dialog box. To open this dialog box, select

[Hardware Settings...] from the popup menu of the Data Coverage window.

Allacation of Data Coverage Memars: ﬂ

Allozation of Coverage kemaony:

Address | Bl & Add.. |
00000 - OFFFF
10000 - 1FFFF
20000 - 8FFFF
30000 - 3FFFF
&0000 - AFFFF
BOO0O - BFFFF
CO00a - CFFFF

:
2
5
4
5
b
7
D?IZIIIIEI - DFFFF jLI
P | b Default

Help | k. | Cancel

Al Clear

Figure 5.89 Allocation of Data Coverage Memory dialog box

You can specify any number of blocks from 1 to 8 (for a total of up to 512 Kbhytes), each beginning on a 64-Kbyte boundary,

as areas for data-coverage measurement.
The blocks may be contiguous or non-contiguous.

With the initial settings, the coverage memory is automatically allocated to addresses in the ROM and RAM areas.
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nanaoon

naann

01FFFF

Area where coverage can
be measured

240000

24FFFF

fArea where coverage can
bhe measured

FEDOON

FFOOON

Area where coverage can
be measured

FFFFFF

Area where coverage can
he measured

Figure 5.90 Schematic view of data coverage memory allocation

(2) Changing memory allocation

When the allocation of coverage memory is changed, the coverage data acquired from the target address ranges prior to the
change is retrieved from coverage memory into a dedicated coverage buffer.

Buffer for
cOverage

nonnon

o000

01FFFF

Area where coverage can
be measured

(2) Data acquisition

240000

—

Area where coverage can
bhe measured

24FFFF

FEOOOD

Area where coverage can
bhe measured

FFOnoo

FFFFFF

Area where coverage can
bhe measured

(1) Change in allocation

Figure 5.91 Schematic view of a change in data coverage memory allocation

Acquired coverage information is accumulated in the coverage buffer until it is cleared by the user. However, coverage
information is not updated for areas to which coverage memory is not allocated.
The coverage information shown in the Data Coverage window includes the information from the contents of the coverage

buffer.
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5.12.4 Data Coverage in an Address Range
The E100 emulator is capable of collecting the access information for a user-specified address range and of displaying the
information.

s
% | 42 [ | =f %t X |
Range |Access Rate I
0005c0 - 000c&AZ 0%

Address I Label | Area | Lata il
oooscao BAM e? f8 1b 03
ooosc4 RAM dee 6f ac 24
oonsca FAM 23 di hd ge
oooscc BAM c? b9 dl 02
ooosoao BAM 09 b7 do 20 ;I
Mﬁddress Range lf{. Section }-.. Tazh Stack j‘

Figure 5.92 Data Coverage window (address specification)

The Data Coverage window is vertically divided in two by the splitter.
The upper pane shows the address ranges to be measured and access rates.

Table 5.35 Contents of the upper pane of the Data Coverage window
[Range] Address range for which coverage is measured
[Access Rate] Access rate as a percentage and graph

The lower pane shows a detailed view of the address range selected in the upper pane.

Table 5.36 Contents of the lower pane of the Data Coverage window

[Address] Address value

[Label] Label name

[Area] Memory area (flash ROM, RAM, or SFR).
This column is blank when the area is unused.

[Data] Memory data.
Data that have been accessed are displayed against a purple
background.

Lines for addresses beyond the area to which coverage memory has been allocated are grayed-out. Although any existing
coverage information for such addresses is retained, the coverage information will not be updated by program execution.
Acquired coverage information is accumulated in memory until it is cleared by the user.
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5.12.5 Data Coverage in Sections
The E100 emulator is capable of collecting the access information for a user-specified section and of displaying the
information.

|
% | 42 [ | =f %t X |
Jection IA::::ESS REate |
ooo41c - 00071E (stack) 13%.

0oo71c - 000A1ER [istack) 0%

0%

Address | Lakbel | Ares | Datsa ;I
Oo0eAR RAM dd ff de 9b

OO0BAC RAM B0 k7 95 Qe

OO0eEO RAM a’l

OO0eE4 RAM =
Do0eER RAM ;I
L I FI'-. &ddress Range hSectinn ;{. Tazh Stack j‘

Figure 5.93 Data Coverage window (section name specification)

The Data Coverage window is vertically divided in two by the splitter.
The upper pane shows the address ranges (section names) to be measured and access rates.

Table 5.37 Contents of the upper pane of the Data Coverage window
[Section] Address range (section) for which coverage is measured
[Access Rate] Access rate as a percentage and graph

The lower pane shows a detailed view of the address range selected in the upper pane.

Table 5.38 Contents of the lower pane of the Data Coverage window

[Address] Address value

[Label] Label name

[Area] Memory area (flash ROM, RAM, or SFR).
This column is blank when the area is unused.

[Data] Memory data.
Data that have been accessed are displayed against a purple
background.

Lines for addresses beyond the area to which coverage memory has been allocated are grayed-out. Although any existing
coverage information for such addresses is retained, the coverage information will not be updated by program execution.
Acquired coverage information is accumulated in memory until it is cleared by the user.
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5.12.6 Data Coverage in the Task Stack

The E100 emulator is capable of collecting the access information for the task stacks and of displaying the information.
The task stack is automatically registered when a load module that includes an OS has been downloaded.

You cannot add, remove or change any task.

If tasks are changed pursuant to alterations of the user program, for example, the window is automatically updated.

£l
% | 5@ | =% X \
Tazsk |Acce33 Rate |:|
O00EOC - OOO0EGEF [TaskID=11, Entry= task011) 0%
IZI O0AZ 4 O00ASY (TaskID=1, Entry= main) 40%

001000 - 001063 (TaskID=16, Entry=_ task016) 0%

000F9C - OOOFFF (TaskID=15, Entry= taskO15) 0% |
O00AEC - O00E4F [TaskID=3, Entry= task003) 0% ;I
Address | Lakel |Area | Data I ;I
oooadn RAM

r

Cooad4 RAM

oooa4a RAM

cooxgc RAM ald 8b 9a al

i

L I FI'-. &ddress Range }1. Section }-..Task Stack {r

Figure 5.94 Data Coverage window (task stack specification)

The Data Coverage window is vertically divided in two by the splitter.
The upper pane shows the automatically registered task stacks and access rates.

Table 5.39 Contents of the upper pane of the Data Coverage window
[Task] Task stack (task ID and task entry label)
[Access Rate] Access rate as a percentage and graph

The lower pane shows a detailed view of the task stack selected in the upper pane.

Table 5.40 Contents of the lower pane of the Data Coverage window

[Address] Address value
[Label] Label name
[Area] Memory area (flash ROM, RAM, or SFR).
This column is blank when the area is unused.
[Data] Memory data.
Data that have been accessed are displayed against a purple
background.
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Lines for addresses beyond the area to which coverage memory has been allocated are grayed-out. Although any existing
coverage information for such addresses is retained, the coverage information will not be updated by program execution.
Acquired coverage information is accumulated in memory until it is cleared by the user.

5.12.7 Clearing Data Coverage Information
(1) Clearing the data coverage information for a specified range

Selecting Clear Coverage Range from the popup menu on the Address Range or Section sheet opens the Clear Coverage Range
dialog box.

2
Start Addrezs; IDDDE24 j
End &ddress: IE":” 287 j Carcel |

Figure 5.95 Clear Coverage Range dialog box

Enter the addresses where the range to be cleared starts and ends. Clicking on the OK button then clears the coverage
information for the selected range.

(2) Clearing all of the data coverage information

Selecting Clear the Entire Coverage from the popup menu clears all of the data coverage information.

5.12.8 Updating Coverage Information

Selecting Refresh from the popup menu updates the content of the Data Coverage window.

If Lock Refresh has been selected, the information is not automatically updated when program execution breaks. To view the
latest information, therefore, you must manually select updating.

5.12.9 Preventing Updates to Coverage Information
Selecting Lock Refresh from the popup menu prevents updates to the Data Coverage window while the execution of the user
program is stopped.
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5.12.10 Saving the Data Coverage Information in a File

You can save the data coverage information for the currently selected sheet in a file.

Selecting Save Data from the popup menu opens the Save Data dialog box.

Save Data - Seckions 7] x|

OF.

File M ame:

I Ll Emwse...l Cancel |

¥ Always save to this file when saving the session

Figure 5.96 Save Data dialog box

Enter the name of the file where you want the information to be saved. If the file-name extension is omitted, “.cdv” will

automatically be appended as the extension. If you specify an existing file name, that file is overwritten.

5.12.11 Loading Data Coverage Information from a File
You can load coverage information files.

Selecting Load Data from the popup menu opens the Load Coverage Data dialog box.

2

[T Clear coverage FAM befare loading

(] Cancel |

Load Mode | File Name | Offset | Add..
Overwrite  ${CONFIGDIR] 000000000
Merge $w/DRKSPNAME] 000000000
Merge ${CONFIGNAME] 000000000 Remove
Move Up
Move Down

Figure 5.97 Load Coverage Data dialog box
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Clicking on the Add button opens the Add coverage data file dialog box shown below.

21x]
File Marme;
I | 2 | Browsze. .. |
Offzet:
|nxunnnun
Coverage Data Load Mode
’Vﬁ' Owenwrite = Merge
oK _ Caneel |

Figure 5.98 Add coverage data file dialog box

Use this dialog box to specify the coverage information file you want to load. You can also specify a mode of loading and
offset for each file you load.

The only file-name extension allowed is ".cdv". An error message will appear if any other extension is entered.

The files you add will be listed in the Load Coverage Data dialog box. The files will be loaded in the order in which they are
listed. If necessary, use the Move Up or Move Down button to change the order.
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5.13 Viewing Realtime Profile Information

5.13.1 Viewing Realtime Profile Information

The code coverage, data coverage and realtime profiling functions of the E100 emulator are mutually exclusive.

To use the realtime profiling function, choose Real-time profile in the Switching function section on the System page of the
Configuration properties dialog box.

Realtime profiling refers to the measurement of performance per function or task within an area allocated as a range for
profiling. Realtime profiling will help you find where and how deterioration in the performance of application programs arises.
The process of measurement does not interfere with execution of the user program.

The results of measurement are updated when execution of the program breaks.

(1) Function profiles

Performance of individual functions can be measured.

For a function, the Realtime Profile window shows its name, the address where it starts, its size, the number of calls,
cumulative execution time, the ratio of this to the overall execution time, and the average execution time.

In function profiling by the E100 emulator, execution times for subroutines are not included in the indicated cumulative
execution time.

CAUTION
A function profile is subject to the following limitations:

(a) Areas to be measured

The E100 emulator can acquire profile information on all functions in up to 8 blocks, with each block a 128-Kbyte unit.

The blocks can be contiguous or non-contiguous.

Functions located beyond the boundaries of the blocks are not specifiable. In such cases, the entries for the functions (or tasks)
are grayed-out.

(b) Limit on the number of functions

Measurement of up to 8K — 1 (= 8,191) functions is possible.

A limit of 8K — 1 (= 8,191) applies to the number of functions within the above scope of measurement. Measurement will not
be performed for the functions beyond this limit. In such cases, the names, addresses, and sizes of the excess functions are
grayed-out.

(c) In-line expansion

The functions that have been written for in-line expansion (optimization by the compiler) are not displayed in the Realtime
Profile window.

(d) Recursive functions

Although the execution times of recursive functions can be measured correctly, they are only executed once.
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(e) Relationship between the address where Go was executed and the address of a break within a measurement range, and the
measurable range

fi Execution starts from function g
gl
/-n{}{
ki
gl l;
hid;
kid;
1 1 1 1

Range that can be measured

Figure 5.99 Measurable range

The measurable range will be as follows.

When execution of the program breaks at the location of a black dot [e]: Execution time and number of passes for functions h
and k

When execution of the program breaks at the location of a red dot [e]: Execution time and number of passes for functions h
and k

When execution of the program breaks at the location of a blue dot [e]: Execution time and number of passes for functions h
and k

For the function g, the number of passes and time for the executed portion can be measured.

Even after execution has returned to a function higher in the hierarchy of calls, the number of calls cannot be measured for a
function from which execution of the program started.

() Function measurement
Accurate measurement requires that execution of the function remained in progress for at least 100 ns. If this is not the case,
the execution time and number of passes may be incorrect.

(9) Debugging information option

To get the execution time and number of passes for a function, you need to specify the option to output debugging information
for the source file or library that includes the function at the time of compilation. If this option has not been specified,
measurement of the execution time and number of passes for a function will not be possible.

(h) Maximum and minimum execution time
You cannot use the realtime profiling function to measure the maximum and minimum execution times for a function. To
measure the maximum and minimum execution times for a function, use the Performance Analysis window.
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(2) Task profile

Performance of individual tasks can be measured.
For a task, the Realtime Profile window shows its ID, the number of passes, cumulative execution time, the ratio of this to the
overall execution time, and the average execution time.

5.13.2 Selecting a Realtime Profile Measurement Mode

Choose Set Range from the popup menu that is displayed when you right-click in the window.

The Realtime Profile Setting dialog box will be displayed. In the Realtime Profile Mode list box of this dialog box, you can
select “Function Profile” or “Task Profile.”

When the profile mode is changed, all results of measurement are cleared.
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5.13.3 Measuring Function Profiles
The Function Profile mode allows measurement of performance per function.

£l
% H e E A \
Block I Function | Address I Size I Count I Titne | Statistic Average |;|
2 __intl OF20E6 3 0 00:00:00.000.000.000 0% 00:00:00.000.000.000

Z __int2 OF30BC 3 0 00:00:00.000.000.000 0% 00:00:00.000.000.000

Z _init OFB0CZ 237 5453 00:00:00.336.606.500 2| O0:00:00.000.061.720

2 fsort OF&1E0 188 5640 00:00:04.4Z7.290.020 sox 00:00:00.000.734.9380

Z $change OF3Z6eC 9z 5454 00:00:01.140.093.630 123 00:00:00.000.209.030

Z _main OFBZcs 10 8120 00:00:00.018.021.330 0% 00:00:00.000.002 210

2 _tutorial OF82Da 340 6418 00:00:01.039.811.7380 113 00:00:00.000.162.010

Z _abort OF34ze 1 0 00:00:00.000.000.000 0% 00:00:00.000.000.000

Z _initset OFE980 z09 0 00:00:00.000.017.400 0% 00:00:00.000.000.000

2 _start OF&a52 a7 0 00:00:00.001.103.310 0% 00:00:00.000.000.000

Z _exit OF3AAL 3 0 00:00:00.000.000.000 0% 00:00:00.000.000.000 &

Figure 5.100 Realtime Profile window (function profile)

The information in each of the columns is described in the table below.

Table 5.41 Details on each column

Block Block number

Function Function name

Address Address where the function starts

Size Function size

Count Number of times the function has been called
Time Cumulative time of function execution

The timestamp is in the form shown below.
Hours:minutes:seconds.milliseconds.microseconds.nanoseconds
Statistic Ratio of the time for the given function to Go-Break time
Average Average of the execution times for individual passes

If a function is outside the areas to which profile memory is allocated, the address line is grayed-out.
Acquired results of profile measurement are accumulated in memory until the user clears them.
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5.13.4 Setting Ranges for Function Profile Measurement
Choose Set Range from the popup menu that is displayed when you right-click in the window.
The Realtime Profile Setting dialog box will be displayed. Set a profile measurement range in this dialog box.

[Function profile mode]

Realtime Profile Setting x|
Realtime Frofile Mode: [ RNl
— List
Allocation of Profile kemony: Add..
Addresz | Block |
Clear
00000 - 1FFFF 1
EQO00 - FFFFF 2 Al Clear
Default
Save... Load... Help ] Carnicel

Figure 5.101 Realtime Profile Setting dialog box

(1) Memory allocation

Before function profiles can be measured, profile memory must be allocated to the addresses at which measurement will be
performed. Profile data can only be obtained from address ranges to which memory has been allocated.

You can specify any number of blocks 1 to 8 (for a total of up to 1 Mbyte), each beginning on a 128-Kbyte boundary, as areas
for profile measurement.

The blocks may be contiguous or non-contiguous.

With the initial settings, the profile memory is automatically allocated to addresses in the ROM and RAM areas.

(2) Automatic detection of functions

When profile memory is assigned to an address range, the E100 emulator automatically detects functions within that range and
adds them to the window.
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5.13.5 Saving Function Profile Measurement Settings

You can save the current profile mode and measurement ranges (memory allocation) for function profiles.

Click on the Save button of the Realtime Profile Setting dialog box, and the Save As dialog box will be displayed.

Enter the name of the file where you want the function profile measurement settings to be saved.

If the file-name extension is omitted, “.rpf” will automatically be appended as the extension.

If you specify an existing file name, a message is displayed asking you to confirm whether you want the file to be overwritten.

5.13.6 Loading Function Profile Measurement Settings
You can load function profile measurement settings.
Click on the Load button of the Realtime Profile Setting dialog box, and the Open dialog box will be displayed.

Laoak jr: IaDebu j - I'j{ ER-

Savelatal0z rpf

File name:; |SaveDataElElEl.rpf Open I
Filez aof bype: IFEeaIF'n:ufiIe Files [*.rpf] j Cancel |

Figure 5.102 Open dialog box

v

Enter the name of the file you want to load.

Only files bearing the extension “.rpf” can be loaded. If you enter any other file-name extension, an error message will be
output.

When loading of the file is complete, the list in the Realtime Profile Setting dialog box is updated.

If the information in the loaded file is for a task profile, the profile mode in the Realtime Profile Setting dialog box is switched
to task mode.
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5.13.7 Measuring Task Profiles

The Task Profile mode allows measurement of performance per task.

Realtime Profile 1 =
% B F | # A |
Block | Task ID | count | Time | statistic | average |£|
1 0 (M3T-MR3I0S4 or Tdle) 1 00:00:00,577.565.000  1:3) O0:00:00.577.565.020
1 1 { main) 1 00:00:00.084.801.850 2% | 00:00:00.084.891.850
1 2 (_taski) 3% 00:00:00.972.308.480 z& s 00:00:00.025.587.060
1 3 [_tmaki) 5 00:00:00.541.265.250 154 00:00:00.021.650.610

=

Figure 5.103 Realtime Profile window (task profile)

The information in each of the columns is described in the table below.

Table 5.42 Details on each column

Block Block number

Task ID Task 1D, entry address

Count Number of times the task has been called
Time Cumulative time of task execution

The timestamp is in the form shown below.
Hours:minutes:seconds.milliseconds.microseconds.nanoseconds

Statistic Ratio of the time for the given function to Go-Break time

Average Average of the execution times for individual passes

Disabled tasks are grayed-out.
Acquired results of profile measurement are accumulated in memory until the user clears them.
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5.13.8 Setting Ranges for Task Profile Measurement
Choose Set Range from the popup menu that is displayed when you right-click in the window.
The Realtime Profile Setting dialog box will be displayed. Set a profile measurement range in this dialog box.

[Task profile mode]

Realtime Profile Setting

Bealtime Frofile Mode: ITask Profile

— Lizt
T azk, List:
Taszk D | Entry Addrezs | Block, il
1 _main 1 J
2 _tazk 002 1
3 _tazk003 1
4 _task004 1
a _task005 1
B _taskDOG 1 Enable All Task |
vl 7 tazk D07 1 b
y I Disable & Task |
Save... | Load... | Help | ] Carnicel

Figure 5.104 Realtime Profile Setting dialog box

(1) Automatic detection of tasks

If you have downloaded a load module that includes an OS, the E100 emulator automatically detects the tasks.

(2) Selecting tasks

Select the checkboxes next to the IDs of tasks you want to measure (by default, all checkboxes are selected).
The selected tasks will automatically be assigned block numbers (1-8).

CAUTION

When the eight blocks have been used up, the block number column for further tasks will be blank, indicating that
measurement for tasks with these I1Ds is not possible. In such cases, deselect checkboxes against the IDs of tasks for which

performance measurement is not necessary.
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5.13.9 Saving Task Profile Measurement Settings

You can save the current settings regarding tasks for measurement (task 1Ds and enabled/disabled states) in task mode.

Click on the Save button of the Realtime Profile Setting dialog box, and the Save As dialog box will be displayed.

Enter the name of the file where you want the task profile measurement settings to be saved.

If the file-name extension is omitted, “.rpf” will automatically be appended as the extension.

If you specify an existing file name, a message is displayed asking you to confirm whether you want the file to be overwritten.

5.13.10 Loading Task Profile Measurement Settings
You can load task profile measurement settings.
Click on the Load button of the Realtime Profile Setting dialog box, and the Open dialog box will be displayed.

2]

Laoak jr: IaDebu j - I'j{ ER-

Savelatal0z rpf

File name:; |SaveDataElElEl.rpf Open I
Filez aof bype: IFEeaIF'n:ufiIe Files [*.rpf] j Cancel |

Figure 5.105 Open dialog box

v

Enter the name of the file you want to load.

Only files bearing the extension “.rpf” can be loaded. If you enter any other file-name extension, an error message will be
output.

When loading of the file is complete, the list (of tasks) in the Realtime Profile Setting dialog box is updated.

Even if a loaded task ID does not currently exist, it will be temporarily displayed in the list of tasks in the Realtime Profile
Setting dialog box. However, only tasks with the existing 1Ds will actually be registered when you click on the OK button.
You can re-open the Realtime Profile Setting dialog box to check the currently registered tasks.

If the information in the loaded file is for a function profile, the profile mode in the Realtime Profile Setting dialog box is
switched to function mode.
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5.13.11 Clearing Results of Realtime Profile Measurement
Choose Clear from the popup menu of the Realtime Profile window, and all results of measurement are cleared.
Unless this is done, measurement results are accumulated in memory.

5.13.12 Saving Results of Realtime Profile Measurement
You can save the current results of realtime profile measurement as text.
Choose Save To File from the popup menu of the Realtime Profile window, and the Save As dialog box will be displayed.

Enter the name of the file where you want the results of measurement to be saved.
If the file-name extension is omitted, “.txt” will automatically be appended as the extension.
If you specify an existing file name, a message is displayed asking you to confirm whether you want the file to be overwritten.

5.13.13 Setting the Unit of Measurement
Choose Properties from the popup menu that is displayed when you right-click in the window.
The Properties dialog box will be displayed.

x

b eazurement mntereal |

Measurement interval: I_ vI

0K | Cancel |

Figure 5.106 Properties dialog box

The unit of measurement can be selected from the following options:
10 ns, 20 ns, 40 ns, 80 ns, 160 ns, 1.6 ps

CAUTION
When the current selection is changed, the measurement results hitherto accumulated are cleared.
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5.13.14 Maximum Measurement Time for Realtime Profiles
(1) Maximum measurement time

The timer used for realtime profile measurement is configured with a 40-bit counter. The maximum measurement time varies
with the selected unit of measurement.

Select the unit of measurement from the Measurement interval drop-down list of the Properties dialog box.

The maximum measurable times for the respective units are listed below.

Table 5.43 Maximum measurable times

Resolution Maximum measurable time
10 ns Approx. 3 hours, 03 minutes, 15 seconds
20 ns Approx. 6 hours, 06 minutes, 30 seconds
40 ns Approx. 12 hours, 13 minutes, 00 seconds
80 ns Approx. 24 hours, 26 minutes, 00 seconds
160 ns Approx. 48 hours, 52 minutes, 01 seconds
1.6 ps Approx. 488 hours, 40 minutes, 18 seconds
CAUTION

Note that results of performance measurement carry an error equal to +(twice the resolution + 100ns), e.g. £140 ns when the
resolution is 20 ns, each time a function is entered. If the resolution is 20 ns and a function is entered 10 times, the error is
+1400 ns.

(2) Maximum measured number of calls
For a realtime profile, a 16-bit counter measures the number of times a task or function is executed. Measurement of up to
65,535 calls is thus possible.
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5.14  Detecting Exceptional Events

5.14.1 Detecting Exceptional Events
The E100 emulator permits you to detect the occurrence of various exceptional events during user program execution.
Exceptional events include abnormal behavior of the user program, as well as an overflow of the measurement counter for

break, trace, or performance analysis. Detection of a specific exceptional event can be set as a condition of a breakpoint or
trace point.

(1) Exceptional events

The E100 emulator detects the exceptional events listed below.

- Violation of access protection: An error is detected when access in violation of a specified access attribute is attempted.

- Reading from non-initialized memory: An error is detected when a non-initialized area (not written) is read.

- Stack access violation: An error is detected when the value of the stack register is beyond a boundary of the stack area.

- Performance-measurement overflow: An error is detected when the time measurement counter for a section has overflowed.

- Realtime profile overflow: An error is detected when the maximum measurable time or maximum measurable number of
passes is exceeded during profile measurement of a function (or a task).

- Trace memory overflow: An error is detected when the trace memory has overflowed.

- Task stack access violation: An error is detected when one task attempts writing to the task stack of another task.

- OS dispatch: An error is detected if a task dispatch has occurred.

5.14.2 Detecting Violations of Access Protection
Violations of access protection such as writing to a ROM area or access to an unused area (for reading, writing, or execution of
an instruction) can be detected as an error.

(1) Access attributes

The following attributes are specifiable in word units for any area.

Read/Write: Accessible for both reading and writing

Read Only: Only accessible for reading

Write Only: Only accessible for writing

Disable: Access prohibited

Disable (OS): Access other than from the OS is prohibited (this attribute is automatically assigned when a program that
includes an OS is downloaded).

(2) Protected areas

Any area in the entire memory space can be protected.
At the time the emulator is booted up, all areas are assigned the Read/Write attribute by default.
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(3) Methods of setting protection

There are the following two methods:

- Automatic setting by section information in a downloaded module
- Individually specifying an access attribute for an area

(4) Method of detection
Violation of access protection is detected by internal resources (blocks 1-16) of the emulator.

The blocks are automatically allocated by an original algorithm of the emulator.

CAUTION
Since the emulator’s internal resources are limited, not all blocks can be protected. If an error occurs, reduce the number of
assigned blocks by using the ‘Delete’ button before setting protection again.

Access attribute

Read/Write
Write -> Read Only -> Violation detected
Read -> Write Only -> Violation detected
Read -> Disable -> Violation detected
Write

Figure 5.107 Patterns for detecting violation

(5) Action taken when violation of access protection is detected

The following actions are selectable.

- Display a warning.

After the Violation of access protection checkbox has been selected on the Exception Warning page of the Configuration
properties dialog box, you will see a warning in the Status window and in a status bar balloon when errors of this type occur.

- Make the detection of violation of access protection a condition of a hardware breakpoint.
- Make the detection of violation of access protection a condition of a trace point.
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5.14.3 Setting Protection for an Area
Follow the procedure below to set protection for an area.

(1) From the Hardware Break dialog box

1. Select the Exception checkbox on the Hardware Break sheet and then click on the Detail button.
N HordwareBreak* (ol x|
Hardhware Brieak IQ,R i Extephian |

congition and comiination setbong
¥ OR condtion:

Eventinuse: 0 Dekal

1 Other condtions: ———

AR ACTOmLERinn ) ¥

Event inuge : 0 DEE

7 Evcecitian: = Tokal: 0 Event
i~ Delay{opdel ——
Exceptional
il ! 1/ —
|
Event used 0 Freeld Dnbui.l Regishered maanks...
Save... | Losd... ke | pply [ cese |

-

Figure 5.108 Hardware Break dialog box

2. The Exception page shown below will appear. Click the Detail button to the right of the Violation of access protection
checkbox.

[N Hardware Break *

Hardware Bresk | 0R  Excention |

[ wiolation of access protecton Diekai...
[ Read fram a unintislized mameey
[ Stack access violation Detal...

[ Performanca overflow
[™" Realtime profik ovesflos

[ Trace memary awerflav

[T Task stack access vinlation Datal,, I
[ o5 dspatch

Evert used 0 Freets Deai...| Regisbered svanks...
save... | Lesd.. ke | aony [ ces |

-

Figure 5.109 Hardware Break dialog box

R20UT3587EJ0302 Rev.3.02 Page 191 of 232
Sep.01. 21 ENESAS



ROE417250MCUO00 User’s Manual 5. Debugging Functions

3. The Violation of access protection dialog box shown below will be displayed.
To have the access attributes automatically set according to the section information in the downloaded module when a
program is downloaded, select the checkbox labeled “Automatically set address areas at downloading.”

Yiolation of access protection X|

v automatically set address areas at downloading

Addrezs Areas:

Block Mo | Label | Start Addrezz - End Address | Access At | Update
01 [8KE) 00000000 - 00001 25F Read write Add
01 [BKE] 00007260 - 00001FFF Dizable =
02 [1kB] Q0002000 - 000EFFFF Dizable dindify...
02 [1k4B) 000OF0000 - 000F1FFF Read Only
03 [BKE) 000F2000 - 000F 39E 3 Read Only
03 [BKE] 000F35E4 - D00F 3FFF Dizable [elete
02 [1kB] Q00F 4000 - 000FDFFF Dizable —
04 [BKE) Q0OFEDCO - DOOFEOFF Read Only Dielete the block
04 [BKE] O0OFET00 - DOOFFFDE Dizable Delete
04 [8KE) 000OFFFDC - OOOFFFFF Read Only -
=[] 00100000 - 00FFFFFF Readfwfrite

Cancel

Help

Figure 5.110 Violation of access protection dialog box

4. Click on the Update button, and the access attributes will be updated according to the section information in the downloaded
module.

5. To add an access attribute manually, click the Add button. The Access protection condition dialog box shown below will
appear. Specify any address range and access attribute.

Access protection condition EI
Start Address: IEUUU j @
End Address:  [FFFF = =
attribute: winte Qi

] I Cancel |

Figure 5.111 Access protection condition dialog box
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6. The protected area you have added will be displayed in the Address Areas list of the Violation of access protection dialog
box.

x
¥ Automatically zet address areas at downloading
Addrezs Areas:
Block Mo. | Label | Start Addrezs - End Address | Access At |
01 (BB Q0000000 - 00001 25F Fead wite
01 [BKE) 00001 260 - 00001 FFF Dizable
02 [1ME] 00002000 - 000D FFF Dizable
0z [1E] O000E D00 - OO0JFFFE Wit Orly
02 [1ME] 0007 0000 - D00EFFFE Dizable
02 [1k4B) 000FQ000 - 000F1FFF Read Only [elete
03 [BkB] O00F 2000 - 000F39E 3 Fead Only —
03 (8KE) 000F33E 4 - O00F3FFF Disable elete the block
02 [1ME] 000F4000 - D00FDFFE Dizable Delate al
04 [BKE) O00FEQOO - OOOFEOFF Read Only -
04 [BEB] O00FE100 - OOOFFFDE Dizable
04 [BkEB] O00FFFDC - OOOFFFFF Fead Only K |
=[] 007 00000 - D0FFFFFF Fead it
Cancel
Help
Figure 5.112 Violation of access protection dialog box
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(2) From the Trace conditions dialog box

1. In the Trace Mode drop-down list of the Trace sheet, select Fill around TP. Select the Exception checkbox and then click on
the Detail button.

S=E

Trace Jor | Excaption | Gption |

=
E’ru r-'ln&al ST T = Fll around TP j]

(I R canditon:

|- Record condition:
| & all © Captue U Donot capture 7 Stepexecionis resorted
| j Chotal
I Evant inuss : 0
Eventigad [ Frea L6 U-EHI Flegstered events...
Seve. | Losd... vep | aeph [ cise |

Figure 5.113 Trace conditions dialog box

2. The Exception page shown below will appear. Click on the Detail button to the right of the Violation of access protection
checkbox.

W Trace comditions * = :lgl.?_:!

Trice |oR | Excoption | optica |

[ Viddation of access protection 1 Detal... ] .

™ Read from & urinkisized memory  Detal...
[ stack access solation Detal... | |

™ Performance averfion
[ Raakime profil averflow

I Task stack access violation i

[ 5 dispatch
Evenk iged 0 Frss L6 Debuil Regstered events...
Savei. | Losd... veb | deply [ close |

Figure 5.114 Trace conditions dialog box
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The Violation of access protection dialog box will be displayed.
The rest of the procedure is the same as if you opened the Violation of access protection dialog box from the Hardware Break
dialog box.

5.14.4 Detecting Reading from a Non-initialized Area
Reading from a non-initialized area, i.e. cases of reading from a memory location to which nothing has been written, can be
detected as an error.

(1) Method of detection

Reading from a non-initialized area is detected by the RAM monitoring facility.
Allocate a RAM monitoring area to a given address range and enable error detection in that area.

Detection circuit

Neither reading -> ->  Error

.. <Comparison>
nor writing has . detected
Has access proceeded in the order
proceeded at the

. “reading then writing”?
location g g

Figure 5.115 Outline of detection of reading from a non-initialized area

(2) Action taken when reading from a non-initialized area is detected

The following actions are selectable.
- Display a warning.

When the Read from uninitialized memory checkbox has been selected on the Exception Warning page of the Configuration
properties dialog box, you will see a warning in the Status window and in a status bar balloon when errors of this type occur.

Data is colored in the RAM Monitor window.

- Make the detection of reading from a non-initialized area a condition of a hardware breakpoint.
- Make the detection of reading from a non-initialized area a condition of a trace point.
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5.14.5 Detecting Stack Access Violations
Setting the size of the stack too small in software development raises the possibility of a program going out of control or
malfunctioning. The E100 emulator actively detects abnormal access by the stack pointer.

(1) Setting stack areas

Selecting a stack section automatically assigns the addresses of the section as a stack area. Alternatively, you can enter any
desired address range. Up to 4 stack areas can be specified.

(2) Initial settings when the emulator is booted up

At the time the emulator is booted up, the default section (‘s”) is automatically selected. However, automatic selection does not
proceed until a program is downloaded, because there is no address information before this.

(3) Detection method

The emulator monitors the value of ER7 and detects if the value points to a location outside the stack areas.

Detection circuit

| ER7 value -> <Compare>
Whether the value of ER7 points | -> Error
Up to 4 stack -> outside the stack areas detected
areas

Figure 5.116 Outline of detection of a stack access violation

The emulator will detect the error if the value of the stack pointer is beyond the stack areas on

1. generation of an interrupt or return from an interrupt handler;
2. calling of a function or return from a function; or
3. the stack pointer pointing to a location outside reserved stack areas.

CAUTION

Detection does not cover cases of corruption of data within a stack area.
(4) Actions taken when a stack access violation is detected

The following actions are selectable.

- Display a warning.

When the Stack Access Violation checkbox has been selected on the Exception Warning page of the Configuration properties
dialog box, you will see a warning in the Status window and in a status bar balloon when errors of this type occur.

- Make the detection of a stack access violation a condition of a hardware breakpoint.
- Make the detection of a stack access violation a condition of a trace point.
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5.14.6 Detecting a Performance-Measurement Overflow
A time in performance measurement coming to exceed the maximum value can be detected as an error.
Timeout case in a performance measurement is referred to as a performance overflow.

(1) Actions taken when a performance-measurement overflow is detected
The following actions are selectable:
- Display a warning.

A warning is displayed in the Performance Analysis window.

The section of the program where the performance overflow occurred is marked “overflow.”

When the Performance Overflow checkbox has been selected on the Exception Warning page of the Configuration properties
dialog box, you will see a warning in the Status window and in a status bar balloon when errors of this type occur.

- Make the detection of a performance-measurement overflow a condition of a hardware breakpoint.
- Make the detection of a performance-measurement overflow a condition of a trace point.

5.14.7 Detecting a Realtime Profile Overflow

A time or number of passes in realtime profile measurement coming to exceed the maximum value can be detected as an error.
Overflows of the counters for time and number of passes for realtime profiling are collectively referred to as realtime profile
overflows.

(1) Action taken when a realtime profile overflow is detected
The following actions are selectable.
- Display a warning.

A warning is displayed in the Realtime Profile window.

The line of the function or task in which a timeout or count-out occurred is marked “overflow”.

When the Realtime Profile Overflow checkbox has been selected on the Exception Warning page of the Configuration
properties dialog box, you will see a warning in the Status window and in a status bar balloon when errors of this type occur.

- Make the detection of a realtime profile overflow a condition of a hardware breakpoint.
- Make the detection of a realtime profile overflow a condition of a trace point.
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5.14.8 Detecting a Trace Memory Overflow

Overflows of the trace memory (4 M cycles) can be detected as errors.
(1) Action taken when a trace memory overflow is detected

The following actions are selectable.

- Display a warning.

When the Trace memory overflow checkbox has been selected on the Exception Warning page of the Configuration properties
dialog box, you will see a warning in the Status window and in a status bar balloon when errors of this type occur.

- Make the detection of a trace memory overflow a condition of a hardware breakpoint.

5.14.9 Detecting Task Stack Access Violations
This facility is only available when a load module that includes an OS has been downloaded. The emulator detects an error
when one task attempts writing to the task stack for another task.

(1) Initial settings when the emulator is booted up

At the time the emulator is booted up, the checkbox labeled “Automatically set address areas at downloading” is selected
(flagged by a check mark). However, automatic selection does not proceed until a program is downloaded, because there is no
address information before this.

(2) Action taken when a task stack access violation is detected

The following actions are selectable.

- Display a warning.

When the Task stack access violation checkbox has been selected on the Exception Warning page of the Configuration
properties dialog box, you will see a warning in the Status window and in a status bar balloon when errors of this type occur.

- Make the detection of a task stack access violation a condition of a hardware breakpoint.
- Make the detection of a task stack access violation a condition of a trace point.
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5.14.10 Setting a Task Stack Area
Follow the procedure below to set a task stack area.

(1) From the Hardware Break dialog box

1. Select the Exception checkbox on the Hardware Break sheet and then click on the Detail button.

(rrrrE— i)
Hardware Break, IQ,R | Extention |

condition and combination sebng

¥ OR condtion:

Eventinuse: 0 Debai

1 Other condtions: ———

AR ACTOmLERinn ) ¥

Event inuge : 0 B[

7 Evcecitian: = Tokal: 0 Event
i~ Delay{opdel ——
Exceptional
T ! 1/ —
|
Event used 0 Freeld Dnbui.l Regishered maanks...
Saven. | Losd. e | apely [ cose |

-

Figure 5.117 Hardware Break dialog box

2. The Exception page shown below will appear. Click on the Detail button to the right of the Task stack access violation
checkbox.

[ Hardware Break ™ =[0l =|

Harchare Bresk | OF  Excention

[ wialation of access protection Detai...
[ Raad from a winkizlzed memory  Detal...
[ Stack access wiolation Detal...

[ Petformance overflow
[~ Fuaaltime profile ovesfiow

™ Trace memary overflave

[T Tesk stack access violation Ceatal, .

[ o5 dispatch
Event used 0 Freeld Dutﬂtl Repistered eents...
Savan. | Lost. v | ey [ o |

o

Figure 5.118 Hardware Break dialog box
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3. The Violation of task stack access dialog box shown below will be displayed. To have the task stack areas automatically set
when a program is downloaded, select the “Automatically set address areas at downloading” checkbox.

Yiolation of task stack access | - x|

I Automaticaly zet addiezs arsas at dewnlsading

Address aeaz (|
TazklD | Labml | Start Addiess - End Addiess
1 LMainTask) O0FFEDND - Q0FFEIFF
2 [tack] OOFFE400 - D0FFETFF

[relEe
Dedete sl

QK

Cancal

Help

Figure 5.119 Violation of task stack access dialog box
4. Click on the Update button, and the task stack areas will be automatically set.

5. To manually add a task stack area, click on the Add button. The Task stack access condition dialog box shown below will
appear. Specify any task ID and the address range of the corresponding task stack.

x4
TaskID |0002 Select... |

Start Address: IUUFFE4DD j @

End Address:  |0OFFE7FF ~| &

Canicel |

Figure 5.120 Task stack access condition dialog box

6. The task stack area (or areas) you have added will be displayed in the Address Areas list of the Violation of task stack
access dialog box.
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(2) From the Trace conditions dialog box

1. In the Trace Mode drop-down list of the Trace sheet, select Fill around TP. Select the Exception checkbox and then click on
the Detail button.

M Trace conditions *

Trace IQR | Excepkion I Crption I

E‘rmeh'lude: I ET tntee

' Fill around TP j]

condiion and combination setting
~¥ OR condtion:

Everkinuse: 0  Detai

—I Other conditons:
I.ﬁ.f{'i.ﬁ.ccumubhnn) _ﬂ

Eventinuse; 0 HEtSl ]

Total: O Event

¥ Exception: ‘I
( Emﬂl'f‘“:' Detai J

Dalay{opde): ——
I (ni] -

- Record conditon:
Al Capture T Donok capbure

T step execution is recardes

Event inuge ;0

Everk used 0 Freel6 Detail,.. Reqishered events. ..
save.. | Load.. | Hep | eeply [ close |
g
Figure 5.121 Trace conditions dialog box
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2. The Exception page shown below will appear. Click on the Detail button to the right of the Task stack access violation
checkbox.

[N Trace conditions * =0l x|

Trace | OR  Excception | option |

[ ¥iolakion of access probection Dekall...
[ Read from auninkialized memary  Dekall,.,
[ Skadk access vialabon Diekail,.,

[ Performance overflow
[ Reakime profile overflow

. [ Task stack access viclation I

[ 5 dispatch |
| Evertused 0 Free16 Detal... | Registered events.., |
SEVE, ., | Load. .. ] Help | Apnly I Cloze I

g

Figure 5.122 Trace conditions dialog box

3. The Violation of task stack access dialog box will be displayed. The rest of the procedure is the same as if you opened the
Violation of task stack access dialog box from the Hardware Break dialog box.

5.14.11 Detecting an OS Dispatch

This facility is only available when a load module that includes an OS has been downloaded. The emulator detects the
generation of task dispatch as an error.

(1) Action taken when an OS dispatch is detected

The following actions are selectable:

- Display a warning.

When the OS dispatch checkbox has been selected on the Exception Warning page of the Configuration properties dialog box,
you will see a warning in the Status window and in a status bar balloon when errors of this type occur.

- Make the detection of an OS dispatch a condition of a hardware breakpoint.
- Make the detection of an OS dispatch a condition of a trace point.
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5.15 Using the Start/Stop Function

The emulator can be made to execute specific routines of the user program immediately before starting and immediately after
halting program execution. This function is useful if you wish to control a user system in synchronization with starting and
stopping of user program execution.

5.15.1 Opening the Start/Stop Function Setting Dialog Box

The routines to be executed immediately before starting and after halting execution of the user program are specified in the
[Start/Stop function setting] dialog box.

To open the Start/Stop function setting dialog box, choose Setup -> Emulator -> Start/Stop function setting... from the menu.

StartStop Function sebting _ |

Wik addiess lm ﬂ @

u The specified rouine iz executed immediately before
ewection of the user's program.

Starting address =] @

|— The specified routing iz executed immediatel gfter the
stop of the user's program,

Stating addess | =] =
ok, | cancel ] Help |

Figure 5.123 Start/Stop function setting dialog box

5.15.2 Specifying the Work address
Use this command to specify the address of a work area for use by a routine to run before the user program execution is started
or after user program execution is stopped.

CAUTION
The specified address must be in the RAM area and not used by the user program.

5.15.3 Specifying the Routine to be Executed

The routines to run immediately before starting and after halting execution of the user program are specified separately.

When the [The specified routine is executed immediately before execution of the user’s program] checkbox is selected, the
routine specified in the [Starting address] combo box, which is below the checkbox, is executed immediately before execution
of the user program starts.

When the [The specified routine is executed immediately after the stop of the user’s program] checkbox is selected, the routine
specified in the [Starting address] combo box, which is below the checkbox, is executed immediately after execution of the
user program stops.
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5.15.4 Limitations of the Start/Stop Function
The start/stop function is subject to the following limitations.
- The debugging functions listed below are not to be used while the start/stop function is in use.
(a) Memory setting and downloading into the program area of a routine specified as a start/stop function.
(b) Breakpoint setting in the program area of a specified routine
- While either of the specified routines is running, the 4 bytes of memory pointed to by the stack are in use by the emulator.
- The general-purpose registers and flags used in a specified routine are subject to the following limitations.

Table 5.44 Limitations to the registers and flags

Register/flag Name Limitations

ERY register When a specified routine has ended, the value of this register must be restored to one that
it had when the specified routine started.

CCR register, | flag Interrupts are disabled while a specified routine is executed.

- When either of the specified routines is running, the debugging functions listed below have no effect.
(a) Tracing
(b) Break-related facilities
(c) RAM monitoring
- While either of the specified routines is running, interrupts other than WDT are always disabled.
- The table below shows which state the MCU will be in when the user program starts running after execution of a routine
specified as a start function.

Table 5.45 MCU status at start of the user program

MCU Resource Status
MCU general-purpose These registers are in the same state as when the user program last stopped or in states
registers determined by user settings in the Register window. Changes made to the contents of

registers by the specified routine are not reflected.

Memory in MCU space | Access to memory after execution of the specified routine is reflected.

MCU peripheral Operation of the MCU peripheral functions after execution of the specified routine is
functions continued.

5.15.5 Limitations on Statements within Specified Routines

Statements within specified routines are subject to the limitations described below.

- If a specified routine uses a stack, the stack must always be the user stack.

- The processing of a specified routine must end with a return-from-subroutine instruction.

- Ensure that a round of processing by a specified routine is complete within 10 ms. If, for example, the clock is turned off and
left inactive within a specified routine, the emulator may become unable to control program execution.

- The values stored in the registers at the time a specified routine starts running are undefined. Ensure that each specified
routine initializes the register values.
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5.16  Using the Trigger Output Function
The trigger output function allows output of signals through an external trigger cable. Trigger pin numbers 31 to 16 can be
used for output. Note, however, that operation of a trigger pin depends on its pin number. Table 5.45 lists the trigger pin

numbers and how they operate.

Table 5.46 Trigger Pin Numbers and Operation

No. Operation

31to24 These pins constantly output a signal; either high or low can be selected.

23 A high-level signal is output when a breakpoint is encountered.

22 A high-level signal is output when a trace point is encountered.

21 A high-level signal is output when specific trace data is extracted or discarded.

20to 16 An event can be specified for each of the signals and a high-level signal is output
when that event occurs.

Output is at the power voltage level of the target system. If the MCU in use has two power supplies, the level on VCC1 will be
applicable.

5.16.1 Using the External Trigger Cable for Output
You can specify input and output through the external trigger cable on the System page of the Configuration properties dialog
box. Select the ‘EXT 0-15 INPUT EXT16-31 OUTPUT’ radio button for ‘External trigger cable’.

Configuration properties

—Glack
Main & Emulator i~ User i~ Gererate I 10/ MHz
sub O Emulator ) Wi clock divided| by 256
— Trigger
External trigeer cable  EXT 0-31 INPUT O E}}?TI"I%_JB? ISE¥;’UT
_ ~ EXT 0-15 TTL
Ihput trigeer level {* EXT 0-31 CMOS S

Figure 5.124 Configuration properties dialog box (System page)
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5.16.2 Opening the Trigger Output Conditions Dialog Box
Choose [Event -> Trigger Output Conditions] from the View menu, or click on the ‘Trigger Output Conditions’ toolbar button

=]

I Trigeer Cutput Conditions

Manual output | Event output I

—Current trigger oukpuk
31 30 29 28 27 26 25 24

Cutput contents | L " L || L " L || L " L " L ” L |

—Qwkpuk Erigger setkings
31 30 29 25 27 26 25 24

Cukpuk sekking : | ) | ) | _ | _ | ) I ) I _ I Okput I

| add pattern I

Qukbput pattern:

Mo.| 31 | 30 | 29 | 28 | 27 | 26 | 25 | 24 |

elete |

Event used 2 Free 14 Detail...l Registered events...l
Save, ., | Load... | Help | Gl I Close I

4

Figure 5.125 Trigger Output Conditions dialog box

Note that you cannot open the Trigger Output Conditions dialog box in either of the following cases.
e ‘EXT 0-31 INPUT’ has been selected on the System page of the Configuration properties dialog box.
e  Anexternal trigger cable is not connected.
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5.16.3 Manual Setting for Output through Trigger Pins 31 to 24
Make the manual settings for output through trigger pins 31 to 24 on the Manual output page.

I Trigeer Cutput Conditions

Manual output | Event output I

—Current trigger oukpuk
31 30 29 28 27 26 25 24

Cutput contents | L " L || L " L || L || L " L || L |

—Qwkpuk Erigger setkings
31 30 29 25 27 26 25 24

Cukpuk sekking : | ) | ) | _ | _ | ) I ) I _ I Ok put I

| add pattern I

Qukbput pattern:
Mo.| 31 | 30 | 23 | 28 | 27 | 26 | 25 | 24 | -
1 - - - - - - - L
2 - - - - - - H L
3 - - - - - L H L
4 - - - - H L H L —
5 - - - L H L H L
6 - - H L H L H L hd
Delete |
Event used 0 Free 16 Detail...l Registered events...l
Save, ., | Load... | Help | Gl I Close I

g

Figure 5.126 Trigger Output Conditions dialog box (Manual output page)

(1) Display of output states: ‘Output contents’

‘Output contents’ indicates the current signal levels on trigger pins 31 to 24.
H: High
L: Low
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(2) ‘Output setting’

‘Output setting’ indicates the levels of signals to be output through trigger pins 31 to 24. Clicking on one of these buttons
changes the state of the corresponding pin in the following order.

= Hos — —‘

L: Low
H: High
—: The previous setting is retained.

When the Trigger Output Conditions dialog box is opened, the states of all signals in the ‘Output setting’ section are always
indicated as ‘—’, whether the previous setting was L or H.

(3) Starting output of signals

Click on the ‘Output’ button to validate the settings and start output of signals.

(4) Saving output patterns

You can save the settings on trigger pins 31 to 24 and reflect a saved setting as the ‘Output setting’. This simplifies operations.
After making settings for an ‘Output setting’, click on the ‘Add pattern’ button. The new setting will be added as the last line
in the ‘Output pattern’ list.

Up to 256 patterns can be added.

Double-clicking on a line in the ‘Output pattern’ list reflects the information on the line as the ‘Output setting’.

The order of the lines (patterns) can be changed by dragging and dropping.

To delete a pattern, select the line and click on the ‘Delete’ button.
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5.16.4 Setting for Output through Trigger Pins 20 to 16
The Event output page allows manual setting for output through trigger pins 20 to 16.

M Trigeer Cutput Conditions

Manual oukput  Event output

—Default setking
Mo, 23: Breakpaoint is encountered,
Mo, 22: Tracepoint is encountered,
Mo, 21 Capkure or Do Mok Capture of trace dakta,

— Trigger oukpuk event

Ewvenk | Mo, | T.l Descriptions | Ca... | Ta... | Comrnenkt
SO ;0 F [Address] 000000
mlevo:  BE [Size] WORD [Type... - -
kIl 15 T [Trigger] - - o - -
17 1 [Interrupt] generate
A 15 F [Address] 000000

add),., | [Ielefe | Emakile | [isatle |

Eventused 5 Free 11 Detail...l Registered events...l

Help | Gl | Close |
B

Figure 5.127 Trigger Output Conditions dialog box (Event output page)

(1) Default setting

‘Default setting’ indicates the trigger output conditions on pins 23 to 21. These pins are always enabled. Signals are output
through these pins when the respective conditions are satisfied. Table 5.47 gives details on how the conditions control output.

Table 5.47 Trigger Output Conditions and Output

No. Condition Output
23 A breakpoint is Continued output of a high-level signal is started.
encountered
22 A trace point is A high-level signal is output only during cycles in which the
encountered trace-point condition is satisfied.
21 Specific trace data is A high-level signal is output only in cycles where trace data is
extracted or deleted being extracted or discarded.
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(2) Trigger output event

You can specify an event for trigger pins 20 to 16. A high-level signal will only be output while the event is occurring.

CAUTION
The actual trigger output follows event detection after some delay. The number of cycles of delay varies with the product. The
delay for trigger output in the ROE417250MCUO00 is 10 cycles.

5.16.5 Events
For details on the setting of events, see section 5.7, “Using Events” (page 109).

5.17 Measuring the Execution Times in a Specific Section

Measurement of the execution times in a specific section of the program is possible. This facility takes the trace data for
instruction fetching at event points (start and end) used to specify the extraction of trace data and then outputs the timestamps
and their differences to a file in a format that is editable in Microsoft Excel.

Timestamps for up to 2-M cycles of trace data will be output to the file.

Each section is defined by two events (start and end events) and up to eight sections are specifiable.

Follow the procedure below to measure the execution times in a specific section of the program.

CAUTION

This facility is only supported by command-line operation. To measure the execution times for a specific section of the
program, be sure to specify the events on the same line as the command. Such measurement is not possible for events that have
been specified in the [Trace conditions] dialog box. Before using this facility, disable all events registered as hardware-break,
tracing, and performance-measurement conditions.

5.17.1 Setting Trace Conditions
Trace conditions can be specified on the command line.

(1) Selecting the mode of tracing

Select “fill until stop’, “fill until full’, or “fill around TP’ as the trace mode. Examples of the commands are given below.

| event trace_mode fr  (fill until stop) |

| event_trace_mode fu  (fill until full) |

| event_trace_mode po  (fill around TP) |
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(2) Specifying the start and end events

Specify the start and end events that define the points where the desired section starts and ends, along with the following
conditions.

Event type: Instruction fetch
Address condition:  Specified value (=)
Do not select any other event type or address condition.

To specify sections from H’1000 to H’10FF and from H’2000 to H’20FF, for example, enter commands as follows.

event_set ev1 f address eq 0x001000 cnt 0x1
event_set ev2 f address eq 0x0010FF cnt 0x1
event_set ev3 f address eq 0x002000 cnt Ox1
event set ev4 f address eq 0x0020FF cnt 0x1

(3) Selecting an option for ‘Record condition’

You should specify extraction of trace data during the event. No other conditions should be selected.

An example of a command that specifies ‘Extraction’ and ‘Duration of an event’ for the events set in step (2) is given below.

event_trace_acquisition apo evl ev2 ev3 ev4

(4) Selecting an option for tracing

Select ‘Event number’ as an option for tracing. Do not select any other options. An example is given below.

event_trace option ev |

5.17.2 Acquiring Trace Data
Run the user program and acquire the trace data.

5.17.3 Specifying a Section

You can use the TRACE_EXECUTE_SECTION_SET command to specify a section. An example of commands to specify
section 1 that starts with event 1 and ends with event 2 and section 2 that starts with event 3 and ends with event 4 is given
below.

trace_execute_section_set 1 start evl end ev2
trace_execute section set 2 start ev3 end ev4
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5.17.4 Saving the Execution Times to a File
After the trace data has been acquired, you can use the TRACE_EXECUTE_SAVE command to save the execution times in
the specified section to a file with extension .csv.
The command description given below is an example where the execution times for sections 1 and 2 are saved in result.csv

under the configuration directory.

trace_execute_save $(CONFIGDIR)result.csv 1 2

The contents of the .csv file opened in Microsoft Excel will be as follows.

Example:
A | B | ¢ |
1 [<ETART1> CENDY >
2 | 1000 1 OFF < Section 1 (start: 0x1000, end: 0x10FF)
_ 3 |Execution time Start End
4 100 0 100
5 | 102 1000 1102
6 | 100 2100 2200
7 58 3000 3038
8 | 1200 5000 6200
e 103 7000 71‘03 Within the acquired data, an execution
0= 5200 - = time is not given if a start event has no
% 1201 5000 10201 corresponding end event.
13 [<STARTZ> < END2 >
14 2000 20FF < Section 2 (start: 0x2000, end: 0x20FF)
15 |Bxecution time Start End
A6 | 100 0 100
A7 102 1000 1102
18 | 100 2100 2200
mEN 98 3000 3038
20 | 1200 5000 6200
21 103 7000 o3
22 |- 8200 -
23 | 1201 5000 10201
24 |

Figure 5.128 .csv file opened in Microsoft Excel

The execution time, in nanoseconds, is saved in the file.

Example:

1h 23 m 455678 ms 901 ps 234 ns = 01:23:45.678.901.234 -> 5025678901234

[CAUTION]

Measurement of execution times in specific sections is not possible for events set in the Trace conditions dialog box, so be sure
to specify the events on the command line.

Execute the TRACE_WAIT command before using the TRACE_EXECUTE_SAVE command in a command file. The
TRACE_WAIT command makes the emulator wait for successful acquisition of the trace data.

For details on commands, refer to the online help information.
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5.18 Generating Pseudo ECC Errors

A command is available for the generation of pseudo ECC errors in ROM or RAM. For the command-line format, see the
online help system.

CAUTION

Generation of pseudo ECC errors for ROM is not possible if emulation memory has been assigned to the corresponding area of
internal ROM.

5.19 Generating a State Where External Oscillation Has Stopped

A command is available for generating a state where it appears as if external oscillation has stopped. For the command-line
format, see the online help system.

5.20 Blank Checking for the Internal EEPROM

A command is available for checking if the internal EEPROM is blank in 8-byte units. For the command-line format, see the
online help system.
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6. Troubleshooting (Action in Case of an Error)

6.1 Flowchart for Remediation of Trouble

Figure 6.1 shows the flowchart for remediati
system and the emulator debugger starting up.
visit the Renesas Tools Homepage.

on of trouble arising between activation of the power supply to the emulator
Go through the checks with the user system disconnected. For the latest FAQs,

https://www.renesas.com/tools

Turn on the power to the emulator

Check the LEDs on the emulator

Normal

iew the Device setting
dialog box of the
emulator debugger

Normal

View the Configuration
properties dialog box of the
emulator debugger

Normal

View the Connecting
dialog box of the
emulator debugger

View the Editor window of the
emulator debugger

Normal

Not normal

v

1. Check the connection of power cable.
See “2.5 Connecting the Emulator Power Supply”

Not normal/Error displayed

v

1. Check the operating environment of the emulator debugger.
See ‘5.1 Setting Up the Emulation Environment”

2. Re-install the emulator debugger.

Not normal/Error displayed

v

See “6.3.(2) On the system page of the Configuration properties
dialog box does not appear in booting-up of the emulator
debugger”

Not normal/Error displayed

v

See “6.3.(3) Error occurs in the Connecting dialog box”

Error displayed

v

See “6.3.(4) Errors occur in booting-up of the emulator debugger”

The emulator debugger has started up

Figure 6.1 Flowchart for remediation of trouble
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6.2 Error in Self-checking
When an error occurs in the self-checking, check the following items.

(1) Re-check the connection between the E100 emulator main unit and the MCU unit.

(2) Download the proper firmware again.

(3) Check the error log from self-checking by the debugger software, and refer to the instructions given therein (see Figure
6.2).

“Error occurred during the self-check test.”
dialog is displayed

Click on the OK button.

A

Check the log in the self-check dialog box.

|

Refer to any instructions in the log.

Figure 6.2 Flowchart for checking of an error in self-checking

IMPORTANT

Notes on Self-checking:
® Disconnect the MCU unit from a converter board and the user system before you start self-checking.
® |f the results of self-checking are not normal (excluding status errors of the target system), the product may
have been damaged. Contact your local distributor.
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6.3 Errors Reported in Booting-up of the Emulator

(1) States of the LEDs on the E100 are incorrect

Table 6.1 Points to check for errors indicated by incorrect states of the LEDs on the E100

Error

Connection to
the user system

Point to check

SAFE LED remains lit.

Check that the power cable is connected.
See "2.4 Connecting the Host Machine" (page 29).

SAFE LED does not light up.

Re-check the connection between the E100 and the MCU unit.
See “2.3 Connecting the MCU Unit to and Disconnecting it from the
E100 Emulator Main Unit” (page 28).

Target Status POWER LED Connected Check that power (Vcc) is being correctly supplied to the user
does not light up. system and that the user system is properly grounded (GND).
Target Status RESET LED does Connected (1) Check that the reset pin of the user system is being pulled up.
not go out. (2) When using the emulator without the user system, check to see
if a converter board is disconnected from the emulator.
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(2) Configuration Properties Dialog Box Does Not Appear in Booting-up of the Emulator Debugger

Table 6.2 Points to check for errors in booting-up of the emulator debugger (1)

Error

Point to check

Communication initialize error

A communication error.

Check all emulator debugger settings and the connection of the interface
cable.
See “4. Preparation for Debug” (page 69).

(3) Error Occurs in the Connecting Dialog Box

Table 6.3 Points to check for errors in booting-up of the emulator debugger (2)

Error

Point to check

MCU board is not connected.

Re-check the connection between the E100 and the MCU unit.
See “2.3 Connecting the MCU Unit to and Disconnecting it from the
E100 Emulator Main Unit” (page 28).

The system configuration of the E100 emulator
is not corresponding to the content of the
E100.ENV file.

The combination between the emulator software and the MCU unit is not
correct. Refer to the release notes of the emulator software, and confirm
the combination between the emulator software and the MCU unit.

A timeout error. The MCU is in the reset state.
Is system reset issued?

A timeout error. The MCU's internal clock is
halted. Is system reset issued?

A timeout error. No clock signal is supplied to
the MCU. Is system reset issued?

Check the oscillation of the oscillator module mounted on the MCU unit,
and confirm that the oscillator module is properly mounted.

A timeout error. The power supply to the MCU
is off. Is system reset issued?

Check that power is being correctly supplied to the user system and that
the user system is properly grounded.

(4) Errors Occur in booting-up of the emulator debugger

Table 6.4 Points to check for errors in booting-up of the emulator debugger (3)

Error

Point to check

A timeout error.

(1) Check that the NQPACK etc. mounted on the user system is
soldered properly.
(2) Check that the connector is installed properly to the user system.
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6.4 How to Request Support

After checking the items under "6. Troubleshooting (Action in Case of an Error)", fill in the text file which is downloadable

from the following URL, then send the information to your local distributor.

https://www.renesas.com/contact

For a prompt response, please fill in the following information:
(1) Operating environment

- Operating voltage: V]
- Operating frequency: [MHZz]
- Clock supply to the MCU: Internal oscillator/External oscillator

(2) Condition
- The emulator debugger starts up/does not start up
- The error is detected/not detected in self-checking
- Frequency of errors: always/frequency (

(3) Details of request for support
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7. Hardware Specifications

This chapter describes specifications of the MCU unit.

7.1 Target MCU Specifications
Table 7.1 lists the specifications of target MCUs which can be debugged with the MCU unit.

Table 7.1 Specifications of target MCUs for the ROE417250MCUQ0

Item Description
Applicable MCU series HB8SX family H8SX/1700 series
Evaluation MCU R5E61700
Applicable MCU mode Single-chip mode, On-chip ROM enabled extended mode
Supported MCU Series H8SX/1700 series (with 1-Mbytes ROM, 64-Kbyte RAM, and 32-Kbyte data-
flash ROM)
Power supply voltage Vcc: 3.0t0 3.6V, 4.5t05.5V
Maximum operating frequency 80 MHz
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7.2 Differences between the Actual MCU and Emulator
Differences between the actual MCU and emulator are shown below. When debugging the MCU using the MCU unit, be
careful about the following precautions.

IMPORTANT

Note on Differences between the Actual MCU and Emulator:
® Operations of the emulator system differ from those of actual MCUs as listed below.
(1) [Initial values of registers

State Register name Emulator MCU
Power-on/initialized PC Reset vector value Reset vector value
ERO to ER6 Undefined Undefined
ER7 (SP) H’10 Undefined
CCR The I mask bitis 1 The I mask bitis 1
and the other bits are | and the other bits are
undefined. undefined.
Reset PC Reset vector value Reset vector value
ERO to ER6 Undefined Undefined
ER7 (SP) H’10 Undefined
CCR The | mask bit is 1 The | mask bit is 1
and the other bits are | and the other bits are
undefined. undefined.

(2) Oscillator circuit
In the oscillator circuit where an oscillator is connected between pins XTAL and EXTAL, oscillation does
not occur because a converter board is used between the evaluation MCU and the user system.

(3) A/D converter
The characteristics of the A/D converter differ from those of the actual MCU because there are a converter
board and other devices between the evaluation MCU and the user system.

Note on RESET# Input:
® A low input to pin RESET# from the user system is accepted only when a user program is being executed (only
while the RUN status LED on the E100 upper panel is lit).

Notes on Maskable Interrupts:

® Even if a user program is not being executed (including when run-time debugging is being performed), the
evaluation MCU executes a debug control program. Therefore, timers and other components do not stop
running. If a maskable interrupt is requested when the user program is not being executed (including when run-
time debugging is being performed), the maskable interrupt request cannot be accepted, because the emulator
disables interrupts. The interrupt request is accepted immediately after the user program execution is started.

® Take note that when the user program is not being executed (including when run-time debugging is being
performed), a peripheral 1/0 interrupt request is not accepted.

Note on Final Evaluation:
® Be sure to evaluate your system with an evaluation MCU. Before starting mask production, evaluate your
system and make final confirmation with a CS (Commercial Sample) version MCU.
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7.3 Connection Diagram

7.3.1 Connection Diagram for the ROE417250MCUQ0

Figure 7.1 shows a partial circuit diagram of the connections of the ROE417250MCUOQ0. This diagram mainly shows the
circuitry to be connected to the user system. Other circuitry, such as that for the emulator’s control system, has been omitted.
See this diagram for reference when you use the MCU unit.

vce -\
P1_0~P1_7,P2_0~P2_7, 451053 f P1_0~P1_7,P2 0~P2_7, \
P6_0~P6_7,PA 0~PA_2PA 7, Jus 33Q P6_0~P6_7,PA_0~PA 2,PA 7, |
PF_0~PF_7,PJ_0~PJ_7, ? < PF_0~PF_7,P)_0~PJ_7, \
PK_0~PK_7 &L PK_0~PK_7
P3_0~P3_7,PA_3~PA 6, P3_0~P3_7,PA_3~PA 6,
PD_0~PD_7,PE_0~PE_7, »< pD_0~PD_7,PE_0~PE_7,
PH_0~PH_7,PI_0~PI_7 PH_0~PH_7,PI_0~PI_7
P4_0~P4_7,P5_0~P5_7 <P4_0~P4_7,P5 0~P5_7
AVCC0,AVCC1 * * <AVCCO0,AVCC1
AVSS AVSS
AVREF0,AVREF1 ° * < AVREF0,AVREF1
vce
510k Q
EXTAL D * < EXTAL
vce
510k Q
NMI# X p3 * < NMI#
vCce
510k Q
User
STBY# X ’ < STBY# system
vce
510k Q I 510k Q
RES# X X < RESH#
vCce
510k Q
MDO~MD? { ¥ X 4 < MD0~MD2
vCC
SN74CB3Q3306A 7451053 @ 30
WDTOVF# I]- ANN—> WDTOVF#
XTAL,0SC1(OPEN) XTAL,0SC1(OPEN)
VSL,VCL,EMLE,0SC2 ¥ VSL,VCL,EMLE,0SC2(OPEN)
VO~V3 <\V0~V3
vce X% < VCC
VSS < V/SS
/
/
H8SX/1700 EVA CHIP /
* Connected to the inside of the emulator

R5E61700

Figure 7.1 Connection diagram for ROE417250MCU00
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7.4 External Dimensions

7.4.1 External Dimensions of the E100 Emulator
Figure 7.2 shows external dimensions of the E100 emulator.

D: 184 mm

H: 132 mm

Figure 7.2 External dimensions of the E100 emulator
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7.4.2 External Dimensions of the Converter Board ROEO100TNPFKO00
Figure 7.3 shows external dimensions and a sample pad pattern of the converter board ROEO100TNPFKOO for a 100-pin 0.5-
mm pitch LQFP.

L 37.00 | A
) L o— Ul
RENESAS ROE0100TNPFK00
= T REy. ' P A
007 1 g2 ——
—— s ——
o 8 — —
= i o| o
511.F50 : - o
= —— ——
\® I —— ., 050 ——
S -
P \ 4

. 16.50

¥ 3
PR 4
—
w
o

g - Unit:mm

Figure 7.3 External dimensions and a sample pad pattern of the ROEO100TNPFKO00
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7.5 Notes on Using the MCU Unit
Notes on using the MCU unit are listed below. When you debug an MCU using the MCU unit, be careful about the following

precautions.

IMPORTANT

Note on the Version of the Emulator Debugger:
® Be sure to use the MCU unit with the following emulator debugger.
- H8SX E100 Emulator Software V.1.00 release 01 or later

Notes on Downloading Firmware:
@ Before using the MCU unit for the first time, it is necessary to download the dedicated firmware (emulator’s
control software installed in the flash memory in the E100). If you need to download at debugger startup, a
message will appear. Download the firmware following the message.
® Do not shut off the power while downloading the firmware. If this happens, the product will not start up
properly. If the power is shut off unexpectedly, re-download the firmware.
® Disconnect the MCU unit from the user system before you start downloading the firmware.

Notes on Self-checking:
® |f self-checking does not result normally (excluding user system errors), the product may be damaged. Then
contact your local distributor.
® Disconnect the MCU unit from the user system before you start self-checking.

Note on Quitting the Emulator Debugger:
® To restart the emulator debugger, always shut off the emulator power supply and then turn on it again.

Note on Display of MCU Status:
® "Status" you can view in the Connecting dialog box of the emulator debugger shows pin levels of the user
system. Make sure that proper pin levels are selected according to the mode you use.
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IMPORTANT

Note on Clock Supply to the MCU:
® A clock source supplied to the evaluation MCU is selected on the System page of the Configuration properties

dialog box of the emulator debugger.

(1) When "Emulator" is selected:
A clock source generated by the oscillator circuit board on the MCU unit is supplied. It is continually
supplied regardless of the status of the user system clock and that of the user program execution.

(2) When "User" is selected:
A clock source generated by the oscillator in the user system is supplied. It depends on the status of the
oscillation (on/off) on the user system.

(3) When "Generate" is selected:
A clock source generated by the dedicated circuit in the E100 is supplied. It is continually supplied
regardless of the status of the user system clock and that of the user program execution.

Note on the Watchdog Function:
® |f the reset circuit of the user system has a watchdog timer, disable it when using the emulator.

Note on Access Prohibited Area:
® You cannot use internally reserved areas. Write signals to the areas will be ignored, and values read will be
undefined.

Note on Breaks:
® The following break functions are available in the emulator debugger.

(1) Software break
This is a debugging function which generates a BRK interrupt by changing an instruction at a specified
address to a BRK instruction (a dedicated instruction for use with the emulator) to break a program
immediately before the system executes an instruction at a specified address. The instruction at the preset
address will not be executed.

(2) Hardware break
This is a debugging function which breaks a program by setting the detection of an execution of an
instruction at a specified address as a break event. The program will break after the instruction at the
specified address is executed.

(3) Exceptional event
This is a debugging function which stops a program when an abnormal operation of the user program or
overflow of each function’s measurement counter, etc. is detected.

Note on Software Breaks:
® After you have selected the “Debug the program with overwriting of flash ROM” checkbox on the [System]
page of the [Configuration properties] dialog box, the setting of software breakpoints in internal ROM becomes
impossible. If you remove the tick from the “Debug the program with overwriting of flash ROM” checkbox,
setting such software breakpoints becomes possible.
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IMPORTANT

Notes on Power Supply to the User System:
® Pin Vcc is connected to the user system to observe the voltage. Therefore, the power is not supplied to the user
system from the emulator. Design your system so that the user system is powered separately.
® The voltage of the user system should be as follows.
3.0V <Vee<3.6V,45V<Vee<h5V

Note on Flash ROM:
® Since the number of times the flash ROM can be programmed or erased is limited, it must be replaced at the end
of its service life.
If any of the following error messages frequently appears while you are downloading a program, replace the

MCU board.

- An error has occurred in erasing of the flash ROM in the target MCU. The flash ROM may have been
degraded.

- An error has occurred in verification of the flash ROM in the target MCU. The flash ROM may have been
degraded.

Note on Debugging with Overwriting of Flash Memory:
® \When the emulator reads or writes to the data flash ROM or flash ROM, software in the emulator may alter the
values of registers in the FCU. To check if the emulator has actually manipulated the registers in the FCU,
select the [Display a message when the emulator was to manipulated registers in the FCU] checkbox on the
[System] page of the [Configuration properties] dialog box. If the message “The registers of FCU was
manipulated by emulator.” is displayed, debugging with flash-ROM rewriting cannot proceed: initialize the user
program before running the program again.

Notes on Manipulation of Memory and Reading of Data from the Flash ROM and EEPROM:

® \When downloading of data or programming of the flash ROM or EEPROM is attempted, the emulator writes
data to the memory in block units. Even if only a single byte of data in the EEPROM has been modified, all
memory resources in the selected block will be rewritten so the block will no longer be blank.

® \When reading of data from the flash ROM or EEPROM is attempted, the emulator enters the break state, and
reading of data from the actual flash memory only proceeds once. For this reason, you will keep seeing the
same value in the emulator even after undefined data have been read out several times. When the actual MCU is
in use, on the other hand, the values change per reading operation.

® |n cases where a clock source on the user system is selected, no external clock is available, and an internal
oscillator is in use, manipulating data in the flash ROM or EEPROM through windows (e.g. [Memory]
window) leads to the message “The command is not executable because the FCU operating clock is out of
operating range.” Before manipulating memory, the clock frequency must be changed to one that allows
programming of the flash ROM or EEPROM.
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Notes on the Emulator Limits Access:

® The emulator limits access to the following areas.

® Areas
- Addresses H’0 to H’FFFFF excluding the flash ROM area.
- Addresses H’FEC000 to H’FEBFFF excluding the RAM area.
- Addresses H’E00000 to H’E1FFFF excluding the EEPROM area.
- Access-prohibited areas.

@ Actions
- When data is viewed in a window (e.g. [Memory]), fixed data 00 is read out.
- When data is changed in a window (e.g. [Memory]), the data is not written. No errors occur.
- When data other than 00 is written with verification, a verification error occurs.

Notes on Memory Access during Execution of the User Program:

@ While the user program is running, using the emulator to download programs to the flash ROM or EEPROM or
to change memory settings is not possible.

® |f you have selected the [Debug the program with overwriting of flash ROM] checkbox on the [System] page of
the [Configuration properties] dialog box and attempt to read data from the flash ROM or EEPROM while the
user program is running, the data read out during the most recent break is displayed rather than the current data
in the flash memory.

@ |f you attempt to read data from the flash ROM or EEPROM while the user program is running under any of the
following conditions, the fixed value “FF” is read out.
- The operating frequency (CPU clock frequency) is below 1 MHz (e.g. while the subclock is in use).
- The CPU clock has stopped (e.g. the emulator is in the standby or subsleep mode).
- The emulator is in the reset state.
- The emulator is waiting for release of the external bus.

® \When memory is accessed during execution of the user program, the MCU temporarily occupies the MCU bus.
If you wish to maintain realtime operation, select the [Disable memory access by GUI when target is executing]
checkbox on the [Options] page of the [Debug Settings] dialog box.

Note on Key-code Error That May Appear during the Boot-up Process:
® An error message “Failed to boot up the EFW program because the keycode value is invalid.” may appear
during the boot-up process and prevent connection of the emulator. In such a case, perform a diagnostic test.

Note on Key Code
® The range of addresses H’4 to H’7 is a key-code area. Note that there are the following limitations.

(1) When emulation memory is not assigned to the flash ROM
Even if you attempt to change values of addresses H’4 to H’7 in a window (e.g. [Memory]), the values will
not be actually written.

(2) When emulation memory is assigned to the flash ROM
If you attempt to change values of addresses H’4 to H’7 in a window (e.g. [Memory]), the values will be
written.
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8. Maintenance and Warranty

This chapter covers basic maintenance, warranty information, provisions for repair and the procedures for requesting a repair.

8.1 User Registration
When you purchase our product, be sure to register as a user. For user registration, refer to “User Registration” (page 16) of
this user's manual.

8.2 Maintenance

(7) (1) If dust or dirt collects anywhere on your emulation system, wipe it off with a dry soft cloth. Do not use thinner or
other solvents because these chemicals can cause the equipment's surface coating to separate.

(8) (2) When you do not use the MCU unit for a long period, for safety purposes, disconnect the power cable from the power

supply.

8.3 Warranty

If your product becomes faulty within one year after purchase while being used under conditions of observance of the
"IMPORTANT" and "Precautions for Safety" notes in this user's manual, we will repair or replace your faulty product free of
charge. Note, however, that if your product's fault is due to any of the following causes, an extra charge will apply to our repair
or replacement of the product.

Misuse, abuse, or use under extraordinary conditions

Unauthorized repair, remodeling, maintenance, and so on

Inadequate user system or improper use of the user system

Fires, earthquakes, and other unexpected disasters

In the above cases, contact your local distributor. If your product is being leased, consult the leasing company or the owner.

8.4 Repair Provisions
(1) Repairs not covered by warranty
Problems arising in products for which more than one year has elapsed since purchase are not covered by warranty.

(2) Replacement not covered by warranty
If your product's fault falls into any of the following categories, the fault will be corrected by replacing the entire product
instead of repairing it, or you will be advised to purchase a new product, depending on the severity of the fault.
- Faulty or broken mechanical portions
- Flaws, separation, or rust in coated or plated portions
- Flaws or cracks in plastic portions
- Faults or breakage caused by improper use or unauthorized repair or modification
- Heavily damaged electric circuits due to overvoltage, overcurrent or shorting of power supply
- Cracks in the printed circuit board or burnt-down patterns
- A wide range of faults that make replacement less expensive than repair
- Faults that are not locatable or identifiable
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(3) Expiration of the repair period
When a period of one year has elapsed after production of a given model ceased, repairing products of that model may
become impossible.

(4) Carriage fees for sending your product to be repaired
Carriage fees for sending your product to us for repair are at your own expense.

8.5 How to Make Request for Repair
If your product is found faulty, fill in a Repair Request Sheet downloadable from the following URL. And email the sheet and
send the product to your local distributor.

https://www.renesas.com/repair

/A CAUTION

Note on Transporting the Product:
0 ® \When sending your product for repair, use the packing box and cushioning material supplied with the MCU unit

when it was delivered to you and specify caution in handling (handling as precision equipment). If packing of
your product is not complete, it may be damaged during transportation. When you pack your product in a bag,
make sure to use the conductive plastic bag supplied with the MCU unit (usually a blue bag). If you use a
different bag, it may lead to further trouble with your product due to static electricity.
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